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DIAGNOSTIKA KAVITACE V HYDRAULICKEM TLUMICI

Anotace; Bakalafska prace je zaméfena na diagnostiku kavitace v hydraulickém tlumidi.
Uvodni kapitola obsahuje popis konstrukce a funkénich principt zakladnich typt
hydraulickych tlumiél. V dalsi kapitole jsou uvedeny nékteré typy hydraulickych
kapalin a jejich vlastnosti. Pro hydraulickou kapalinu, ktera byla pouzita v
naslednych méfenich, bylo provedeno méfeni hustoty, povrchového napéti a
viskozity. Nasleduyici kapitola obsahuje teoreticky tivod do problematiky kavitace.
Dalsi ¢ast prace je zamé&fena na popis metod pouzZivanych pii diagnostice kavitace.
Diraz je kladen na metody a zarizeni, které jsou k dispozici v laboratofi Technické
univerzity v Liberci. Kapitola o méfeni popisuje aplikace vybranych metod pro
diagnostiku kavitace na kalibra¢ni komofe. Jsou zde uvedeny popisy jednotlivych
zafizeni a dale vysledky kalibratnich méfeni pomoci akustického bublinkového
spektrometru a optického méfeni stinovou metodou. Posledni ¢ast prace popisuje
kavitaéni komoru uréenou pro detekci kavitace v realnych tlumiich a metodiku

méfeni na tomto zafizeni

Kli¢ova slova: Kavitace, hydraulicky tlumi¢, hydraulicky olej,

diagnostika kavitace, model tlumige.



DIAGNOSTICS OF CAVITATION PHEMOMENA
IN A HYDRAULIC SHOCK ABSORBER

Annotation: The bachelor thesis is focused on the diagnostic of cavitation in the shock
absorber. The introductory chapter includes the design description and
working principles of basic types of shock absorbers. The review of hydraulic
liquids and their properties are introduced in the following chapter. The
density, surface tension and viscosity measurements were performed for the
hydraulic fluid uwsed in following measurements. The following chapter
includes theoretical introduction to the cavitation phenomena. Next part of the
work 1s focused on methods used in the cavitation diagnostic. A special
emphasis is placed on methods and devices available in the laboratories of the
Technical university of Liberec. The measurement chapter describes
applications of selected methods on the cavitation diagnostics on the
calibration chamber. The description of the devices and results of the
individual measurements using acoustic bubble spectrometer and optical
methods (shadow photography) are given in this chapter. The final part of the
work describes cavitation chamber for the detection of cavitation in the real

shock absorbers and measurement methodology on this device.

Key words: Cavitation phenomena, Shock absorber, hydraulic power fluid,

diagnostics of the cavitation phenomena, hydraulic shock absorber model.
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Seznam symbolt a jednotek

o stlagitelnost hydraulického oleje [Pa™']

v objem hydraulického oleje [m3]

p tlak piisobici na hydraulicky olej [Pa]

h vyska volné hladiny hydraulického oleje nad zakladni rovinou [m]
P hustota hydraulického oleje [kg.m'3]

w rychlost proudéni hydraulického oleje [m.s™)

F sila na odtrzeni platinového prstence pii méfeni povrchového napéti [m N]
U konstanta platinového prstence [m]

¢ povrchové napéti hydraulického oleje [Nm™]

Z konstanta valce [nedefinovanol]

D, smykovy spad viskozimetru [s'l]

a dilky na indika¢nim pfistroji viskozimetru [-]

v kinematicka viskozita hydraulického oleje [mzs‘l]

1 dynamicka viskozita [Pa.s]

Pe parcialni tlak plynu uvnitf kavitaéni bubliny [Pa]

Pv parcialni tlak nasycenych par uvniti kavitaéni bubliny [Pa]
Ul tlak okolni kapaliny na kavita¢ni bublinu [Pa]

Pe kapilarni tlak na rozhrani kapalina - bublina [Pa]

6 povrchové napéti kapaliny [N.m™]

R polomér kavitaéni bubliny [m]

Ry pocatecni polomér kavitacni bubliny [m)]

Mo tlak kapaliny pfi R = R, [Pa]

R kriticky polomér kavitaéni bubliny [m]

PRe kriticky tlak [Pa]
P2 tlak plynu uvnitf bublinky pii pocateénim poloméru [Pa]
pe(t)  tlak uvnitf bubliny v zavislosti na Case [Pa]
p-(t)  tlak kapaliny v nekone¢nu v zavislosti na ¢ase [Pa]
i hustota kapaliny [kg.m'3]
R’ rychlost zmény poloméru bubliny [m.s'l]
rychlost pohybu kapaliny na rozhrani bubliny s kapalinon [m.s™]
R” zrychleni zmény poloméru bubliny [m.s™]

zrychleni pohybu kapaliny na rozhrani bubliny s kapalinou [m.s?]
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1 UVOD

Hydraulicky teleskopicky tlumi€ je soucasti mnoha zafizeni a zabezpe€uje nékolik
funkci, z nichZz nejdilezit&si jsou tlumeni narazi a kmitd. Pro spravnou funkci tlumice je
nutno, aby tlumiCova kapalina obsahovala minimum nerozpusténého wvzduchu, jehoz
plitomnost mize zna¢né ovlivnit charakteristiku tlumice. Je znamo, Ze rozpustnost vzduchu v
kapalinach kles4 s klesajicim tlakem a naopak. Proto se v mistech, kde dochazi k poklesu
tlaku objevuyi bublinky. Kdyz se tyto bublinky dostanou do mist s vy$s$im tlakem, dochazi k
jejich vybuzem a oscilacim. Béhem oscilaci nékteré bublinky kolabuji a mohou poskozovat
¢asti tlumice piipadné zphasobit lokalni spalovani tekutiny. Vznik a aktivity téchto bublinek
nazyvame kavitaci. K poklesu tlaku v tlumiéi dochazi zejména na riznych Skrticich
elementech. Kavitace je tedy v piipadé hydraulickych tlumi¢ii zna¢né nezadoucim jevem. V
souCasnosti je problém kavitace feSen specialni konstrukci nebo pretlakovanim tlumi¢i
plyny, coz s sebou nese nemalé finan¢ni ndklady. Pouziti pfetlaku podmifiuje spravné
utésnéni tlumiél, se kterym je spojena fada dal$ich problémii. Je viak tieba si uvédomit, ze
ani timto zplisobem nelze uvolitovani vzduchu zcela odstranit, protoze jakykoli pokles tlaku
vede ke sniZeni rozpustnosti vzduchu. Jednim ze soulasnych trendd v konstrukci tlumica
vyvo) jednoduchého (beztlakového) tlumice, kde bude piitomnost vzduchovych bublin
maximalné potlalena. Vyvo takového tlumice vyzaduje Siroké spektrum znalosti z mnoha
oborli a nasazeni modernich technologii pro vyzkum, mezi néz patfi metody diagnostiky

akustické diagnostiky, optické metody a mnohé dalsi.

Cilem této prace je:

- seznamit se se zakladnimi principy hydraulickych tlumiéi a problematikou kavitace v
hydraulickém tlumiéi.

- prostudovat moznosti detekce vzniku a vyvoje kavitace v tlumi€i a provést resersi
literatury zaméfené na toto téma.

- provést ovéreni pouzitelnosti metod k detekei kavitace na kalibraéni komore.

- seznamit se s modulem kavita¢ni komory v hydrodynamické laboratofi z hlediska
moznosti aplikace metod detekce kavitace a jejim ovladanim.

- na zaklad€ ziskanych poznatki piipravit metodiku detekce kavitace na kavita¢ni komote

a provést uvodni spusténi modulu kavita¢ni komory.

13



2 HYDRAULICKE TLUMICE

2.1 Tlumiée a odpruzeni vozidla

Tlumide jsou tlumici prvky mechanickych soustav uzitkovych zafizeni. Lze je rozdélit
na mechanické, plynové a kapalinové. S kapalinovymi (hydraulickymi) tlumiéi se miZeme
setkat napi. u sedadel ridi¢h, automatickych pracek a hlavné ve vozidlech viech typl (osobni,
pfivésna, stavebni, zemédélska, kolejova, ...). Hydraulicky tlumi¢ je zde soucasti podvozku
vozidla - odpruzeni (soustava pruzina — tlumi¢). Nejvice se tlumi€ pouzivad v odpruzeni
osobnich automobill a nejvice namahany je u nakladnich automobilii. Obecné vykona tlumié
pi1 bézném provozu okolo 1200 funkénich cyklli na jeden kilometr a pfitom plni velmi
dilezitou funkci. Je proto vhodné problematiku vozidlovych tlumi¢i popsat.

Odpruzeni vozidla zajituje komfort a bezpe€nost jizdy, kdy pfi ndrazech a kmitani
naprav vozidla v disledku nerovnosti vozovky dochazi pouze k omezenému pienosu téchto
narazii a kmitl na podvozek a karoserii. Chrani tak osoby a naklad vozidla pied otiesy a
zvySuje zivotnost dili vozidla. Hlavn€ ale zabezpedyje staly styk pneumatiky s povrchem a to
1 u nerovné vozovky, ¢imz je dosazeno pienosu sil v soustavé kolo — vozovka. Vozidlo je tedy
fiditelné a jizda bezpeéna.

Predpokladem pro spravnou funkénost odpruzeni je funk&nost tlumife. Na jeho
funk&nost ma vliv fada Cinitelli. Jednim z nich je také kavitace, jejimZ projevem je zpénéni

tlumi¢ového oleje, spalovani tlumi¢ového oleje a narusovani povrchu ventilového systému.

2.2 Princip hydraulickych tlumi¢a

Hydraulicky tlumié plni funkei tlumeni narazi a tlumeni kmitd. Pfi pohybu vozidla
nerovnosti vozovky rozpohybwi pruzné ulozenou karoserii vozidla. Tlumié se snazi karoserii
Luklidnit® tlumici silou. Z hlediska pfemén energii se vn¢j§i mechanicka energie pfemeéni
pomoci pistu stlacujiciho tlumiCovy olej na tlakovou energii. Soucinitel stladitelnosti
tlumiCového oleje mize byt napi. 6,71.10"° pal Kdyz provedeme myslenou uUpravu
nasledujiciho vztahu pro stlacitelnost kapaliny a vyjadtime si tlak, zjistime, ze i velmi mala
zména objemu vytvoii obrovsky tlak diky velmi malé hodnoté soucinitele stladitelnosti

kapaliny.

s__Lov F} 2.1)
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Nasledné proudi stladovany tlumiovy olej skrz soustavu Skrticich elementti tlumice. Proudi
z mista s obrovskym tlakem do mista s nizkym tlakem. Tato zm¢na tlaku je téméi okamzita.
Pribéh zmény tlaku lze popsat pomoci Bernoulliho rovnice 2.2, zde v tlakovém tvaru.
Nasledwjici rovnice 2.3 vysvétlyje pfimo pfeménu tlakové energie na kinetickou energii a o
mnoho mensi tlak. Pi1 zanedbani vyskového Clenu je na levé strané rovnice (stlaCovana ¢ast
oleje) obrovsky tlak a téméf nulova rychlost. Naopak na pravé strané rovnice (nestlatovana

¢ast oleje) je vysoka rychlost protékajiciho oleje skrz skrtici elementy a téméf nulova tlakova

energie.
w) W)
epg it =k gt (22)
w w?
Pit PPt Ry (23)

U
wi{w, PP,

Z energetického hlediska v souhmu dochazi k pfeméné tlakové energie disipaci na
tepelnou energii. Pfi¢inou je hydraulicky odpor soustavy skrticich elementi tlumice,
turbulence, zatopeny proud oleje do nestlatované ¢asti, zpénéni a dalsi jevy, podilejici se na
disipaci energie.

Popsana zména tlaku v tlumi¢ovém oleji hydraulického tlumie by mohla zapiicinit

vznik kavitace. Proto se pro zamezeni kavitace hydraulické tlumi¢e rizn€ upravuji.

2.3 Konstrukce hydraulickych tlumici

Hydraulické tlumice 1ze z konstruk¢niho hlediska rozd¢lit na dva typy - na teleskopické
tlumice a pakové tlumice. Pakové tlumice se jiz nepouZivaji a dnes se setkavame vyhradné s
tlumidéi teleskopickymi.

Teleskopické tlumide lze rozdélit na tlumice s prabéznou tyéi, dvoupléstové a
jednoplastové. Na obrazku 2.1 je jednoduse zobrazena konstrukce teleskopickych tlumiéi a

umisténi Skrticich element, ve kterych dochézi ke kavitaci.
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Tlumi¢ Dvouplastovy Jednoplastovy
s prabéznou tyci tlumié tlumié
Obr. 2.1: Jednoducha schémata teleskopickych tlumiéi s oznacenim
mist Skrticich elementt (vzniku kavitace) [2]

2.4 Dvouplastovy teleskopicky kapalinovy tlumi¢

Konstrukei tohoto tlumice popiseme na bézném automobilovém tlumici. Tlumi¢ sestava
z vnitiniho (pracovniho) valce a vnéj§iho valce. Vnitini valec je vyplnén tlumicovym olejem,
ktery pii pohybu pistnice s pracovnim pistem protékd skrz Skrtici elementy (zde pistové
ventily) tohoto pistu. Pii pohybu pistnice do tlumice se méni vyuzitelny objem vnitiniho valce
0 objem casti pistnice zasunuté dovnitf. Piebyvajici olej proudi pies dalsi Skrtici elementy
(zde spodni ventily) ve spodni ¢asti tlumice do vnéj§iho valce. Prostor ve vn&jSim valci
nazyvame vyrovnavaci. Je tvofen z Casti olejem a z ¢asti bud’ pretlakovanym technickym
plynem (pak muzeme nazev kapalinovy zaménit za pfidavné jméno plynokapalinovy), nebo je
tento prostor spojen svolnou atmosférou a je tvofen vzduchem (pak tlumi¢ nazyvame
v nezménéné podobé dvouplastovy teleskopicky kapalinovy tlumic). Technickym plynem pro
pretlakovani byva nejcastéji dusik. Pretlak je rizny, dany vyrobcem a velikosti tlumice, napf.
0,4 — 0,8 MPa. Timto je popsana konstrukce pro technologii tlumeni. Dale je zde mnoho
dalsich ¢asti (upevnovaci kloub, tésnéni, ucpavky, ... ). Obrazek 2.1 vysvétluje pochody pfi
¢innosti (prepousténi, zmeéna objemu, ...) uvniti tlumice a nasledujici obrazek 2.2 zobrazuje

kompletni konstrukci v&etné jednotlivych dilt popisovaného tlumice.
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. horni upevnovaci kloub

. ochranna trubka

. tésnéni pistnice

. vedeni pistnice

. vngjsi valec s plynem

. pistnice

. pracovni pist, skrtici elementy (pistové ventily)

. vnitini valec s tlumic¢ovym olejem

e B e Y

. Skrtici elementy (spodni ventily)
10. pouzdro

11. spodni upeviiovaci kloub

Obr. 2.2: Dvouplastovy teleskopicky kapalinovy tlumic [3]

2.5 Jednoplastovy teleskopicky kapalinovy tlumi¢

Konstrukce tohoto tlumice popiSeme opét na bézném automobilovém tlumic¢i. Tlumic
sestava z jednoho valce, ktery je valcem pracovnim. Vnitfek je tvofen pistnici s pistem
a Skrticimi elementy (zde pistové ventily), délicim pistem, tlumiCovym olejem a technickym
plynem. Tento technicky plyn je nejcastéji opét dusik. TlumicC je jim plnén pretlakem, napf.
2,5 — 3,5 MPa a je opét rizny dle vyrobce a velikosti tlumice. Délici pist rozdéluje valec na
dvé casti a oddéeluje olejovou ¢ast a plynovou ¢ast. Tim se zabrani promichani oleje a plynu.
Funkce tohoto tlumice je obdobna jako u predchoziho tlumice z kapitoly 2.4, zde ale dochazi
k pratoku pouze skrz jednu soustavu Skrticich elementi. Existuji také konstrukéni varianty
bez déliciho pistu, kde je provedena uprava proti promichani oleje a plynu pomoci odrazové
piicky, nebo uklidiiovacim pistem. Popsana zakladni konstrukce obsahuje jesté dalsi
konstrukéni prvky (upeviiovaci kloub, pouzdra, ... ). Na obrazku 2.1 je zjednoduSené
zobrazena konstrukce a lze jim vysvétlit jak probiha Cinnost tlumi¢e. Na obrazku 2.3 je

popsana kompletni konstrukce popisovaného tlumice.
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. horni upevnovaci kloub

. tlumicovy olej v pracovnim valci tlumice
. tésnéni pistnice

. vedeni pistnice

. ochranny kryt

. pist, Skrtici elementy (pistové ventily)

. délici pist

. plyn

. pouzdro

el B e Y e

10. spodni upeviovaci kloub

11. pistnice

Obr. 2.3: Jednoplastovy teleskopicky kapalinovy tlumi¢ [3]

2.6 Skrtici elementy tlumi¢i

Skrtici elementy vytvafeji hydraulicky odpor $krceni pritoku tlumiového oleje.

Z konstruk¢niho hlediska existuji dva typy - otvory a ventily.

2.6.1 Otvory

Skrtici element ,,otvor” je jednoducha tzka priichozi dira s konstantnim prifezem. Pro
riznou rychlost pistnice a tedy razny tlak je pak diky tomuto konstantnimu prurezu rizné
tlumeni. Pokud je rychlost pistnice velka, nestaci tlumiCovy olej protékat a Skrceni je silné a
opacné pii malych rychlostech tlumiCovy olej protéka bez pozadované odezvy Skrceni a
tlumeni je nedostatecné. Pfi prvnim popsaném stavu, kdy je rychlost pistnice obrovska je
obrovsky i narust tlaku. Z Bernoulliho rovnice lze vyjadfit, ze tlumiCovy olej o stavu
obrovské tlakové energie s téméf nulovou rychlosti se zméni na stav obrovské rychlosti a
nizkého tlaku. Toto je predpokladem pro vznik kavitace. TlumiCovy olej se zpéni. Dojde ke

zmené charakteristiky tlumice.

2.6.2 Ventily

V soucasné dobé€ se nejvice pouziva provedeni ventilu jako tuha deska nebo kuzelka a
poddajna planzeta. Pritla¢na sila u tuhé desky nebo kuzelky je vyvozena pfitlacnou pruzinou a
u poddajné planzety je piitlatna sila vyvozena napétim svazku predepjatych planzet. Vyhodou

ventilu je zména pruto¢ného mnozstvi, dana sekundarnim otvorem a pfitlatnou silou. Ventil
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je navrzen tak, aby sekundarni otvor, ktery je obdobou Skrticiho elementu ,,otvor poskytoval
konstantni prato¢ny prifez pro malé rychlosti a pro velké rychlosti se tlakova sila na ventil
zvysi natolik, Ze se pruzinou pfitlaovany ventil nadzvedne ze sedla a tim se zvétsi pratocny

prufez. Dosahne se tak optimalniho tlumeni a eliminuji se podminky pro vznik kavitace.

Obr. 2.4: Motocyklovy tlumi¢ s predepjatymi planzetami [4]

2.7 Model tlumice

Diagnostika kavitace v hydraulickém tlumic¢i je pii riznych podminkach provozu
vozidla prakticky nemozna. Za timto ucelem se vyrabé&ji modely hydraulickych tlumica, ve
kterych se simuluje stav provozu hydraulického tlumice a provadi se diagnostika. Jednim
takovym zafizenim je i zkuSebni zafizeni Hydrodynamické laboratore, Katedry casti a
mechanismu stroju Technické univerzity v Liberci. Nachazi se v aredlu koleji Vesec v Liberci
na Doubi.

Popis tohoto zafizeni a metodika diagnostiky bude popsana v dalsich kapitolach.
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3 HYDRAULICKY OLEJ

3.1 Primyslové oleje

Priimyslové oleje jsou oleje pouZivané v primyslovych zafizenich. Primyslovy olej se
vyrabi ze zakladového oleje piidanim aditiv, ktera zlepiuji jeho pozadované vlastnosti.
Zékladovy olej existye minerdlni a synteticky. Mineralni olej je ropny produkt ziskany
frakéni destilaci ropy. Synteticky olej je vyroben modernimi chemickymi technologiemi ze
zakladnich ropnych frakci nebo zakladnich chemickych latek. Vyhodou syntetickych oleju
oproti mineralnim olejim je predvyrobni definovani pozadovanych vlastnosti danych stejnou
stavbou vsech molekul. Stavba molekul mineralniho oleje oproti syntetickému oleji je dana
komplexnosti smési uhlovodikli vzniklou pii vyrobé frakéni destilaci. Aditivy nejcastéji
byvaji antioxidanty pro zlepSeni oxidacni stability, inhibitory koroze pro snizeni korozniho
pusobeni oleje a modifikatory tfeni pro vytvoieni ochranné vrstvy na povrchu télesa
zabranjici pfimému kontaktu tfecich ploch.

Primyslové oleje 1ze rozdélit podle Ucelu. Prumyslovy olej pak oznacujeme jako strojni,
turbinovy, kompresorovy, pfevodovy, hydraulicky,. ..

Klasifikace pramyslovych olejii je uvedena v CSN 65 6601. Je provedena podle
viskozitni tfidy, coz je ¢iselna hodnota kinematické viskozity v [mzs' ] pii 40°C ve stiedu
intervalu hodnot této viskozitni tfidy a viskozitniho indexu VI [-]. Kinematicka viskozita jako
zakladni parametr klasifikuje a oznacuje primyslové oleje: ISO VG diselna hodnota
kinematické viskozity, napt. ISO VG 32. Rada hodnot pro ozna¢eni kinematické viskozity je

2,3,5,7,10, 15, 22, 32, 46, 68, 100, 150, 220, 320, 460, 680, 1000, 1500,

3.2 Hydraulické oleje

Hydraulické oleje se vyrabi v §irokém spektru vlastnosti a vyrobeil. Dilezité vlastnosti
sledované vyrobci a uvadéné v technickém listu jsou hlavné viskozita, viskozitni index, bod
vzplanuti a bod tuhnuti. Daldi informace o vlastnostech je mozné ziskat napf.
z bezpeénostniho listu napfiklad barvu, zapach, hustotu, tlak nasycenych par, rozpustnost ve
vodé, korozi na médi, neutralizaéni &islo, odluéivost vzduchu, ... Mnozstvi uvadénych hodnot
se 1isi dle vyrobce. Nékteré z téchto adaji piedstavuji dilezité hodnoty 1 pro vypoéty a
zpracovani v pocitatovych programech méficich zafizeni pro diagnostiku kavitace. Jedna se
zejména o hustotu, kinematickou viskozitu, tlak nasycenych par, povrchové napéti. Dale je
pak nutné znat tepelnou vodivost, teplotni vodivost a rychlost zvuku v daném hydraulickém

oleji.
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V nasledujici tabulce je uveden vybér nékolika oleja klasifikace ISO VG 32

5 ) 5 . 3 p —_— i 5 i
s kinematickou viskozitou okolo 32 mm“s™ s hodnotami veli¢in, které jsou pro nas dulezité.

Znacka oleje Oznaéeni Hustota | Viskozita Tiak na;grc shyeh Ponv;;tg(t)ive
Jednotka kg.m-3 | mm’s’ kPa N.m"
Poznamka pfi 15°C | pfi 40°C pfi 20°C
PARAMO OT-HP 3 880 32 <0.01 -
ESSO HLP 855 31 - -
ESSO NUTO H 32 872 32 <0.013 -
MOBIL HLPD 32 873 32 <0.01 -
MOBIL SHC 524 854 30 <0.013 -
oL euy | BatranHv32 | 874 32 ; -
MOGUL HV 32 875 32 <0.01 -
SHELL Tellus 32 875 32 - -
TEXACO Rando HD 32 870 32 - -
AGIP 0S80 32 885 30 - -

Tab. 3.1: Vybrané vlastnosti ruznych znaCek hydraulickych oleju

3.3 Hydraulicky olej zkuSebni komory

Zkusebni model hydraulického tlumice v Hydrodynamické laboratori KST TUL na
Doubi pouziva hydraulicky olej dodany firmou Brano Group a.s. pro jimi zadané zkousky na
tomto modelu hydraulického tlumice. Vlastnosti tohoto oleje nejsou znamy. Z tohoto duvodu
bylo nutné zméfit diive vyjmenované dilezité veliCiny. Z ¢asové-ekonomickych duvoda a

dostupnosti méficich zafizeni se jedna o méfeni hustoty, povrchového napéti a viskozity.

3.3.1 Méteni hustoty hydraulického oleje

Hustota byla zméfena v laboratorich Katedry chemie Technické univerzity v Liberci pfi
prilezitosti méfeni povrchového napéti. Bylo pouzito sklenéného hustoméru (areometr)
LABORA s referenéni teplotou 20°C a pro rozsah hustot 800 — 850 kg.m™. Méfeni bylo
provedeno opakované pii teploté 20°C v odmérném valci a vzdy vykazovalo stejnou hodnotu

p=848kg.m‘3.

Obr. 3.1: Sklenény hustomér [5]
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3.3.2 Méfeni povrchového napéti hydraulického oleje

Mgieni povrchového napéti 6 [Nm™'] hydraulického oleje v zavislosti na teploté t [°C]
bylo provedeno v laboratofich Katedry chemie Technické univerzity v Liberci odtrhavaci
metodou. Mefici zafizeni se skladalo ztorzniho dynamometru PHYWE Germany
s platinovym prstencem, termostatické lazné HAAKE C10, laboratornich zvedaku,

krystaliza¢ni misky, teplomért a stojanku s uchytkami.

stojanek s uchytkami  teplomér oleje  teplomér lazné

laboratorni zvedék termostaticka lazen laboratorni miska s olejem torzni dynamometr

Obr. 3.2: Sestava pro méfeni povrchového napéti

Pii méfeni byla v termostatické lazni ménéna teplota po 5°C a to od 20°C do 40°C. Pri
téchto teplotach byla opakované desetkrat méfena sila F [m.N] nutna pro odtrzeni v nasem
pripadé platinového kruhového prstence od fazového rozhrani. Nasledné bylo na zakladé
zjisténé sily a konstanty U[m] platinového prstence dopoc€itano povrchové napéti. Pro vypocet
byl pouzit statisticky program kapesniho kalkulatoru CASIO. V piiloze P1 jsou naméfené a

vypocitané hodnoty tohoto méfeni a v pfiloze P2 jsou graficky znazornény.
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Pro vypocet bylo pouzito nasledujiciho vztahu 3.1 a konstanty platinového prstence
U=0,061m.

a=im (3.1)

U m

3.3.3 Meéfeni viskozity hydraulického oleje

M¢éfeni viskozity bylo provedeno v laboratofich technickych meéfeni Katedry
energetickych zafizeni TUL. Jednalo se o méfeni viskozity v zavislosti na teploté pomoci
rotatniho viskozimetru Rheotest 2. Viskozimetr Rheotest 2 ma instalovanou vodni lazen

s termostatickym ohfevem. Viskozimetr a pomocna zafizeni jsou na nasledujicim obrazku.

termostat teplomeér termostaticka lazen s valci a olejem viskozimetr indikaéni pfistroj
Obr. 3.3: Viskozimetr

Princip meéfeni je zaloZen na pienosu sily mezi dvéma valci prstencem méfené
kapaliny. Vng&jsi valec je pevny. Je ve styku s temperovaci lazni a tim temperuje méfenou
kapalinu. Vnitini valec se otaci a je pfipojen na valcovou Sroubovitou pruzinu. PruZina se pfi
rizném zatizeni otacejiciho se valce od méfené kapaliny rtizné deformuje. Tato deformace je
mirou prenaSeného kroutictho momentu a je snimana odporovym potenciometrem, ktery je

zapojen do mustku. Vystupem mustku je hodnota proudu odpovidajici prenasenému
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momentu. Nasledné se na indika¢nim pfistroji odecitaly dilky o [-] a pomoci uvedenych
vypoltovych vztahtt 3.2, 33 a 3.4 byla dopocitana dynamicka viskozita p [Pas] a
kinematicka viskozita v [m”s™]. Pro vypoget byla pouZita namé&fena hustota p=848kg m~,
konstanta valce Z=0,51 a smykovy spad D,=729 [s"'], coZ je pro dané nastaveni viskozimetru

konstanta ode¢tena z tabulky.

r :Z‘a{ﬁ] (3.2)

m

o [Pa-s] (3.3)

v= ﬁ["’—} G4)

Viskozita hydraulického oleje je zpracovana v pfiloze P3 a zavislost na teploté graficky

znazornéna v pfiloze P4.

3.3.4 Vyzkum kavitace v primyslovych olejich

Vyzkum kavitace v prumyslovém oleji je vétsinou vazan na aplikaéni sféru
hydraulickych prvki a mechanismi (tlumice, zubova Cerpadla, armatury, ...). Nasledwici
reerSe je z ¢lankt uvedenych ve zdroji [7].

Samotnym vyzkumem kavitace v oleji se zabyva napif. skupina védcii z University of
Twente v Enschede, Nizozemsko. Meged, Y., Venner, C.H.; Napel, WE v ¢&lanku
Classification of lubricants according to cavitation kriteria pojednavaji o klasifikaci riznych
druht oleji (mineralni, synteticky, ...) podle kavitadniho kritéria. Zakladem tohoto vyzkumu
byla potieba vytvofit metodiku hodnoceni kavitadnich vlastnosti olejli, protoze neexistovala
Zzadna mezinarodni standardizace v této oblasti. Védecka prace je tvofena dvéma oddily.
Jeden se zabyva numerickymi simulacemi s Reynoldsovymi rovnicemi a teorii elastické
deformace. Na zaklad€ téchto simulaci se formuluji vlastnosti oleji, napt'. kavita¢ni energie,
okolni tlak. Prakticky oddil se zabyva testovanim 20 oleji. Toto testovani bylo provedeno
hlinikovym hrotem spojenym s oscilatorem. Hrot byl ponofen v oleji a po uréitou dobu
vibroval. Piitom byla periodicky méfena hmotnost hrotu a dopo€itana zména hmotnosti. Tim

byla zjisténa kavitacni eroze pii definovanych podminkach a daném oleji. Poznatky obou
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Casti prace byly shrnuty dohromady a korelovany. Vytvofily tak podklad pro konstruktéry

hydraulickych zafizeni dle druhu oleje.

Vyzkumu kavitace pro aplika¢ni sféru se vénwji napiiklad W. Kollek, Z. Kudzma, M.
Stosiak a J. Mackiewicz. V ¢lanku Possibilities of diagnosing cavitation in hydraulic systems
uvadéji mizné metody testovani. Jeden z experimentil je zaloZzen na pusobeni podtlaku na
sloupec vzorku oleje. Ptitom se sleduji velikosti vznikajicich kavitatnich bublin. Dal3im
experimentem je simulace déji v Cerpadle. Pomoci pistového mechanismu, vytvaiejiciho
v komoie ze specialniho skla podtlak, simuluji vznik kavita¢nich bublin.

Vyzkumu vzniku kavitace na modelu ventilu se zabyvaji MARTIN, C.S., MEDLARZ,
H., WIGGERT, D.C., BRENNEN, C. ve ¢lanku Cavitation inception in spool valves.
Vyzkum byl proveden na zvétseninach skuteCného ventilu a zabyva se sledovanim podminek
pro vznik poskozeni ventild hydraulickych mechanismi pro rizné otevieni ventild a riizna

Reynoldsova ¢isla.
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4 KAVITACE

4.1 Jev kavitace

Kavitace je fyzikalni jev, zahmujici vznik, riist a zanik dutin v kapaliné. Kavitace je
v mnoha pfipadech na zavadu, ale v uréitych pfipadech muze byt i prospésna. Negativné
pusobi v hydraulickych strojich a zafizenich. Stava se tak v Cerpadlech, ve vodnich turbinach,
armaturach, hydraulickych systémech a také v hydraulickém tlumiéi. V té€chto strojich je
hlavnim projevem kavitace erozivni dinek na povrchy materialu soudasti strojii. Zadouci
ucinky kavitace se projevyi pii ¢isténi slozitych tvarovych povrchid, odplynéni kapalin,
odbarvovani organickych roztokii, urychlovani chemickych reakci a v medicinalnich
aplikacich.

Kavitacni bubliny jsou tvofeny plynem, parami kapaliny, nebo kombinaci obou a
vznikaji za urcitych podminek danych tlakem a teplotou kapaliny v ur¢itém misté - kavita¢ni
oblasti. Pii poklesu tlaku na tlak nasycenych par (tzv. kavitaéni tlak) dojde k poruseni
kontinuity a lze vizualné pozorovat vznik bubliny. Pokud tlak setrva na hodnoté kavitacniho
tlaku nebo poklesne, budou bubliny rast Pokud tlak vzroste, dochazi k implozi a bublina
zanikne. Pii zaniku se plyn v dutin€ smr§tuje a para kondenzuje a okolni kapalina se snaZi

prostor zaplnit, ¢cimz dojde k velkému razu. To je pfi¢inou zminéné kavitacni eroze.

4.2 Rozdéleni kavitace

Kavitaci lze rozdélit dle nékolika hledisek: principu vzniku, teploty a tlaku, tvaru, mista
vyskytu, kvalitativniho popisu, poétu cykli, principu generovani, oblasti vyskytu a aplikace a
dalSich.

Rozdéleni dle principu vzniku:. Parni kavitace - hlavni podil vnittku bubliny je para,

difiize plynu z kapaliny lze zanedbat a mnozZstvi plynu se tedy pfi expanzi nemeni.
Phmova kavitace - do bubliny z nasycené kapaliny
vnika difizi plyn, je tvofena plynem a objem bubliny roste pomalu

Rozdéleni dle teploty a tlaku: Konstanii tiak, rist teploty na bod varu - kavitace

jako var kapaliny.
Polkles tlaku, konstantni teplota — napi. pii proudéni.

Rozdéleni dle tvaru: Kapsovité - bubliny zapliuji uréitou oblast, napi. v tryskach.

Viaknové - bubliny jsou fetézcem ve tvaru vlakna, napf. na koncich

lopatek lodnich Sroubi.
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Rozdéleni dle mista: Kavitacni oblast uvnitf proudu.

Kavitacni oblast na obtékané plose.

Rozdéleni dle kvalitativniho popisu: Pocinajict kavitace - malé pravé vnikajici bubliny.

Rozvitd kavitace - vét§i bubliny, roste mnozstvi.
Zanikajict kavitace - bubliny mizi a zanikaji.

Rozdéleni dle poctu cvklt: Kavitace stabilni - velky pocet cykla.

Kavitace pFechodnd - jeden nebo malo cyklu.

Rozdéleni dle principu generovani: A) tlakové principy generace

Hydrodynamicka kavitace - pozorujeme i
v mistech, kde proudici kapalina zrychluje a kde dochéazi poklesu tlaku, napf. v potrubi,
Cerpadlech, turbinach, ...
Akusticka kavitace - bubliny vznikaji plisobenim
zmén tlaku ultrazvukovymi pulzy, napf. ¢idténi povrchu, medicinalni aplikace, ...
B) energetické principy generace
Opticka kavitace - bubliny vznikaji na zakladé
energie leticich laserem generovanych fotonil, které jsou zaostieny do daného mista.
Casticova kavitace — je zaloZena na pisobeni
elementarnich ¢astic mikrosvéta a jejich energie v prehfatych kapalinach.
Kavitace v hydraulickém tlumiéi lze zafadit do hydrodynamickeé kavitace. Dalsi zafazeni
neprovadim, protoze se mize vyskytovat ve vice variantach. Napfiklad mize byt pocinajici,

rozvita a 1 zanikajici dle faze, ve které se v daném méfeni nachazime.

4.3 Popis jevu kavitace

Kavita¢ni bublinu lze popisovat bez zavislosti na ¢ase, ve statické rovnovaze, nebo ji lze
popsat dynamicky se zavislosti na Case. Pii popisu se vychazi z riznych pfedpokladia na
vlastnosti kapaliny a bubliny. Mezi tyto vlastnosti patii stladitelnost, vlivy vazkost,
povrchové napéti, termodynamické vlastnosti kapaliny, druh stavové zmény plynu bubliny,
rychlost ristu a zaniku bubliny, ...

V kapaliné vznika velké mnozstvi kavita¢nich bublin o spektru riznych velikosti. Mezi
témito bublinami mohou byt malé vzdalenosti a mohou se navzajem ovliviiovat. Pak by
nebylo prakticky mozné provést popis kavitace. Proto je vhodné uvazovat osamocenou

bublinu v kapaliné.
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4.4 Kavitatni jadra a pevnost kapaliny v tahu

Abychom mohli popsat statickou rovnovahu kavitaéni bubliny v kapaling, je nutné
vysvétlit prvopocateéni jevy dileZité pro vznik kavitace. Jestlize ma vzniknout kavitace, je
nutné, aby v kapalin€ byla tzv. kavita¢ni jadra. Kavita¢ni jadra jsou velmi malé bublinky, ze
kterych vznikne kavita¢ni bublina. Tato mikroskopicka kavita¢ni jadra vzniknou piekonanim
pevnosti kapaliny v tahu. Pevnost kapaliny v tahu je napéti potiebné k odtrzeni molekulovych
vrstev kapaliny. Po ptekonani koheznich sil vrstev molekul dojde k poruseni homogenity
kapaliny a v mistech tohoto poruseni jsou kavitaéni jadra. Predpokladem pro piekonani této
pevnosti je jeji zeslabeni mikrobublinkami nerozpusténych plyni nebo tuhymi neéistotami.

Teoreticky Cistd kapalina ma pevnost v tahu o hodné vétsi nez kapalina realna.

4.5 Kavita¢ni bublina ve statické rovnovaze v kapaliné

Statickd rovnovaha kavitaéni bubliny v kapaliné se pouziva pro uréeni parametri pfi
zacinagjici kavitaci. Tuto statickou rovnovahu lze popsat za uréitych predpokladu. Mezi tyto
predpoklady patii: bublina se nachazi v kapaliné a vnitfek je tvofen plynem a parou kapaliny
v niz se nachazi, bublina je dokonale kulatad, nezanedbavame povrchové napéti kapaliny,
sdileni tepla mezi vnittkem bubliny a okolni kapalinou je dokonalé, nedochazi k difizi plynu
z kapaliny do bubliny, nebo z bubliny do kapaliny.

Nasledné budeme uvazZovat bublinu, kde tlak uvnitf je konstantni a roven soudtu
parcialnich tlakil plynu p, a nasycenych par p,. Budeme-li hledat zminénou rovnovahu, tak
tento soucet predstavuje jednu stranu rovnosti. Druhou stranou rovnosti je plsobeni okolni
kapaliny na bublinu tlakem p;, ke kterému je pii¢ten kapilarni tlak pc rozhrani bublina -
kapalina. Kapilarni tlak je roven podilu dvojnasobku kapilarniho napéti ¢ a poloméru bubliny

R Jestlize tyto strany dame do rovnosti, mizeme napsat tuto rovnici.

P, +D, =D +D, (4.1)
2c
Do+ D= Pt (4.2)

Uvedenou rovnici lze pravami popsanymi napf. v [11] prepsat do tvaru pro okolni tlak
kapaliny p, V této upravé je pouZita rovnice pro stavovou zménu idealniho plynu
z potateéniho stavu do obecného stavu. Predpoklada se idealni plyn a izotermickd zména
stavu. Poate¢ni stav veliin bude ozna¢ovan s dolnim indexem 0. Nové se zde tedy objevuje

pocatecni polomér bubliny R, a tlak kapaliny py pii tomto poCateénim poloméru,
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3
pi=p, +[pm = ek i—GM%J —%J (4.3)
Rovnici 4.3 lze graficky znazomit po dosazeni fyzikalnich vlastnosti kapaliny, ¢iselnych
hodnot p., pw, & a volbe parametru Ry.
Graf byl vytvofen pro v méfeni pouzity hydraulicky olej o teploté 25°C s povrchovym
napétim ¢ = 33,36. 10° Nm™. Tlak nasycenych par byl pouzit obecné pro tento druh oleje p, =
1000 Pa. Atmosféricky tlak byl pouzit obecny Py = 101 325 Pa. Po¢atecni polomér bubliny

byl zvolen ve &tyfech hodnotach Ry =0.2 . 10°,0.5.10°,1.0.10°, 1.2 .10° m.

nm- 90 -+ —RU = 15
o
2 R =10
T 70+ 0
R, = 0.5
50 L _
/ —Ry=02
NERELELEE P
30k R, [10°m] W
Pnp
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R[10°m]

Graf 4.1: Zavislost rovnovazného tlaku v kapaling€ na poloméru bublinky

Pouzijeme-li znalosti matematické analyzy, tak kladna hodnota prvni derivace tlaku

v kapaling€ dle poloméru kavitacni bubliny urCuje funkci rostouci a naopak zaporna hodnota
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této derivace funkci klesajici. Jestlize dojde ke zméné poloméru bubliny, ktera se nachazi
v rovnovaze a tato zména vymizi, miZeme fici, Ze staticka rovnovaha bubliny byla stabilni
dle rovnice 4.4. Pokud zména poloméru bubliny nevymizi a naopak se bude zvétSovat,

muzeme ficl, ze statickd rovnovaha byla nestabilni dle rovnice 4.5.

ap,

—5 <0 44
T (44)
an>

—+L>0 4.5

Jestlize poloZime danou derivaci rovno nule, nalezneme extrém funkce — kriticky bod,

jemuz odpovida kriticky polomé&r bubliny R, a kriticky tlak v kapaliné pg..

oR

Tato minima — kritické body jsou v grafu 1 rozpoznatelné. Kdybychom nalezli feseni
rovnice 4.6 pro viechny pocatetni poloméry, vznikla by kiivka spojujici vSechny kritické
poloméry a kritické tlaky. V grafu 1 jsou body minima funkce 4.3 spojeny carkovanou
fialovou Carou. Tato kfivka rozdé€luje funk&ni zavislost 4.3 pro dany polomé&r na vétev stabilni
a nestabilni. Vétev nalevo od kritického bodu je stabilni a vétev napravo od kritického bodu a
kriticky bod je nestabilni. Pii libovolném vyskytu bubliny miZze dojit k zvétSeni nebo
zmen3eni poloméru, k tzv. porucham.

Popis chovani bubliny na stabilni vétvi

Jestlize se bublina nachazi na stabilni vétvi (R<R.) a jeji polomér se zvétdi (aniz by
prekroc¢il kriticky polomér) nebo zmensi, tak se po této poruse bublina navrati do
rovnovazného stavu. Vysvétluje se to tim, zZe pfi zvetdeni poloméru bubliny klesne tlak v
bubliné nepfimo s tfeti mocninou poloméru bubliny a kapilarni tlak klesne pouze s prvni
mocninou polomé&ru. Tim tedy vyznam kapilarniho tlaku vzroste a navrati ji do rovnovazného
stavu. Analogicky lze popsat zmenseni polomé&ru bublinky, kdy naopak tlak v bubliné roste
s treti mocninou a kapilarni tlak roste pouze s prvni moc¢ninou,

Popis chovani bubliny na nestabilni vétvi

Jestlize se ale bublina nachazi na nestabilni vétvi (R>R,) a jeji polomér se zvétsi, objem
bubliny bude rist. Vysvétlit to lze na zakladé hodnoty tlaku plynu v bubliné. Je maly oproti
tlaku nasycenych par, protoze bublina je velka. Se zménou poloméru nedochazi k vyrazné
zméné tlaku plynu uvnité bubliny. Pak celkovy tlak v bublin€ miZeme povazovat za tlak

nasycenych par. Co se ale bude ménit je kapilarni tlak. Ten se zmensi s rostoucim polomérem

30



a tak tlak nasycenych par bude pii snizovani kapilarniho tlaku podporovat rist bubliny.
Naopak pii zmenSeni poloméru bubliny kapilarni tlak poroste a zpisobi zmensSeni bubliny.
ZmenSeni bude az na kriticky polomér,

Popis chovani bubliny v kritickém stavu

Pokud se bude bublina nachazet v kritickém bodu, tak mohou nastat dvé varianty
rovnovahy, stabilni a nestabilni. Stabilni je v pfipadé zmensSeni poloméru bubliny a nestabilni

je pii zvétdeni polomeru bubliny.

Matematickou upravou vztahti 4.6 a 4.3 muizeme kriticky polomér R, v zavislosti na

pocatecnim poloméru R, vyjadrit nasledujicim vztahem.
3-R
Rc = RD d “12.—0 . pg(l (4?)
\ g

Tato zavislost je znazornéna v nasledujicim grafu pro v méfeni pouzivany olej.

q;g 10 —
o g .l
o /

0 |
0 5 10 15 20 25
Ro[10°m]

Graf 4.2: Zavislost kritického poloméru na poc¢atecnim poloméru

Kriticky polomér R, dosadime do rovnice 4.3 a ziskame vztah popisujici kriticky tlak

PRe.

(4.8)

.

w2

2.0
DPr. =D, — Tc

Zavislost 4.8 je pro nami pouzivany olej v nasledujicim grafu.
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Graf 4.3: Zavislost kritického tlaku na poCatecnim poloméru

4.6 Dynamika kmitajici kavitacni bubliny

Popis dynamiky kavitaéni bubliny zahrnuje fadu okolnich vlivl, jak je uvedeno
v kapitole 4.3. Je dilezité fici, ze kavitani bublina pii své aktivité vykonava roztahovani a
smrstovani, coz pfedstavuje kmitavy pohyb. Odvozeni bylo provedeno nekolika autory a dle
autora se metodika odvozeni muze lisit. Rovnice 4.9 se nazyva Rayleigh-Plessetova a
popisuje dynamiku kmitajici kavitacni bubliny. Tato prace se dynamikou kavitacni bubliny

nezabyva.

ps)=20)_p e 2 gy 20 LR (+9)
o) 3 P'R p°R
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5 METODY DIAGNOSTIKY KAVITACE

5.1 Diagnostika kavitace

Kavitaci diagnostikujeme riznym zpusobem. Existuje mnoho metod pro konkrétni
aplikace v Cerpadlech, turbinach, armaturach, apod. Obecné metody jsou metoda opticka a
metoda akusticka. Optické metody diagnostiky kavitace jsou napf. metody stinova, $lirova a
PIV. Akustické metody jsou napi. detekce kolapst bublin pomoci hydrofond, nebo metoda
meéfeni spektra bublinek pomoci akustického bublinkového spektrometru (ABS). V této praci

jsou vysvétleny pouze nékteré.

5.2 Metoda ABS

Metoda ABS je specidlni akustickd metoda. ABS znamena akusticky bublinkovy
spektrometr. Méfime s nim mnozstvi bublinek v zavislosti na poloméru a objemovy zlomek
bublinek v zavislosti na poloméru. Metoda je zaloZzena na Sifeni zvuku ve viceslozkovém
systému latek. Jedna latka je spojita a v ni je rozptylena druha latka. Spojita latka je v nasem
pripadé tekutina — hydraulicky olej a v ni je rozptylena plynna latka — kavita¢ni bubliny.
Takovéto prostiedi nazyvame disperznim prostiedim. Pro disperzni prostiedi plati, ze rychlost
zvuku, ktera disperznim prostfedim prochazi, zavisi na frekvenci tohoto zvuku. VSechny
mozné zavislosti tykajici se prostiedi, spektra bublinek, Sifeni zvuku a dalsi, Ize popsat
matematicky. Vzniknou tak rovnice, které se fesi specialnimi numerickymi metodami ve
vypocetnim softwaru. Vysledkem vypoctu jsou jiz zminéné zavislosti.

Pro feSeni rovni¢ je potieba ziskat signal zvuku, ktery prosel prostfedim a zadat vstupni
fyzikalni vlastnosti méfené tekutiny a okolniho prostfedi, dale pak parametry signalu a
vypoltu. Vstupni vlastnosti okolniho prostiedi jsou atmosféricky tlak a teplota vzduchu.
Vstupni vlastnosti tykajici se méfené tekutiny jsou Poissonova konstanta plynu uvnitf
kavitatni bubliny, teplotni vodivost plynu uvnitf kavitacni bubliny, tlak nasycenych par
tekutiny, rychlost zvuku v tekuting, viskozita tekutiny, hustota tekutiny a povrchové napé&ti
tekutiny. Mezi parametry signalu a vypoctu patii vzdalenost pfevodnikii, volba parametri
signalu a mnozstvi méfenych poloméri. Mezi parametry signalu patfi minimalni a maximalni
frekvence, pocet vyslanych signal(l pro vypocet primérnych hodnot a dal$i. Nakonec se
zadavaji parametry pro omezeni feeni. Jedna se 0 minimalni a maximalni polomér bublin a

pocet velikosti bublin,
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Zvukovy signal se vysila a pfijima pomoci piezokeramickych pievodniki. Prvni
piezokeramicky prevodnik — vysilac vysila zvukovy signal. Druhy piezokeramicky prevodnik
— pfijima¢ pfijme zvukovy signal vyslany prvnim pfevodnikem. Pfevodniky jsou tvofeny
aktivni Casti, opérnou Casti a styCnou casti. VSechny tyto Casti jsou zality ve specialnim
materialu. Rozméry a material vSech Casti a zaliti jsou navrzeny dle ur€itych pravidel. Lisi se
od sebe pro pifimy kontakt stekutinou pii ponofeni do tekutiny, nebo pro dalsi vrstvu,
oddelujici pfevodnik od tekutiny. Pfi naSich méfenich pouzivame konstrukci pfevodniku
vhodnou pro kontakt pies dalsi vrstvu. Pievodniky se umist'uji proti sobé a musi byt od sebe
akusticky odizolovany, aby se zvukovy signal nepfenasel pfimo pies konstrukci. Na druhou
stranu musi byt zabezpeCen dobry pienos zvukového signalu mezi prevodnikem a méfenym
prostfedim. Zajistuje se to pomoci vhodného prostiedi, které ma podobnou akustickou
impedanci jako material prevodniku. Vhodny material je v naSem piipadé plexisklo (PMMA)
a dale indiferentni gel, ktery se nanese na pievodnik. Prevodnik s gelem se pfimackne na
velmi malou mezeru k méficimu okénku z plexiskla a poté se pfevodnik stabilné ustavi.
Piezokeramické prevodniky jsou kalibrovany pro rizny interval vysilani a pfijimani. Z tohoto
divodu se pouzivaji pievodniky pro stiedni oblast hodnoty frekvence 50 kHz a 150 kHz. Tim
se zahme celda oblast od hodnot frekvence mensi jak 50 kHz a wveétSich jak 150 kHz.
Nasledujici graf 5.1 znazortiuje, jak piiblizné vypadaji oblasti pouziti prevodniku, které jsou

soucasti méficiho zafizeni ABS.
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Graf 5.1: Charakteristiky prevodnikii ABS
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Pii méfeni je z méfici karty opakované vysilan signal rizné frekvence, ktery je zesilen
vykonovym zesilovacem. Do prvniho pfevodniku — vysilace pfichazi zesileny zvukovy signal
a je prevodnikem vyslan do méfeného prostiedi. PfijimaC piijima zvuk, ktery prosel
disperznim prostiedim, kterym je ,,utlumen”. Zvukovy signal pfijimace je zesilovaci zesilen a
vede se do méfici karty. Méfici karta je AD/DA pievodnik signalu. Z méfici karty se data

pfevedou do pocitace. Nasledujici obrazek 5.1 ukazuje zakladni méfici sestavu.

O O
150 kHz § » 08
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N o @
v 00
O ‘*’0
Oc?l}
2
e 9
0S5
50kHz o9&
ey o.uO
W & C'Cg
030-3

DYNAFLOW

Prevodniky Méfici komora Vodice Meéfici karta Vodice Pocitac s vypoctovym softwarem
Obr. 5.1: Zakladni méfici sestava ABS

Data z méfici karty v pocitai zpracovava specialni vypoctovy software. Matematické
feSeni spociva ve vyreseni Fredholmovych integralnich rovnic prvniho fadu. Tyto rovnice
maji tvar dle obecného vztahu 5.1, kdy neznama funkce poCtu bublinek v zavislosti na
poloméru N(R) je v integralu s tim, Ze meze integralu neobsahuji proménnou. Funkce f(®) je
zavisla na frekvenci signalu zvuku a je zjiSténa vlastnim mefenim. Vypoctové numericke

algoritmy softwaru byly navrhnuty pracovniky vyrobce.

flo)= Tk(a), R)- N(R)-dR (5.1)

Yo
Pii feSeni rovnic mohou nastat problémy s definovanim uritych mezikrokd vypoctu.
Nejcastéji se problém tyka rozlozeni bodu pii déleni intervalu pro feSeni. Pak mohou vznikat
nestability feSeni. Existuji ale i dalsi problémy, napfiklad s omezujicimi po¢atecnimi
podminkami (rovnice plati do ur¢itého objemového zlomku, oscilace bublin jsou sféricke, ...)
nutnymi pro existenci vubec né&akého feSeni. Proto je vhodné provést vzdy rtzna kalibra¢ni

mefeni a na jejich zakladé rozhodnout o pravdivosti skuteCného meteni.
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Na obrazovce pocitace v aplikaci ABS je pii kazdém méfeni zobrazen prubéh vsech

vysilanych a jim odpovidajicich prijimanych signald. Vysilany signal je modry a pfijimany

signal je Cerveny. Na nasledujicim obrazku 5.2 je obrazovka softwaru ABS a na obrazku 5.3.

jsou prubéhy nékolika vybranych signalu pro rizné frekvence.

Prabéh vysilaného a piijimaného signalu pro danou frekvenci

% mee1.abs - ABS Acoustic Bubble Spectrometer &
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Obr. 5.2: Obrazovka softwaru ABS
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Obr. 5.3: Prubéhy vybranych signalt riznych frekvenci
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Po zpracovani signalu software vypocte metodou zmin€nou v této kapitole spektrum
bublin v1 mm® v daném okamZiku. Na obrazku 5.4 je obrazovka softwaru ABS s dil¢im

vysledkem. Ve spodni Casti je grafické vyobrazeni spektra bublin a objemového podilu bublin

v daném okamziku. Vrchni grafy zobrazuji data o zeslabeni signalu.
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Obr. 5.4: Vysledek dil¢iho méreni ABS

Grafickych zpracovani dil¢ich vysledki jako na obr. 5.4 je na zakladé pozadavki na
mefeni (vzorkovani, rozdéleni intervalu na polomery bublin, ...) mnoho. V3echny vystupy
jsou ukladany jako textovy soubor, ktery lze prevést do programu Excel a v ném provést
vysledné grafické zpracovani.

Vyrobcem meéficiho zafizeni ABS je americkd firma Dynaflow Inc. Akusticky
bublinkovy spektrometr je patentovany vyrobek a v souCasné dobé existuje na celém svété

pouze nékolik kust v nékolika vyvojovych variantach.

5.3 Stinova metoda

Stinova metoda je jednou ze zakladnich a nejjednodussich optickych metod pro
zobrazovani nehomogenit (kavitacnich bublin) v transparentnich tekutinach. Kavita¢ni
bubliny se vhodnym zpuisobem prosvétluji laserem, halogenovou lampou nebo xenonovou

lampou. Za meéreny objekt se vklada stinitko nebo zafizeni pro zaznam obrazu, takzvaného
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stinogramu. Fyzikalnim principem je zakfiveni trajektorie paprska svétla pii prichodu
bublinou. Tyto paprsky maji v riznych mistech riznou hustotu, coZz se projevi na stinitku
stiny a obrysy. Na stinogramu bude kavitacni bublinka tmavsi, protoze svétlo se v bublince
rozptyli o hodné vice nez pfi prachodu pouze tekutinou. Princip této metody si 1ze jednoduse
predstavit na Skolnim pokusu, kdy se sklo ponofi do kapaliny o stejném indexu lomu, napf.
détského oleje a zmizi. Je to dusledkem toho, ze rozhrani mezi nemisitelnymi latkami je
nasemu oku, které je v tomto pokusu stinitkem, viditelné pouze pii rizném indexu lomu obou
latek. Stinové metody jsou vhodné pro diagnostiku v prostiedich velkych zmén indexu lomu.
V nasSem priipadé pouzivame pro osvétlovani paralelni svazek paprsku, ktery je vytvoren
studiovym bleskem na obrazku 5.5 FOMEI Digital PRO 1200 s vykonem zablesku 1200Ws a
pilotni halogenovou zarovkou o vykonu 1000W. Paprsky pilotni Zarovky se po prachodu
prostfedim zaznamenavaji vysokorychlostni CCD kamerou. CCD kamera je digitalni kamera
pfipojitelna k pocitaci. Zakladem je CCD snimac, coz je elektrotechnicka soucastka. Princip
je zalozen na fotoelektrickém jevu u polovodicu, kdy se kvanta fotonu pfemeéni na elektricky
naboj na elementarni jednotce CCD snimace, takzvaném pixelu. Tento naboj se ptsobenim
elektrostatického pole posouva pies celou pixelovou miiz, zesili se a pfevede na datovy kod.
Jestlize se jedna o rychlokameru, je tento proces velmi rychly v fadu statisict za sekundu.
Tim je vytvoren obrazovy digitalni zaznam. Ve Skolni laboratofi pouzivame CCD
rychlokameru znacky Integrated Design Tools, Inc., Redlake, typu MotionPro X3 s moznym

zaznamem az 64000 snimk za sekundu, viz obrazek 5.6.

Obr. 5.5: Studiovy blesk [16] Obr. 5.6: CCD rychlokamera [14]

Touto CCD rychlokamerou ziskame stinogram v digitalnim formatu, ktery lze na
pocitaci v programu Matlab ve specialni aplikaci zpracovat. Tato aplikace ma slangovy nazev
pocitani ryze“. Aplikace sama obrazek zpracuje. Principem je ztmaveni pozadi a vyfazeni
objektt, které nemaji nic spoleéného s definovanymi objekty pro pocitani a zesvétleni

sledovanych bublin. Princip Uprav je zobrazen na obrazku 5.7. Aplikace nasledné provede
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soucet bublin, které odpovidaji zadani. Matlab podpora na internetu uvadi, Ze spolehlivost

vypoltu je 95%.

Obr. 5.7: Postup zpracovani obrazku pii metodé ,,pocitani ryze* [18]

5.4 Detekce kolapsti kavitaénich bublin pomoci hydrofonti PVDF

Hydrofon je snima¢ tlaku $ificiho se v kapaliné. Pro detekci kolapsu kavitanich bublin
se PVDF (Polyvinylidenfluorid) vysokofrekven¢ni hydrofony pouzivaji pro své obecné dobré
vlastnosti pro tento typ méfeni. Hydrofony PVDF jsou zalozené na piezoleketrickém jevu,
kdy tlakova sila mechanicky deformuje piezoelektricky element. Deformaci se element
polarizuje na urcity elektricky naboj. Elektricky naboj o ur€itém napéti je zesilovaci zesilen a
zmefen. Zmeifena hodnota napéti odpovida tlaku v kapaliné. Hydrofony jsou specialné
kalibrovany a tlak mefi velmi pfesné.

Pii vyzkumu kavitace se hydrofony pouzivaji pro méfeni kolapst kavita¢nich bublin.
Kolaps s sebou nese tlakovy pulz, ktery méfime. Vystupem je velké mnozstvi tlakovych
signald, které se pii zpracovani od sebe oddéluji a analyzuji. Ve $kolni laboratofi pouzivame
vysokofrekven¢niho PVDF hydrofonu RP Acoustic RP 19 s. Signal je zesilen a veden do
oscilografické karty National Instruments NI PXI 5105, 8-CH, 60 MS/s. Z oscilografické
karty je veden pfes sbérnici do National instrument NI PXI 1033 Chassis a z této sbérnice do

pocitace. Nasledn¢ se signal vyhodnocuje a zpracovava v pocitaci.

= RP 198

R £

Obr. 5.8: Hydrofon PVDF [17]
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6 MERENI
6.1 Kalibra¢ni méieni ABS

6.1.1 Kalibra¢ni trat’

Kalibra¢ni trat’ slouzi pro kalibra¢ni méfeni. Kalibratnim méfenim v naSem piipadé
oznaCujeme méfeni, které je vibec prvnim takového druhu ve skolni laboratofi KEZ TUL a
slouzi nam pro obecné posouzeni vhodnosti metodiky ABS pro dalsi, jiz skute¢né méfeni na

modelu hydraulického tlumi¢e v Hydrodynamické laboratoii KST TUL.

6.1.2 Popis principu kalibratniho méteni na kalibra¢ni trati pomoci ABS

Ukolem bylo otestovat méfeni spektra bublin pomoci ABS v hydraulickém oleji.
Zékladni myslenka byla opakované dopovat obéh hydraulického oleje ur€itym objemem
vzduchu pomoci injekéni stiikacky a sledovat zménu spektra bublin. Po prichodu vzduchu
Cerpadlem se vzduch rozmisi v oleji a vzniknou bubliny. Tato smés se necha urcity ¢as obihat
a bubliny tak budou homogenné rozprostieny v celém objemu systému. Pak se provede
mefeni pomoci ABS. Tento postup se nékolikrat opakuje. Princip méfeni a zakladni sestava je
znazornéna na obrazku 6.1.

Injekeni stiikacka Pryzova hadice Zatka Kalibraéni komora Meéfici karta

Injektovany vzduch Odstiedivé Cerpadlo Hydraulicky olej Prevodnik Pocitac¢
Obr. 6.1: Sestava kalibrac¢ni trati
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Vedouci prace navrhl zkonstruovat kalibrac¢ni trat’ z komory, ktera je k dispozici
z diivéjsi vyzkumné ¢innosti. Komora je se§roubovana z hlinikovych profilt, ¢elni stény jsou
z plexiskla a maji na sob€ piipevnéna hlinikova mezikruzi. Na tato mezikruZi se pies korkové
tésnéni plipeviiyi specialni piiruby s okénky pro pievodniky. Korkové tésnéni ma v tomto
piipadé funkei izolantu prenosu zvukového signalu mezi piirubou s pfevodniky a mezikrzim,
Tento zvukovy signal by se pfenesl pfes hlinikovou konstrukci na piijima¢ piimo bez
priichodu tekutinou. Konstrukce je tedy vytvoiena specialné€ pro metodu ABS.

Pred sestrojenim kalibra¢niho zafizeni bylo nutné komoru natiit specialni ¢ernou barvou
pro zabran¢éni koroze od hydraulického oleje a pro moznost osvétlovani laserem se
zamezenim nekontrolovatelnosti odrazu od hlinikového povrchu komory. Bylo nutné sehnat
nékolik topenaiskych a hydraulickych armatur, pryzové hadice a ¢erpadlo. Komora pak byla
smontovana nasledné popsanym zpisobem a byla vyménéna té€snéni. Komoru lze
odstranénim zatek ve spodni a vrchni ¢asti vytvorit jako priatoénou komoru. Misto zatky ve
vrchni ¢asti komory se zasroubovala dvouvsuvka a na ni T kus. Na T kus je v horizontalnim
sméru pfisroubovana redukce na pryzovou hadici a ve vertikalnim sméru zatka, kterou se
v systému za provozu vytvoifi mirny pfetlak. PryZzova hadice pokrafuje k odstiedivému
Cerpadlu z pracky supertatramat. Z Cerpadla pokra¢uje druhd pryzova hadice, ktera vede
k redukci a k dvouvsuvce a tim je pfipojena ke spodni ¢asti komory. Po smontovani se systém
pies T kus ve vrchni ¢asti komory naplni hydraulickym olejem. Uzavie se a miré pietlakuje
zatkou. Posledni nedilnou asti je plastova injekéni stfikacka se zavitem, do kterého se
zaSroubuje jehla. Tato injekéni stfikacka dodava do obéhu piedem dané mnozstvi vzduchu,
Proto musi byt pfipojena na okruh. Vyiesilo se to jednoduchym zpisobem. Stiikacka s jehlou
byla napichnuta na pryzovou hadici. Pfedepjatost pryze jehlu nepropustné obepnula a z mista
napichnuti pryZzové hadice neunikal zadny hydraulicky olej. Na nasledujicich obrazcich je

kalibraéni trat’.

41



Pocitac Meéfici karta Kalibra¢ni komora Prevodniky

Obr. 6.2: Kalibra¢ni trat

Sani Vytlak

Injekéni stiikacka Cerpadlo z pragky supertatramat

Obr. 6.3: Detail ¢erpadla a injek¢ni stiikacky
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o E # ’ i :
Pievodnik 150 kHz Pfevodnik 50 kHz
Obr. 6.4: Detail kalibra¢ni komory

6.1.3 M¢éfeni na kalibra¢ni trati

Postup meéfeni na kalibrani trati je popsan v nasledujicim odstavci. Komora
s hydraulickym olejem byla nékolik dni ponechana v klidu. V tomto obdobi byly z komory
vyvedeny vsechny bublinky ulpivajici na sténach a v Cerpadle.

Vlastni méfeni zacalo zakladnim nastavenim softwaru ABS. Nejdulezitéjsi casti bylo
nastavit vstupni vlastnosti hydraulického oleje a okolniho prostredi, dale pak vlastnosti
signalu a jinad omezeni. V priloze PS5 jsou obrazky ztohoto nastaveni ve Ctyfech krocich.
V prvnim kroku se méfeni pojmenovalo, nastavil ¢as a datum. Ve druhém kroku byly za
pomoci vedouciho bakalaiské prace nastaveny parametry signalu dle jeho zkuSenosti.
Dulezité bylo spravné zméfit vzdalenost pfevodnika, ze které se stanovi objem méfené
oblasti. Ve tfetim kroku byly zadany parametry tekutiny a okolniho prostiedi. Byl zméfen
aktualni atmosféricky tlak a teplota vzduchu v laboratofi. Parametry tekutiny byly zjistény

z méfeni viskozity, méfeni kapilarniho napéti, atd. Tlak nasycenych par nebyl méfen, ale dle
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telefonického rozhovoru se specialistou na oleje firmy Paramo, a.s. je tlak nasycenych par
hydraulickych oleji pro tuto skupinu oleju priblizné stejny. K dispozici byly udaje z reSerse
oleji ztabulky 3.1 této bakalaiské prace. Byla kdispozici rychlost zvuku 1535ms™
v hydraulickém oleji. V poslednim, ¢tvrtém kroku, bylo nastaveno omezeni vystupu. Byl
urCen interval méfenych polomeéru a také rozdéleni tohoto intervalu na jmenovité polomery,
kterymi se bude pfifazovat poCet bublin v daném objemu. Nastaveni se uloZilo.

Po nastaveni bylo nutné provést referenéni méfeni. K tomuto referencnimu méfeni se
vztahuji vSechna nasledujici vlastni méfeni. Pii referencnim méteni byl obéh hydraulického
oleje zastaven. Toto méfeni bylo ulozeno a software ABS zného pii vypoctech odebira
potiebna data pro vyhodnoceni vlastnich méfeni.

Nasledovalo mé&feni na kalibragni trati. Cerpadlo bylo spusténo a po 5 minutach bylo do
ob&hu pied Eerpadlem injekéni stiikatkou vpraveno 0,2 em® vzduchu. V erpadle se vzduch
s olegjem promisil. Tato smés se nechala 15 minut obihat a potom se provedlo prvni méfeni po
dobu 5 minut. Po méfeni se ¢erpadlo na 5 minut vypnulo a nechalo vychladnout. Cely tento
postup se peétkrat opakoval. Do obéhu bylo vpraveno celkem 1 em® vzduchu po castech o
objemu 0,2 cm’® vzduchu.

V probihajicim méfeni se za pét minut vytvorilo okolo 15ti takovychto dil¢ich vystupt
ve formé textového souboru ukazkou v piiloze P6. Textovy soubor se prevedl do tabulkové
formy programu Excel. V Excelu bylo provedeno grafické vyhodnoceni, které je kompletné
v pfiloze P7 a ukazkou viz. obrazek 6.5. Jedna se o grafické vyhodnoceni poctu bublin v
zavislosti na poloméru bubliny a objemového zlomku bublin v zavislosti na poloméru
bubliny. Zagina se od prvniho méfeni po prvni injektazi. Celkové grafické vyhodnoceni je

v priloze P8 a P9. Slovni hodnoceni vysledku v piilohach je v odstavci 6.1.4.

Grafické znazornéni poétu bublin v zavislosti Graficke znazornéni objemového zlomku bublin v
na poloméru pro méfeni &.1 _ zavislosti na poloméru pro méfeni &.1
1200 § 70E07 _
3 1000 S 6OEO7 -
3 g0 || = 5.0E-07
- g 4.0E-07 -
i %‘ 3.08-07 -
400 2.0E-07
200 1.0E-07 “
0 Moo 0.0E+00 Lol .".".“.".".."."." IIIIIIIIIIIIIIIIIIIIIII
© H o &H »
©® S E S S S © & F & L PSP
Polomé&r bubliny [um] Polomér bubliny [um]

Obr. 6.5: Ukazka vyhodnoceni vysledki méfeni ABS
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6.1.4 Zhodnoceni méreni na kalibra¢ni trati

Vétsina d&u v piirodé je néjak podobnd se zakladnimi matematickymi funkcemi.
V nasem piipadé to byl pfedpoklad exponencidlniho rozdéleni spektra bublin v hydraulickém
oleji. Grafy spektra bublin ve vSech pfilohach jsou klesajici piiblizné dle exponencialniho
rozdéleni. Nejvice je nejmensich bublin a &im v&tdi bubliny jsou, tim je jich méné.
Komplexné to plati u druhého méfeni. Pro daldi méfeni uz predpoklad komplexn¢ neplati.
Pribéh grafu je u prvniho poloméru tietiho a &tvrtého méfeni porusen, mnoZstvi pro nejmensi
polomér je mensi neZ mnoZstvi pro vétsi polomeér. Pro paté meéfeni je situace obdobna, ale u
prvniho poloméru vykazuje enormni narist mnozstvi bublin, Tyto neobvyklé ukazy mohou
byt zpasobeny predem definovanymi podminkami pro vypodetni algoritmus vyrobce nebo
tim, Ze nemame vhodny rozsah pfevodnikli a v krajnich intervalech je spravnost feSeni
omezena.

Viechna méteni vykazuji u poloméru pies 30 mikrometri propad mnoZstvi. MiiZe to byt
chyba metody, nebo fyzikalni jev.

Vyskytuje se proluka mezi bublinami poloméru nad 100 mikrometri a bublinami okolo
350 mikrometru. Pocet bublin okolo poloméru 350 mikrometrii se téméf neméni. Predpoklada
se, ze je to dano opét rozsahem prevodniki a v daném piipadé horni mezi, nebo se jedna o
chybu jiného charakteru a to bublinou v indiferentnim gelu vzniklou pfi nanadeni na
pievodnik.

V piiloze P8 je do jednoho grafu vynesena zavislost spektra bublin viech méfeni na
injektovaném vzduchu. Pocet bublin s rostoucim mnozstvim injektovaného vzduchu roste.
Podobné v piiloze P9 roste s vétsim mnoZstvim injektovaného vzduchu objemovy podil
bublin na celku. V grafech v P8 a P9 nevynadim bubliny s polomérem okolo 350 mikrometrti,
protoze je to nejspiSe nepravdivy udaj, dany rozsahem pievodniku nebo bublinami
v indiferentnim gelu,

Meéieni spektra bublin ve vodé pomoci ABS je nejcastési. Méfeni spektra bublin
pomoci ABS v hydraulickém oleji tak znamé neni a proto neni zZadna moznost srovnani a

konzultace. Vysledky tedy mohou mit 8§ir§i vyznam, ktery prozatim nelze specifikovat.
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6.2 Stinova metoda

6.2.1 Popis méfici sestavy

M¢éfeni stinovou metodou na kalibracni trati bylo dopliikovym méfenim k metodé ABS
a bylo charakteru seznameni s touto metodou. Snimky proto nebyly v Matlabu zpracovany a
provedlo se pouze vizualni hodnoceni. Pro osvétlovani tekutiny v kalibra¢ni komoie byla
pouzita halogenova pilotni zarovku studiového blesku a svétlo se soustfedilo kuzelovym
nastavcem do prostoru snimaného kamerou. Svétlo od lampy mélo obrovskou intenzitu, ktera
nebyla pro osvétleni vhodna. Proto se mezi komoru a lampu vlozilo piskované sklo.
Piskované sklo rozptylilo paprsek takovym zplsobem, ze pifimé svétlo do objektivu uz
nemélo takovou intenzitu. Proti osvétleni se na stativu umistila CCD kamera, spojena
s ovladacim panelem na pocitaci. Kalibracni komora a jeji pfisluSenstvi je stejné konstrukce
jako v pfipadé meéfeni ABS. Na obrazku 6.6 je meéfici sestava stinové metody. Na tomto

obrazku neni zachycen pocita¢. Datové kabely v pravém dolnim rohu vedou k pocitaci.

S
et

¢ 2 A - Y
At -i, "l & &

Studiovy blesk —lampa Piskované sklo Kalibra¢ni komora CCD rychlokamera

Obr. 6.6: Méfici sestava stinové metody
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6.2.2 Snimkovani stinovou metodou a vizualni hodnoceni snimku

Po ustaveni kamery se provedla kalibrace CCD kamery bez osvétleni halogenovou
lampou. Kamera byla zaostfena na misto v rovin¢ vedené prostiedkem komory a nastavila se
doba expozice. Nasledovalo nékolik snimani pfi dvoji injektazi asi 0,5cm*® vzduchu. Nebyl
stanoven presny postup mefeni, protoze se jednalo, jak jiz bylo zminéno, pouze o metodické
méfeni. Vysledkem byly fady snimki (stenogramii) tekutiny s bublinami, viz. obrazek 6.7.
Vybér vzdy jednoho snimku z fady ze vSech meéfeni je v piiloze P10. V této piiloze jsou
sefazeny snimky v ¢asovém sledu po prvni a druhé injektazi s nékolikaminutovym odstupem.
Obrazky v pfiloze P10 popiseme. VSechny snimky obsahuji Cernou svislou ¢aru, coz je stin
dratu pruméru 1,5mm, vlozeného do komory pro snadnéjsi zaméreni mista stfedu komory.
Z vizualniho hodnoceni prvniho snimku, kde je na levé strané primarni proud po prvni
injektazi, je zfejmée, ze v kapalin€ bylo pfed prvni injektazi témer nulové mnozstvi bublin. Po
,homogenizaci“, rovnomérném rozptyleni bublin pomoci nékolikaminutového obé&hu
Cerpadla, je na druhém snimku poznat zmenSeni mnozstvi bublin touto ,,homogenizaci* oproti
primarnimu proudu na prvnim snimku. Po nékolika minutach byl ziskam treti snimek a z n¢ho
Ize vyhodnotit, ze doslo ke snizeni po¢tu bublin v tekutiné. Nasledovala druha injektaz a na
¢tvrtém snimku je situace po ,homogenizaci“ druhé injektaze. Vizualné je poznat, ze doslo
k velkému naristu mnozstvi bublin a také vznikly bubliny vétsich polomért. Posledni paty

snimek je ziskan kratce po ¢tvrtém snimku a nedoslo téméf k zadné zméné.

Obr: 6.7: Ukazka snimku (stinogramu) z méteni

47



6.3 Model hydraulického tlumite

6.3.1 Uel zatizeni

Model hydraulického tlumi¢e Hydrodynamické laboratofe KST TUL je specialni
testovaci zafizeni, které simuluje skute¢né d¢€je v hydraulickych tlumicich. Na tomto zafizeni
probihalo nékolik experimentli, napiiklad vyzkum charakteristiky ventili hydraulického
tlumie.

V soudasné dobé probiha pfiprava experimentu, ktery se bude zabyvat vznikem kavitace
za Skrticim elementem hydraulického tlumice. Jedna se hlavné o optimalizaci Skrticich
elementl pro co nejvétsi zamezeni vzniku kavitace.

Kompletni pfiprava experimentu sestava z konstrukce zafizeni, ovladani zafizeni a
mnoha dalSich krokid. Dnes je védeckymi pracovniky zkonstruovan model tlumice. Pracuje se
na jeho ovladani a regulaci. Dalsi pfipravnou Casti je vytvofeni vhodnych podminek pro

méfeni. Na tomto modelu tlumiée se bude méfit metodou ABS a optickymi metodami.

6.3.2 Popis zaiizeni

Model hydraulického tlumice je pritoné zafizeni velmi se piibliZujici skute¢nému
hydraulickému tlumi¢i. Velikostné se jedna o model tlumife vétsiho rozméru, podobnému
tlumi¢i v nakladnich automobilech a vozech v kolejové dopravé. Na nasledujicim obrazku 6.8

je schéma modelu, které bude popsano.
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Obr. 6.8: Schéma modelu hydraulického tlumice [19]

Model se sklada z komory a pistu se Skrticimi elementy. Komora ma nizkotlakou a
vysokotlakou ¢ast. Obé& tyto Casti maji tlakové snimace hydrofony, které slouzi pro fizeni
hydromotoru a pro diagnostiku zmény tlaku pfi ,,probéhnuti tlumic¢e™ pii rizném kavita¢nim
zpeénéni hydraulického oleje. Nizkotlaka ¢ast ma otvory pro umisténi oken, na které se
pritisknou pirevodniky ABS, nebo pro prosvétlovani a snimani optickymi metodami.
Nizkotlaka a vysokotlaka ¢ast je oddélena pistem tlumice. Pist ma dvé sady otvort, na kterych
jsou pomoci pruzin pfitisknuty kruhové planzety a je tak vytvoren druh $krticiho elementu -
ventil. V pfipadé modelu tlumice je pist nepohyblivy a nechava se skrz jeho Skrtici elementy
protékat hydraulicky olej. Je to tedy pfesny opak realného tlumice, kde se naopak pist
pohybuje. Proud hydraulického oleje je vytvoren linearnim hydromotorem. Pfi pohybu pistu
smérem vzhlru se olej nechava protékat skrz Skrtici elementy pistu do nizkotlaké ¢asti. To je

stav, kdy je tlumi¢ ve funkci. Naopak, kdyz jde pist smérem dolu, olej by se protlacoval skrz
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nizkotlakou ¢ast. Nizkotlaka ¢ast ma okna z materialu, ktery by velky tlak od hydromotoru,
simulujici hmotnosti nékolika tun, nemusel pevnostné zvladnout. Proto byla konstrukce
vytvorena se sekundarnim okruhem, pies ktery se hydraulicky olej pfevadi pfi pohybu pistu
dolu do prostoru nad pist. V tomto sekundarnim okruhu je pneumaticky fizeny kulovy ventil.
Otevira a uzavira okruh dle faze ve které se model nachazi. Z téchto diivodu je na nizkotlakou
Cast pripojen vyrovnavaci zasobnik, ktery vyrovnava mirné zmény tlaku. DalSi soucasti
modelu je nékolik dopliujicich prvkd, jako napiiklad ventil pro plnéni modelu, na ktery je
pfipojena hadice a pumpa, dale vypoustéci a pojistovaci ventil. Obrazek 6.9 a 6.10 ukazuje
skute¢ny model hydraulického tlumi¢e v Hydrodynamicke laboratofi KST TUL na Doubi.
V poptedi je komora tlumice a v zadni Casti je stojan hydromotoru.
Hydrofon vysokotlaké ¢asti  Stojan hydromotoru

Komora modelu  Mista pro okna

Plnéni komory modelu hadici Tlakomér vyrovnavaci nadoby Hydrofon nizKotlaké ¢asti

Obr. 6.9: Model hydraulického tlumice (pohled zepiedu)
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Komora modelu Sekundarni trat Kulovy ventil Senzor pozice otevieni kulového ventilu

o

Vysokotlaka ¢ast Nizkotlaka ¢ast ~ Mista pro okna Vypoustéci ventil  Hydromotor

Obr. 6.10: Model hydraulického tlumice (pohled z boku)

6.3.3 Metodika méieni na modelu hydraulického tlumice

Béhem zpracovavani bakalarské prace byla nekolikrat navstivena laboratof modelu
hydraulického tlumice, kde doSlo k seznameni s konstrukci a funkci. Model je tésné pred
dokon¢enim. Pii jeho dokonCovani pied prvnim spusténim se vyskytlo nékolik problému,
které byly v pribéhu ¢asu odstranény. Jednim z problému bylo fizeni ¢innosti modelu. Model
je fizen pocitaCovym programem, ktery je ve vyvoji. Program je zavisly na nékolika
senzorech z komory a celého zafizeni. Senzory tlaku - hydrofony nizkotlaké a vysokotlaké
casti zpusobovaly problémy, protoze snimaly namisto tlaku signal zjinych zafizeni,
pfenasejici se pies konstrukci. Tento problém byl odstranén specialni piechodkou
s teflonovym odstinénim hydrofonu.

Dokoncovaci proces je témér u konce. Do této doby prob&hlo nekolik testovacich
zkousek. Pii poslednim bylo provedeno méfeni tlaku hydrofony na nizkotlaké a vysokotlaké

¢asti.
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Po dokonCeni testovacich méfeni bude provadéno méfeni metodami popsanymi
v kapitole 5. Prvni méfeni bude metodou ABS se stejnym postupem jako v pfi méfeni na
kalibraéni komote. Provede se referenéni méfeni a pak se pro rizné pritoky hydraulického
oleje vytvorené hydromotorem zméfi spektrum bublin. Soucasné s méfenim ABS bude méfit
tlak na tlakovych snimacich a teploty na termo¢lancich na ventilu, ktery se Skrcenim pii
pratoku zahiiva. Po tomto méfeni se necha olej nékolik hodin ustdlit. Nasledné se stejné
meéfeni provede optickymi metodami. Bud' metodou stinovou se zadnim osvitem stejnym
zplisobem jako na kalibra¢ni komoie, nebo laserem s botnim osvitem. Po méfeni se olej
necha opét né€kolik hodin ustalit. Pak probéhne tieti méfeni, kdy se pro pritoky stejné jako
v ptedchozich méfenich bude detekovat kavitatni sum pomoci hydrofonu. Vysledky budou
zpracovany. Vystupem bude vyhodnoceni vzniku kavitace v $irdich souvislostech. Nasledné
bude mozné pomoci simuladnich metod vytvofit vhodny geometricky tvar $krticich elementd
hydraulického tlumice, ktery kavitaci eliminuje a stejnym zplisobem spravnost navrhu ze

simula¢niho programu otestovat méfenim.
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7 ZAVER

Prace obsahuje popis konstrukce a funkénich principti hydraulickych tlumi¢a. V
souvislosti s konstrukci jsou zde uvedeny poznatky tvkajici se problematiky kavitace v
hydraulickém tlumic¢i. Dalsi ¢ast obsahuje seznameni s hydraulickymi oleji. Je zde uveden
vybér nékolika pouZivanych oleji a jejich vlastnosti, popis praktického méfeni hustoty,
povrchového napéti a viskozity. V zavéru této Casti je provedena referSe literatury zabyvajici
se vyzkumem kavitace v oleji. Bakalarska prace obsahuje teoreticky Uvod do jevu kavitace.
Jsou zde vytvoreny grafy zavislosti rovnovazného tlaku v kapaling, kritického poloméru a
kritického tlaku na po¢atecnim poloméru bubliny pro olej pouzivany v kavitaéni komofte ve
skolni laboratofi. Dalsi ¢ast je zaméfena na metodiku diagnostiky kavitace v hydraulickém
tlumici. Jezde uveden popis a vysvétleni principli metod a zafizeni s dlirazem na vybaveni
laboratofi Technické univerzity v Liberci. Po uvedeni do problematiky diagnostiky nasleduje
kapitola 0 méfeni. Z divodu posouzeni vhodnosti metody ABS pro méfeni kavitace v oleji
bylo provedeno kalibraéni méfeni na kalibraéni komofe. Kalibraéni komora byla navrzena a
sestavena specialné pro toto kalibraéni méfeni. Méfeni bylo zpracovano a vyhodnoceno, jak je
uvedeno v kapitole o méfeni a piilohach bakalaiské prace. Na kalibraéni komoru byla
aplikovana 1 stinova metoda. Pro stinovou metodu bylo provedeno pouze vizualni hodnoceni,
taktéz uvedené v kapitole o méfeni a pfilohach. Posledni ¢ast této kapitoly uvadi popis a
metodiku méfeni na modelu hydraulického tlumide v laboratofi na Doubi.

Poznatky ziskané ze zpracovani bakalafské prace jsou podkladem pro hlubsi studium
kavita¢nich dé&ji v hydraulickém tlumi¢i. Bylo by Zadouci dikladné se zaméfit na
neobjasnéné jevy pit méfeni ABS, na které bylo poukézano pii popisu vysledki. Potom bude
mozné meéfit spektrum kavitanich bublin na komofe modelu hydraulického tlumice
v laboratofi na Doubi. V soucasné dobé je k dispozici pro model tlumice jeden pist bez aprav
na Skrticich elementech. Snahou by mélo byt provadét mizné geometrické upravy Skrticich
elementil tlumie tak, aby se kavitace co nejvice eliminovala. Piedpokladem pro tyto upravy
je proménlivost prifezu, kdy nebude dochazet ke sniZeni tlakli naraz, ale postupné. Tyto
upravy by bylo vhodné modelovat v simula¢nich programech. Nasledn¢ by se pist vyrobil a
na modelu tlumi¢e by se proméfila spravnost navrhu. Vysledkem by mohla byt co

nejvhodnéjsi optimalizace geometrie hydraulického tlumice pro zamezeni kavitace.
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Pfiloha P1 - Tabulka hodnot méfeni povrchového napéti a hustoty hydraulického oleje

MERENiI POVRCHOVEHO NAPETiI A HUSTOTY HYDRAULICKEHO OLEJE

Podminky méfeni a poznamky

Datum

Teplota laboratorniho vzduchu

Tlak

Me&fici zafizeni: Sklenény hustomér, Torzni dynamometr
Konstanta platinového prstence

21°C

13.4.2010

96.7 kPa

0.061m

Statistické zpracovani provedeno pomoci kapesniho kalkuldtoru CASIO

Méfeni hustoty

Zméiend hustota (opakované pii 20°C) 848 kgm™

Méfeni povrchového napéti
Teplota vodni lazné 21°C
Teplota oleje 20°C
Méreni &islo ¢. 1. 2. 3. 4 5. 6. 7. 8. 9. 10.
Naméfena hodnota sily | [mN][4.100| 4.100 |4.125|4.100]4.100|4.100|4.125|4.100]|4.100|4.125
Vysledna hodnota sily 4.11£0.01 mN
Povrchove napéti 33.6940.08 mNm'’
Teplota vodni ldzné 28.5°C
Teplota oleje 25°C
Méreni Cislo G. 1. 2. 3. 4, 5, 6. 7. 8. 9. 10.
Naméiena hodnota sily | [mN]|4.075| 4.050 |4.100(4.075(4.073)|4.050(4.050 |4.050|4.075|4.100
Vyslednd hodnota sily 4.07+£0.02 mN
Povrchové napéti 33.36+0.16 mNm™'
Teplota vodni lazné 33°C
Teplota oleje 30°C
Méreni Cislo &. 1. 2. 3. 4, 5. 6. 7. 8. 9. 10.
Naméfena hodnota sily | [mN][4.025| 4.000 |4.000]|4.000]4.000|4.025]|4.025|4.000|4.025|4.000
Vysledna hodnota sily 4.01£0.01 mN
Povrchove napéti 32.8740.08 mNm'’
Teplota vodni lazné 37.5°C
Teplota oleje 35°C
Méreni &islo ¢. 1. 2. 3. 4 5. 6. 7. 8. 9. 10.
Naméfena hodnota sily | [mN][3.975| 3.950 |3.950]|3.950]3.950|3.950|3.975|3.975|3.950|3.975
Vysledna hodnota sily 3.9640.01 mN

Povrchove napéti

32.46+0.08 mNm™
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Teplota vodni ldzné 42°C

Teplota oleje 40°C

Méreni &islo ¢. 1. 2. 3. 4 5. 6. 7. 8. 9. 10.
Naméi'end hodnota sily | [mN] [3.900 | 3.900 |3.900|3.875]3.900| 3.873|3.900|3.900| 3.900| 3.873
Vyslednd hodnota sily 3.89+0.01 mN

Povrchove napéti 31.8940.08 mNm'’
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Kapilarni napéti [mNm™]

Priloha P2 - Graf zavisloti kapilarniho napéti na teploté hydraulickeho oleje

ZAVISLOST KAPILARNIHO NAPETIi NA TEPLOTE HYDRAULICKEHO
OLEJE
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Piiloha P3 - Tabulka hodnot méfeni viskozity hydraulického oleje

MERENI VISKOZITY HYDRAULICKEHO OLEJE

Podminky méfeni a poznamky

Datum 15.4.2010
Teplota laboratorniho vzduchu 23°C
Tlak 100.9 kPa

Méfici zafizeni: Rheotest 2

Typ méfeni: S pro stiedni viskozity
Méiici valec: S 1

Konstanta valce Z=0.51

Smykovy spad D,=729 s-1

Hustota oleje p=848 kg.m™

Teplota t [°C] Dilky a [-] Dynamit':llr::é;l .\;i]skozita M Kinemali[cnl_I(?S_\;i]skozila v
23 31 0.0217 256 10°
24 30 0.0210 24.7 10°
25 29 0.0203 239 10°
26 28 0.0196 23 1 0%
27 27 0.0189 22.310°
28 26 0.0182 21.4 10°
29 25 0.0175 20.6 10°
30 24 0.0168 19.8 -10°°
31 23 0.0161 19.0 -10°
32 22 0.0154 18.1 -10°
33 215 0.0150 17.7 10°®
34 21 0.0147 17.3 -10°®
35 20 0.0140 16.5 -10°
36 19.5 0.0136 16.1 -10°®
37 19 0.0133 15.7 10°°
38 18 0.0126 14.8 -10°
39 17.5 0.0122 14.4 -10°
40 17 0.0119 14.0 -10°
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Piiloha P4 - Graf zavislosti viskozity na teploté hydraulického oleje

ZAVISLOST VISKOZITY NA TEPLOTE HYDRAULICKEHO OLEJE
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Priloha P5 — Nastaveni programu ABS

1 Krok - Nastaveni nazvu a ¢asu méfeni

Experiment Settings

General ] Signalsi Physical Parameters | Physical Conslraintsl

~Title-
‘ |mes'|

-~ DatedTime

\ [Wednesday, Apil 28,2010 =] (1115298 =
- General —

| Uszer name I-‘L-BS

Comment

Check this box to use the setlings on this page and the
following ones as default at startup.

2 Krok — Nastaveni parametra signalu

Experiment Settings

General Signals ] Physical F'alan'elem] Physical Constraints |

PCIE111 DAQ card used, sampling rate up to 10 MS/s Mumber of Periods [—fua
Naminal Signal Amplitude [—1_0 Valts Hydraphane Distance [—52 cm
Number of tests [perform average] [-—5 [~ Enable Signal Settiings Auta Calibration
Estend data acquisition time by ]—1‘ times of default setting. [~ Generate Reference Data

Test/Ref ratio of power amplification of sent signal: |71

i~ Hydrophane settings - — -

| 15t set resonance freq; | kH dT ] ms  Frequencies u lol kHz
| q 50 z 0.007 q P 80

| 2nd set resonance freq: 150 kHz dTl ] p.oo7 ms; Freguencies dp b | 160 kHz

3 'F_quUEan.' SB_tLD = — — : 3 — -
| Min. Freg. I 10 kHz.  Coresponding bubble size: 349 micrans Murmber of Freq. | B0
Max. Freq. ] 290 kHz. Coresponding bubble size: 12,1 microns

" Equal 1/f frequency list start from ‘5 kH

(& Linear frequency list &rrange frequency list automatically I
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3 Krok — Nastaveni fyzikalnich parametrt tekutiny a okolniho prostiedi

Experiment Settings

General | Signals  Physical Parameters | Physical Constraints |

Selection of type of liquids: ]Miner alC .,I

i~ Experiment Conditions -

| Pressure

- Ras Conditions -

A‘ :’
=i

e o
=9

u

Specific heat 1

- Liquid Properties -
Sound speed 1535 m/s

il:

Suface Tension| o339 MN/m

- Thermal Conductivity k = aT +b

Temperature 2SR

Il

\apor pressure Pa.
Density a4 ka/m"3
iscosity 00217 kaofms

0.01165

FlE

4 Krok — Nastaveni parametri omezeni vystupu

Experiment Settings

General | Signals | Physical Parameters  Physical Constraints l

- Bubble Size Infarmation -

Mumber of Sizes 100

i~ Fadius -

Minimurn I 1 microns

Area of bubbles per m™3 of mixture

Yolume of bubbles per unit volume of mizture

IUse Logarithmic Scale: Onx [
Ony [

M aximurn | 1000 microns |

i 100000
l 100000
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Piiloha P6 — Vystupni data z ABS

et o et o oo ot b ok o o o e o ok ke ootk e o stk s o st ok sk ok sk ok sk Ok
* BUBBLE SIZE DISTRIBUTION *

E E

* *

* ABS Acoustic Bubble Spectrometer *
* Version 5.0 *

* Copyright (C) Dynaflow, Inc. 1998-2008. *
* *

ook o e o o o s oo ook o e ol s s o sl ook o oo sk s e ko ol ke s abe sk st s o e ofe ol oke sl ok sk o ol o ok ok

Output run 1 was printed at 11:10:48 428 2010
Total Void Fraction: 0.0000013938
Bubble radius  Number of bubbles Void_ fraction_contribution

(micron) (thousand/m"3)

599500 0.000 0.000000000000
1598500 1686.451 0.000000065235
25.97500 618.283 0.000000076931
35.96500 0.000 0.000000000000
45 95500 564.750 0.000000312880
55.94500 16.503 0.000000015645
65.93500 18.756 0.000000028036
75.92500 19.097 0.000000042387
8591500 12,982 0.000000040856
9590500 15.312 0.000000065886
105.89500 3.440 0.000000019649
115.88500 0.130 0.000000000960
125.87500 0.000 0.000000000000
135.86500 15.296 0.000000179069
145.85500 0.000 0.000000000000
155.84500 0.000 0.000000000000
165.83500 0.000 0.000000000000
175.82500 0.000 0.000000000000
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Piiloha P7 - Grafické znazorméni poctu bublin v zavislosti na poloméru pro méfeni ¢.1,2,3.,4,5
a grafické znazornéni objemového zlomku bublin v zavislosti na poloméru pro
meéfeni ¢.1,2,3.4,5

Objemovy zlomek [-]

Graficke znazornéni poCtu bublin v zavislosti
na polomeéru pro méfeni €.1

— 1200
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Objemovy zlomek [-]
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Objemovy zlomek [-]

Grafické znazornéni poctu bublin v zavislosti na
poloméru pro méreni ¢.3
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Objemovy zlomek [-]

Grafické znazoznéni poctu bublin v zavislosti
na poloméru pro méfeni ¢.4
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Priloha P8 - Grafické znazornéni ristu mnozstvi bublin spektra polomért na injektovaném vzduchu
(pozn. injektaz pred prvnim méfenim a mezi méfenimi 0.2 cm® vzduchu)
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Priloha P9 - Grafické znazornéni objemového podilu bublin spektra polomért na injektovaném vzduchu
(pozn. injektaz pied prvnim mé&fenim a mezi méfenimi 0.2 cm® vzduchu)
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P10 — Stinova metoda

Obrazek snimku 1 kratce po prvni injektazi.

Proud rozptyleného injektovaného vzduchu Drat Tekutina ve stavu pred injektazi

Obrazek snimku 2 po ,,homogenizaci“ tekutiny a injektovaného vzduchu obéhem Cerpadla.
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Obrazek snimku 3 po dalich nékolika minutach od snimani predchoziho snimku.

Obrazek snimku 4 po druhé injektazi a ,,homogenizaci®.

Obrazek snimku 5 po nékolika minutach od prvniho snimku od druhé injektaze.
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Abstract

This manual provides a brief description of the ABS Acoustic Bubble
Spectrometer™ - an acoustics based device that measures bubble size
distributions and void fractions in liquids and measures cavitation
susceptibility. It explains in detail the procedures for setting up and
operating the system including support for a multiple-set hydrophone. A
step-by-step operation example is also provided to help the user get
started.

ABS Acoustic Bubble Spectrometer isa registered trademark of DYNAFLOW, INC,
The ABS software is a Copyright © of DYNAFLOW, INC. 1995-2008. All rights
reserved,

DyNaFLow, INc. may have patents andi'or pending patent applications covering subject matier
in this document. The furnishing of this document does not convev any license to these patents.
Other brands or product names are trademarks (™) op registered trademarks (B) of their
respective holders. No part of this document mav be reproduced or transmitted in any form or
by any means, electronic oy mechanical, for any purpose, without the express
written perniission of D¥NAFLOW, INC.
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Intellectual Property and
Software License Agreement

This agreement governs your use of the ABS Acoustic Bubble Spectrometer™ product
and any material enclosed with it, including any manuals, disks, hardware, PC cards,
and computer programs.

Grant of License. This agreement permits vou fo use one copy of the product, which is
licensed as a single product. The sofiware is “in use” on a computer when it is loaded
into the temporary memory (i.e. RAM) or installed into the permanent memory fe.g., hard
disk or other storage device) of that computer.

Copyright and Restrictions. The software is owned bv DYNAFLOW, INC. and is protected
bv United States copyright laws. The Hardware and its Driver and the Software are
protected Copyright Laws, Patents, and Trade Secrets. Youw must treat the Software like
any other copwighted material, except that you may make one copv of the Software
solelv for backup archival purposes. You may not reverse engineer, decompile or
disassemble the Software and Hardware, except to the extent applicable law expressiy
prohibits the foregoing resiriction. DYNAFLOW, INC. may have patents and'or pending
patent applications covering subject matters in this document. The furnishing of this
document does not give vou anv license to these patents. DIYNAFLOW, INC. grants vou a
non-exclusive license to use ome copy of the ABS Acoustic Bubble Spectrometer™
Software program.

Limited Warranty. For 30 thirty davs from your date of purchase, DYNAFLOW, INC.
warramts that the media on which the Software is distributed are free from defects in
materials and workmanship. DyNAFLOW, INC. will, at its option, refind the amount vou
paid for the Software or repair or replace the Software provided that (a) the defective
Software is returned to DYNAFLOW, INC. or an authorized dealer within 60 days from the
date of purchase and (b) vou have completed and veturned the enclosed registration.

Limitation of Liabilities. In no event will DyNAFLOW, INC. be liable for any indirect,
special, incidental, economic or consequential damages arising out of the use or inability
to use the ABS Acoustic Bubble Spectrometer™ Product. In no event will DYNAFLOW,
INC. s liability exceed the amount paid by vou for the Product.

Restricted Rights. No part of this document mav be reproduced ov transmitted in anv
Jorm or bv anv means, electronic or mechanical, for anv purpose, without the express
written permission of DYNAFLOW, INC. Other brands or product names ave trademarks or
registered trademarks of their respective holders.
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1. Introduction

The ABS Acoustic Bubble Spectrometer™, is an acoustics based device
that measures bubble size distnibutions and void fractions in liquids.
Compared to optical based devices, the ABS Acoustic Bubble
Spectrometer™© is more affordable and easier to setup and use. The
underlying acoustic technique is very sensitive to bubbles but practically
insensitive to particulate matter unlike optical techniques that cannot
readily distinguish between these.  The ABS Acoustic Bubble
Spectrometer”~ can be used in a wide variety of two-phase flow
applications where knowledge of the bubble size distribution and the
volume fraction and/or area of contact between the gas and the liquid are
important. These areas include oceanography, cavitation tunnels,
controlled laboratory testing, industrial flows, and biomedical
instrumentation. The instrument can provide the data in near real time,
thus making it suitable for process or time varying applications. The
initial efforts to develop the device were funded by National Science
Foundation Small Business Innovation Research (SB/R) awards [1-2].

The device extracts the bubble population from acoustic measurements
made at several frequencies. It consists of a pair of hydrophones or
transducers connected to a signal generation / data acquisition system
resident on a personal computer. A data board controls signal generation
by the first hydrophone and signal reception by the second hydrophone.
Short monochromatic bursts of sound at different frequencies are
generated by the transmitting hydrophone and received by the second
hydrophone after passage through the bubbly liquid. These signals are
processed and analyzed utilizing specialized copyrighted software
algorithms developed by DYNAFLOW, INC, to obtain the attenuation and
phase velocities of the acoustic waves, and, from these, the bubble size
distribution.

All the measurements and analyses can be easily and rapidly conducted
through a user-friendly Graphical User Interface (GUI). All physical,
experimental, and analytical parameters can be modified by the user
interactively. Both raw and processed experimental data from experiments

4
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can be saved for future use. The results are displayed graphically in real
time on the screen and can also be exported or printed.

As an option, the conventional ABS Acoustic Bubble Spectrometer™ can
be upgraded and used to determine the liquid susceptibility to cavitation.
In order to do so, a hydrophone projects acoustic power in the liquid with
an increasing intensity. A sensitive transducer measures the resulting
pressure field. The signals of this transducer are then analyzed and any
high frequency emission from cavitation bubble is detected. Cavitation is
“called” when a threshold of the rms of the emitted signals is crossed.

2. Technical Basis

2.1 Theoretical Foundation

Bubble size distribution measurements using the ABS Acoustic Bubble
Spectrometer”- are based on a dispersion relation for sound wave
propagation through a bubbly liquid. A multiphase fluid model for sound
propagation through bubbly liquids is combined with a model for the
bubble oscillations, including various damping modes. The combined
model relates the attenuation and phase velocity of a sound wave to the
bubble population or size distribution. These relations produce two
Fredholm integral equations of the first kind that are ill-posed and require
special treatment for solution, particularly in the presence of noise. Novel
algorithms developed by DYNAFLOW [1-3] are able to accurately solve
these equations using a constrained optimization technique that imposes a
number of physical constraints on the solution. This renders the equations
well posed and the solution more accurate. A detailed presentation of the
underlying physics and mathematics employed in the ABS Acoustic
Bubble Spectrometer@@ can be found in our JASA paper [3].

2.2 Validation

The complete procedure was initially tested on analytical data with
varying amounts of artificial noise added. It was found that to
successfully recover the bubble distribution, and to perform much better
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than previous solution techniques. The bubble distributions obtained from
the ABS Acoustic Bubble Spectrometer™ were then validated by
comparison with microphotography. Bubble populations were generated
using electrolysis and air injection through porous tubes. The bubble
population obtained using the ABS Acoustic Bubble Spectrometer™®
compared favorably with the results of microphotography. Details can be
found in [1-8].

3. System Requirements and Setup

3.1 Hardware

The ABS Acoustic Bubble Spectrometer™® system can operate on a PC
that has Windows 2000/XP/Vista installed. For a desktop based system,
one spare PCI slot 1s required. For a notebook based system, one spare
PCMCIA slot (CardBus or ExpressCard type) is needed. Sufficient hard
disk space is required to store the data acquired, which depends upon the
parameters set by the user.

The basic system also utilizes two hydrophones — one for transmission and
one for reception of acoustic wave bursts. Different sets of hydrophones
can be employed with the ABS Acoustic Bubble Spectrometer™ as long
as they have suitable performance characteristics over the frequency and
distance ranges of the application and their characteristics are known and
specified to the system. For an ABS Acoustic Bubble Spectrometer™®
system with optional multiple-set hydrophone support, multiple pairs of
hydrophones with different resonance frequencies can be connected to the
system at the same time to enhance the performance through coverage of a
larger frequency band and to expand the available measurement range.

For the upgraded system with the capability to measure cavitation
susceptibility, a low frequency emitting hydrophone and a high sensitivity
receiving transducer for cavitation detection are also provided
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3.2 Software

The ABS Acoustic Bubble Spectrometer™® software runs on a Windows
2000/XP/Vista operating system or above. It enables the user to conduct
the measurements and analyses through a user-friendly Graphical User
Interface (GUI) from which the user can easily input the control and
operating parameters for the experiment, specify analysis options, and
view analysis results. The detailed steps required for control of the various
boards, data acquisition, signal analysis, inverse problem solution, and
data output are thus transparent to the user. The various options and tasks
are accessed through a series of menus and dialog boxes.

3.3 Setup and Cabling for a Desktop Based System

The following hardware is provided as part of a desktop based ABS
Acoustic Bubble Spectrometer™® system:

Signal Generation / Data Acquisition Boards (Installed in PC)
External BNC Connector Box with integrated amplifier

BNC Cables

Optional programmable multiplexer switch with accompanied
USB cable and terminal block

Oo0oaoa

Perform the following steps to set up the desktop based ABS Acoustic
Bubble Spectrometer™® Generation II system hardware:

For the basic single-set hydrophone system.

¢ Connect the External BNC Connector Box with the attached
Signal Generation / Data Acquisition Board using the 68 Pin
Shielded Cable.

¢ Connect the sending hydrophone to the BNC connection on the
Connector Box marked as “Transmitter”.

¢ Connect the Receiving hydrophone to the BNC connector on the
Connector Box marked as “Receiver”.
Turn on the computer
Turn on the amplifier switch on the BNC Connector Box

For the optional multiple-set system:
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¢ Connect the External BNC Connector Box with the attached
Signal Generation / Data Acquisition Board using the 68 Pin
Shielded Cable.

¢ Connect the programmable multiplexer switch to the computer
using the accompanied USB cable

¢ If not attached, attach the accompanying terminal block for the
programmable multiplexer switch to the switch, tightly secure the
attachment with the screws on the terminal block.

¢ Connect the BNC connector on the Connector Box marked as
“Transmitter” to the BNC connector marked as “AQ IN” on the
terminal block of the switch using a BNC cable.

e Connect the sending hydrophones to the BNC connects on the

terminal block of the switch marked as “AQ 17, “AQ 2”, . in
order.

¢ Connect the Receiving hydrophones to the BNC connector on the
Connector Box marked as “Receiver 17, “Receiver 27, ..., in
order.

¢ Power up the programmable multiplexer switch first and then turn
on the computer
¢ Turn on the amplifier switch on the BNC Connector Box

Note:
Malke sure the amplifier is turned on and that it has a fresh
battery. (When not in use, it should be turned off. Otherwise, the
battery will drain.) Also make sure the 68 pin cable connection
is good on both ends and pushed in all the way.

3.4 Setup and Cabling for a Notebook Based System

The following hardware is provided as part of a notebook based ABS
Acoustic Bubble Spectrometer™ system:

Integrated ABS Acoustic Bubble Spectrometer®® System box
PCMCIA Expansion Cable (CardBus or ExpressCard type)
BNC Cables

Optional programmable Multiplexer Switch

Oo0oao
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Perform the following steps to set up the notebook based ABS Acoustic
Bubble Spectrometer ~ system hardware:

For the basic single-set hydrophone system:

Figure 1 shows the setup diagram of the basic single set system. The
analog input and output as well as the signal amplifier are integrated into
one ABS System Box. Follow the following steps to set up the system:

==
g '
Flow £
—_ S8
"%
P —
~2piop Sgnal Amplifier

— N
output

input

Figure 1. Setup of the basic single-set system.

e Connect the Integrated System Box with one end of the PCMCIA
Expansion Cable, and insert the other end into PCMCIA slot of
the notebook.

e Connect the sending hydrophone to the Tramsmitter of the
Integrated System Box.

e Connect the Receiving hydrophone to the Receiver of the
Integrated System Box.

e Power up the interface box first and then power up the laptop.

o Select “Insert Mobility Express Card and press enter” option to
continue booting up the computer.

e After the system has completely booted up, using the
Measurement & Automation application to check whether the



ABS Acoustic Bubble Spectrometer™® USER MANUAL: 7-077v. 5.0

DAQ card has been detected by expanding the Traditional NI-DAQ
Devices. A device name such as “PCI-6115" should appear.

o If the DAQ card is not detected, close the Measurement &
Automation application and unplug the Express Card from the
laptop.

e Wait for a few seconds and plug the Express Card back into the
laptop.

o Launch the Measurement & Automation application again, the
DAQ card should be detected now. Click the device name to
activate the device.

e Use test panel of the Measurement & Automation application to
test the DAQ card to ensure that the analog inputs and outputs are
working properly.

e If the above procedures have been performed successfully, the
ABS system is ready for measurement.

For the twin-set hydrophone system:

2 shows the setup diagram of the twin-set system. It can drive up to two
sets of hydrophones. The system set-up procedures are similar to the
single-set system except for connecting the hydrophones to the ABS
System Box as described below:

= [
ok o
Flow gé E %
—_ = 25
? £
]
F 3
: = Sgnal Amplifie
hee i A 4 é
— + | Analog Analog
e "1 output input
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Figure 2. Set up of the twin-set system.

e Connect the two sending hydrophones in the order of ascending
resonance frequency to the Transmitter 1 and Transmitter 2 of
the Integrated System Box.

e Connect the two receiving hydrophones in the order of ascending
resonance frequency to the Receiver 1 and Receiver 2 of the
Integrated System Box.

For the optional multiplexer-controlled multiple-set hydrophone system:
Figure 3 shows the setup diagram of the multiplexer controlled triple-set
system. A multiplexer is used to route the sent signal to desired
hydrophones. As the basic and twin-set system, the analog inputs and
outputs as well as the signal amplifier are integrated into the Integrated
System Box. Follow the following steps to set up the system:

E

50 kHz
250 KHz
Hydrophone

Hyd rophone

150 kHz

Hyd rop hone

Row
—

Bt

| | 1|
vV VvV V

»{ Analog Analog
output input

Figure 3. Set up of the multiplexer controlled triple-set system.

e Connect the Integrated System Box with one end of the PCMCIA
Expansion Cable, and insert the other end into PCMCIA slot of
the notebook.

11
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¢ Connect the programmable multiplexer switch to the notebook
using the accompanied USB cable.

¢ If not attached, attach the accompanying terminal block for the
programmable multiplexer to the chassis, tightly secure the
attachment with the screws on the terminal block.

¢ Connect the BNC connector on the Integrated System Box
marked as “Transmitter” to the BNC connector marked as “AQ
IN” on the terminal block of the switch using a BNC cable.

¢ Connect the sending hydrophones to the BNC connectors on the
terminal block of the switch marked as “AQ 1", “40 2”7, ..., in
order.

e Connect the Receiving hydrophones to the BNC connectors on
Integrated System Box marked as “Receiver 17, “Receiver 27, ...,
in order.

e Power up the interface box and programmable switch first and
then power up the laptop.

o Select “Insert Mobility Express Card and press enter” option to
continue booting up the computer.

o After the system has completely booted up, using the
Measurement & Automation application to check whether the
programmable switch has been detected by expanding the Devices
and Interfaces. A device similar like “NI SCXI-1127" should
appear under the NI-DAQmx Devices

e Using the Measurement & Automation application to check
whether the DAQ card has been detected by expanding the
Traditional NI-DAQ Devices. A device name such as “PCI-6115
should appear.

o If the DAQ card 1s not detected, close the Measurement &
Automation application and unplug the Express Card from the
laptop.

o Wait for a few seconds and plug the Express Card back into the
laptop.

e Launch the Measurement & Automation application again, the
DAQ card should be detected now. Click the device name to
activate the device.

12
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o Use test panel of the Measurement & Automation application to
test the DAQ card to ensure that the analog inputs and outputs are
working properly.

¢ If the above procedures have been performed successfully, turn on
the amplifier switch on the BNC Connector Box, the ABS system
is ready for measurement.

For the optional multiplexer-controlled multiple-set hydrophone system
with cavitation susceptibility measurement:

Figure 4 shows the set-up sketch of the multiplexer controlled triple-set
system with cavitation susceptibility measurement. Compared to the
regular triple-set system, this system has an extra hydrophone to generate
cavitation and an extra high-sensitivity pressure transducer to detect the
cavitation events. As other systems, all the analog inputs and outputs and
the signal amplifiers for the regular ABS receiving hydrophones are
integrated into the ABS System Box. The pressure transducer has its
dedicated unit for power supply and signal amplification. The signals from
the pressure transducer and the 1% receiving ABS hydrophone share the
same analog input channel, as shown in Figure 4, these two signals are
sent to the multiplexer and then are routed to the analog input based on
operation mode. The set-up procedures are similar to the multiplexer
controlled triple-set system except for the cable connections are more
complicated, follow the procedures as described below:

13
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[E:

Analog Analog
output

Figure 4. System setup of the multiplexer controller triple-set system with cavitation
susceptibility measurement.

e Connect the BNC connector on the ABS System Box marked as
“Transmitter” to the BNC connector marked as “AO IN” on the
terminal block of the switch using a BNC cable.

e (Connect the sending hydrophones to the BNC connectors on the
terminal block of the switch marked as “40 I”, “4A0 27, ..., in
order. Make sure the hydrophones are connected in ascending
order of the resonance frequency

e (Connect the cavitation hydrophones to the BNC connectors on the
terminal block of the switch marked as “Cav. 40”,

e Connect the Receiving hydrophones to the BNC connectors on
Integrated System Box marked as “Receiver 17, “Receiver 27, ...,
in order matched with the sending hydrophones.

e Connect the pressure transducer to the BNC input connector of
the standalone power supply unit for the pressure transducer.
Connect the output connector of the power supply unit and the
BNC connector on the terminal block marked as “Rec. 27,

e Connect the port “To Multiplexer” on the Integrated System Box
to “Rev. 17

14
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¢ Connect the port “41” on the terminal block to the port marked as
“From Multiplexer” on the Integrated System Box.

Noftes :

a.  Insert the PCMCIA card into the notebook computer, plug in the
12V power supply to the ABS System Box. and turn on the power
to the multiplexer.

b.  Before turning on the laptop computer, make sure that the green
LED lights on the chassis of the multiplexer and the ABS System
Box are on.

c. If the ABS application fuils to acquire data properly, close the
ABS application and use the Measurement & Automation
application to ensure that the DAQ card can be detected. Also
use the test panel to test the DAQ card to ensure that the analog
inputs and outputs are wovking properly.

d Make sure the amplifier is turned on and that it has a fresh
battery. (When not in use, it should be turned off Otherwise, the
battery will drain) Also make sure the expansion cable
connection is good on both ends and pushed all the way in.

4. Operating t_!]e ABS Acoustic Bubble

Spectrometer”

Double clicking the ABS icon starts the ABS Acoustic Bubble
Spectrometer™ - Generation II software. This invokes the Graphical User
Interface. It includes the menu, the tool bar and a plotting area. The
contents displayed in the plotting area depend on the operation performed,;
they can be the transmitted and received signals (either reference signals
or those from an actual measurement) or the analysis results.

4.1 Tool Bar

The tool bar is located just under the main frame menu at the top of the
window._ It contains several shortcut buttons that are used to invoke
different functions. These shortcut buttons are listed here and described in
detail below.

15
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Iﬁ Print Preview

Experiment Settings
Reference Signals
Acquire

Analyze

View Signals

M| View Results

Start Continuous Mode

MO EERE 2 M

Stop Continuous Mode

| Cavitation susceptibility measurement Mode

4.2 Experiment Settings

This button invokes the Experiment Settings property sheet that
enables the user to input the various environmental and operating
conditions for the experiment. The property sheet can also be invoked
from the menu by clicking Experiment / Settings or by pressing the F7
key. There are four separate property pages as described below and shown
in Figure 5 through Figure 9.

o General: This page has entries for title, date, time, user’s name, and
comments on the experiment (Figure 5).
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Figure 5. Experimental Settings: General Information Page.
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Figure 6. Experimental Settings: Signals Page.

a Signals: The signals property page is shown in Figure 6. The user can
specify the number of periods and the nominal peak signal amplitudes
(in volts; maximum signal amplitude is /0 volts) of the sent signals for
test and reference signals respectively, enter the distance between the
two hydrophones in the experiment, and build a table that lists signal
properties.
Note: The “burst” duration for each transmitted signal is then equal

fo the ratio of the number of periods to the signal frequency.
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HARDWARE INFORMATION: The DAQ card information and its
maximum sampling rate is automatically detected and used by the
system. Information such as PCI 6111 DAQ card used, sampling rate up
to 5 MS/s will be displayed, the system will automatically determine
the sampling rate to use based on the signal characteristics under
consideration.

DATA ACQUISITION DURATION EXTENSION FACTOR: The default time
duration for data acquisition is set to be four times the time of flight
between hydrophones in the liquid. This equals the hydrophone
distance divided by the sound speed in pure liquid, plus the duration of
emission. This default setting is good in normal cases. If this default
duration 1s not optimal for the particular experiment, e g. the duration
is too short to obtain the complete response signal; the user can adjust
the time duration by changing the value of N of the user input in
Extend data acquisition time by N times of default setting, which sets the
duration for acquisition to be a multiple of the default acquisition time
by the specified factor.

ENABLE SIGNAL SETTINGS AUTOQ CALIBRATION: Since the gain and
voltage settings can be different for each frequency as well as for test
and reference signal. It is tedious to manually set up the gain and
voltage setting manually. The user can check Enable Signal Settings
Auto Calibration to let the system figure out the best gain and voltage
settings for each frequency in both test and reference condition. After
checking this option, when acquiring reference signal, the system will
continuously adjust the gain and voltage settings until optimal settings
have been found for all frequencies, then the real reference signals will
be acquired at the settings optimized. When measuring the first time
under the test conditions, the system will similarly adjust the gain and
voltage settings until optimal settings have been found for all
frequencies, then the real test signals will be acquired at the settings
optimized. After the calibration for the test signal 1s finished, the check
before Enable Signal Settings Auto Calibration will be automatically
unchecked by the system, and all the subsequent tests will be
conducted using the setting found in the calibration process until the
user checks the selection again to re-conduct the calibration process.
The user can examine the optimized settings from the table. Ref Guain
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and Test Gain are the gain settings for the reference and test signals
respectively. V Factor and Ref V Factor are the voltage factor settings
for the reference and test signals respectively. The actual sent signal
voltage is the product of the voltage factor and the specified nominal
sent signal amplitude.

FREQ (Hz). This table includes the list of selected insonification
frequencies and the corresponding gains to be applied to the
transmitted and received signals at each frequency. The frequency list
should be arranged in ascending order. These should be set based on
the hydrophone characteristics to attain sufficient resolution for the
particular configuration without saturating the received signal. Trial
and error may be required. The table also includes a column labeled as
Ignore Signal which enables removal of any signal that is erroneous
such that it will not be taken into consideration in the analysis for the
bubble populations. The software automatically removes any signals
that give unreasonable sound speeds or bad signal to noise ratio and
sets their values of Ignore Signal to Yes. Users can also manually
ignore any signal that they believe is problematic by setting the value
of Ignore Signal 10 Yes at the corresponding frequency.

AUTOMATIC FREQUENCY SETUP: To manually set up a long
frequency list can be time consuming. To speed up the process, the
GUI can arrange the frequency automatically. What the user needs to
do is to specify the Min. Freq. (minimum frequency), the Max. Freq.
(maximum frequency), and the Number of Freq. (number of
frequencies), and choose how to generate the frequency list. Please
notice that when the user changes the Min. Freq. and the Max. Freq. the
corresponding bubble sizes will be automatically calculated and
displayed as a gumdeline about the optimal bubble size measurement
ranges. Two options are available, one is to linearly arrange the
frequency list with equal frequency interval {choose Linear frequency
list), the other one is base on equal bubble size interval, which
corresponding to the equal 1/f interval (choose Equal 1/f frequency list).
If the equal 1/f interval is selected, the user can also specify when to
start the equal 1/f interval arrangement. Between the minimum
frequency and this frequency, equal frequency interval of 1000 Hz will
be used.
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TRIPLE-SET HYDROPHONE OPTIONS: If it 1s a multiple-set hydrophone
system, the user can use this option to control how to distribute the
frequency list among the three sets of hydrophones. The order of the
hydrophone arrangement is that the 1% set is for lower range of
frequencies, the 2" set is for the middle range of frequencies, and the
3% get is for the higher range frequencies. What the user needs to do is
to specify two cut-of frequencies, the first frequency is specified after
the text Use I* set of hydrophones for the frequency up to, frequencies
below this one are handled by the 1** hydrophone set. The second
frequency is specified after the text Use 2™ set of hydrophones for
frequencies up to. Frequencies above this one are handled by the 3™ set
of hydrophones. The system will route automatically a given
frequency signal to the corresponding hydrophone according to the
specification. Please make sure the order of the hydrophone
connections matches among the receiving and transmitting
hydrophones.

HYDROPHONE RESPONSE CHARACTERISTICS: When a system is
delivered, the resonance frequency and response time of the
hydrophones are given. They are used for analysis for improved
accuracy.

AUTOMATIC FREQUENCY DISTRIBUTION AMONG HYDROPHONES:
Except for the basic single set ABS system, the user needs to specify
the frequency range for each set of hydrophones. Since the
hydrophone performance might change at different conditions, an
automatic frequency distribution scheme has been implemented to
remove the user guess work in specifying the frequency range for each
hydrophone. To do so, the user needs to check the check box of
Automatically distribute the frequency among the hydrophones.
Close the signal setup page, and click Aequire to start the acquisition
of the auto frequency distribution process, which examines the
frequency response characteristics of each hydrophone set and then
assign the optimal frequency range to each set of hydrophones. (This
option is presently not active)
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AMPLIFICATION RATIO: The system can be coupled with an external
amplifier, however usually the amplifier is needed only during the
actual tests and not in the reference condition. If this is the case, the
user needs to specify the power amplification ratio after the text
Test/Ref ratio of power amplification of sent signal, such that the
difference will be taking account for in analysis.

GENERATE REFERENCE DATA: Also on this page i1s a check box
Generate Reference Data which is used to indicate whether the
experiment is to be conducted as a reference with a pure liquid (with
no bubbles). The pure liquid in the same experimental configuration
provides a background reference state and is used in calculating the
bubble size distribution in the liqmd “with bubbles”. This reference
data set is obtained by conducting an experiment where bubbles have
been removed as much as possible from the liquid under conditions
and settings otherwise identical to those to be employed in determining
the desired bubble size distribution. Check the box to generate this
reference data set. The reference data set can be saved to disk for later
use or stored in memory. This procedure is recommended beccuise it
frees the user from errors associated with calibration of the
hydrophones in the specific configuration of the experimental setup.

NUMBER OF TESTS: The user can specify the number of test runs, n,
desired to obtain the averaged results by entering a number between /
and 20 in the Number of Tests box. Sets of signals are generated and
acquired as many times as specified. The average of these signals is
used to obtain the bubble distribution for 7 > 1. In this case, the signals
of the last run are displayed (see 4.4 View Signals below). The sound
speed ratio and attenuation vs. frequency displayed are the average
values (see 4.6 View Results below). It should be noted that this option
does not work with the external trigger mode (section 4.7).

o Physical Parameters: The Physical Parameters page (Figure 7)
specifies the operating conditions of the experimental environment.
These data are to be entered in S7 units as noted on this page and
should be specified for the temperature and pressure at the
measurement location. Values to be specified include:
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Pressure (static) of the liquid at the measurement location
{Pascal)

Temperature of the liquid at the measurement location (°C)
Specific heat ratio (c,/c,) of the gas comprising the bubbles
Vapor pressure of the liquid (Pascal)

Sound speed in the pure liquid (no bubbles) (ms)

Liquid density (kg'm)

Liquid surface tension (N:m)

Liquid dynamic viscosity (kg/im-s)

Gas thermal conductivity, k, given as a linear function of
temperature, 7, (X) with parameters a and b (W/m- K ):

k=al +b

A database of the frequently used liquids, such as water, mercury,
mineral oil, corn syrup, etc. are listed for convenience. If the liquid of
interest is not listed in the database, select user specified, and enters
the customized physical parameters as required.
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Figure 7. Experimental Settings: Physical Parameters Page.

0 Physical Constraints: On this page (Figure 8), physical constraints
are imposed in order to enable solution of the ill-posed problem, and
the parameters of the computed distribution are specified. These
include the minimum and maximum of the computed bubble sizes
(radii) and the number of discrete sizes to compute. Two options are
available for calculation (and subsequent display) of the bubble sizes.
The sizes can either be linearly or logarithmically distributed between
the minimum and maximum sizes. In addition, the vertical scale (y) —
bubble number per unit volume — can be displayed with either a linear
or logarithmic scale. The logarithmic scale is selected if the
appropriate box on this page is checked. Upper bounds on both the
total bubble surface area and the total bubble volume per unit volume
(nm’) of the measurement region are also specified here. These are
utilized as constraints in solving the inverse problem and need only be
very approximate. They are usually set to large positive values.
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Experiment Settings &[
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Figure 8. Experimental Settings: Physical Constraints Page.

o Cavitation Susceptibility: This page (Figure 9) provides information
for the system to measure the cavitation susceptibility.

AMPLIFICATION OF POWER AMPLIFIER: specifies the amplification of
the power amplifier that drives the cavitation hydrophone. Please
make sure that the actual amplification factor you set on the
amplifier matches with the value specified. To do so, use a constant
input signal amplitude and adjust the amplification of the amplifier
until the ratio of the output signal to the input signal of the amplifier
reaches the amplification value you require and enter the same in the
ABS Cavitation Susceptibility Page.

MAXIMUM SIGNAL VOLTAGE: gives the maximum signal voltage that
will be applied to the cavitation hydrophone, it should not exceed the
maximum output voltage of the power amplifier, for the Krohn-Hite
wide band power amplifier, the maximum output voltage is 160 v
(RMS).
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SENT SIGNAL FREQUENCY: specifies the signal frequency used to test
the cavitation susceptibility, which usually i1s around 50 — 70 kHz and
corresponds to the best response frequency range of the hydrophone
provided for cavitation susceptibility measurement.

SIGNAL CYCLES TO BE ACQUIRED: specifies the number of cycles to
be acquired during the data acquisition process, it should be long
enough to enable the detection of the cavitation events if the cavitation
phenomenon exists.

For the signal analysis, the low frequency signals should be removed
from the received signal:

RANGE OF BLOCKED FREQUENCY: specifies the range of frequency to
be filtered out during the signal analysis. This purpose of this filtering
process is to remove background and excitation noise and keep only
high frequency signals of cavitation events.
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Figure 9. Experimental Settings: Cavitation Susceptibility Page.

4.3 Acquire
Cxy
s This button initiates acquisition of signal in the ABS hardware

version and re-processing of the raw signals in the ABS no-hardware
version if the data file loaded is a regular ABS data.

For the hardware version, under regular ABS operation mode, a set of
acoustic signals of characteristics specified in the Experiment
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Settings/Signals page are sent by the transmitting hydrophone and acquired
by the receiving hydrophone. In order to improve the signal analysis a
rectangular wave with the same duration as that of the matching sine wave
is also added. The Acquire function can also be invoked from the menu by
clicking Experiment/ Acquiring Signals or by pressing the F8 key. The
screen is automatically refreshed after the data acquisition is completed
and processed. The raw or analyzed “sent” and “received” signals are
displayed (Figure 10) based on the user selection if set in View Signals
mode originally. The analysis results are displayed (Figure 15) if the View
Results mode is originally set.

For the hardware version operating under the cavitation susceptibility
measurement mode, a set of acoustic signals of characteristics determined
in the Experiment Settings/Cavitation Susceptibility page are sent by the
transmitting hydrophone and acquired by the high sensitivity pressure
transducer. Similar as the regular ABS mode, the raw or analyzed “sent”
and “received” signals are displayed (Figure 14) based on the user
selection if set in View Signals mode originally. The analysis results are
displayed (Figure 18) if the View Results mode is set originally.

4.4 View Signals

M This button activates the View Signals mode to show the raw or
analyzed “sent” and “received” signals most recently acquired (Figure 10).
When clicked on while the Ctr key is pressured, a dialog box appears
(Figure 12) to let the user specify the scale or magnification factors to be
applied to the vertical axes of the signals for display. This enables
zooming in on signal details that may be too small to see well with normal
magnification. Another way to view the sent/received signals or reference
signals is by selecting the Test Signals or Reference Signals under either
Original Signals or Analyzed Signals type on the View pull down menu. If it
is the Original Signals type, the acquired raw signal is displayed. If it is the
Analyzed Signals type, the processed signals will be displayed.

The following descriptions apply to regular ABS mode.

As shown in Figure 10, the corresponding responses to sinusoidal and
rectangular wave are displayed side by side. The duration of the

28



ABS Acoustic Bubble Spectrometer™® USER MANUAL: 7-077 v. 5.0

rectangular wave is also output on top of the signal. Also on the upper left
corner of the display window, either “Ref” or “Test” is marked to indicate
that the signal displayed is the reference signal or test signal.

Another feature in the signal display window of Version 5.0 is that the
signals that have been dropped (e.g. small signal to noise ratio) from
bubble distribution calculations during the signal analysis process are
crossed out and marked as “Dropped Signal”. This gives the user a direct
indication of which signals are used during the analysis. Figure 11 shows a
sample screen shot of the signals that have been dropped during the signal
analysis.

¥ 03_31_06_test_2.abs - ABS Acoustic Bubble Spectrometer ®

A Aot Bl Specometer®) - 190 006 wees Oyraficec o0

Ref
2 Duration: 0.25ms I 20kiz
e | 05
i—*‘—‘—“‘*‘l‘*—' ' §
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0.287 s ¥ 02T m
E Buration: 017 ms 130
| I II |
| | [ Lt
- i Al b m| LU 1 |
] \ | : iR |. 111 | I |
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2 0.22ms S
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Figure 10. Display of the Raw Sent (blue) and Received (red) Signals.
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Figure 11. Dropped signals during the analysis are crossed out in signal display
window.

If the Number of Tests specified in the Signals property page (Figure 7) is
greater than 1, another dialog box (Figure 13) appears to enable the user to
specify the option to view the signals of an individual test or to view the
averaged signals of the tests. The user can select a test of interest by
clicking the selection buttons. If the check box Used for average is
checked, that individual test will be used for signal averaging otherwise
that specific test will be excluded from the signal average process.
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Figure 12. Dialog Box for Setting Display Scale of the Raw Signals.
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Figure 13. Dialog Box for Selecting Viewing Option for Multiple Tests.

Under the Cavitation Susceptibility mode, not all signals for all voltages
tested are displayed, only signals at 4 selected voltages are displayed,
covering the typical signals with and without cavitation in the test. When
raw signal is displayed, the Senmt signal is scaled down before the
amplification while the Received signal is displayed in the original scale.
If the Analyzed signal is displayed, the graph scale is based on the
analyzed Received signal, which is displayed in its original scale, while
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the Sent signal is scaled down by a varying scale to fit in the graph scale
determined by the analyzed Received signal.
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Figure 14. Display of sent and received signals under Cavitation Susceptibility
mode.

4.5 Analyze

\ﬁl Under the regular ABS mode, this button invokes the analysis
algorithms that processes the analyzed acoustic signals to obtain the
measured bubble populations. The results are automatically displayed on
the screen based on user selected display option (Figure 15, described
below under 4.6 View Results). This function can also be invoked by
selecting Experiment /Analyze Signals or pressing the F9 key. Under
Cavitation Susceptibility mode, this button invokes the algorithms that
process the acoustic signals to obtain variation of the filtered received
signal with voltage and the determined threshold of cavitation.
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4.6 View Results

ki This button activates the View Results mode to display the analysis
results of the experiment (Figure 15). It is automatically enabled after

clicking the Analyze \gl button or can be activated by clicking the View
Results .‘ button at any time.
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Figure 15. Display of the Analyzed Results.

The following descriptions applied to the regular ABS mode:

Four plots are displayed in this mode:
o Sound speed ratio (1 =cC/Cyer) VS. frequency.
o Attenuation ratio (v) vs. frequency.
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®  Bubble size distribution in the form of the number of bubbles per
cubic centimeter vs. bubble radius in microns.

e Void fraction contribution in the form of the void fraction
contribution vs. bubble radius in microns. The total void fraction
of all bubbles are also displayed above the graph, it is simply the
total measured void fraction in the range of bubble size detected.

Note: The number of bubbles per cubic centimeter is plotted on the
vertical axis of the bubble size distribution. To obtain the number of
bubbles within the measuring volume, this must be multiplied by the
size of the measuring volume in cubic centimeters.

After the View Results H button is clicked while the Ctrl key is pressed
down, a dialog box (Figure 16) appears to enable the user to select the
display option for viewing the analyzed results. If the Use Previous/Default
Display Settings button is clicked, the default ranges or the ranges used in
the previous display are used for displaying the analyzed results. If the
Specify Results Display Settings button is clicked, a new dialog window
(Figure 17) appears to let the user specify the desired ranges for sound
speed ratio, attenuation ratio, and bubble size distribution. In addition, the
user can also select to display the attenuation ratio in either power
spectrum or RMS form.

The user can also show the analysis results of the experiment by clicking
on Analyzed Results in the menu item View.

| Specify Results Display Settings I

Usge Previous/Detault Display Settings ‘

Figure 16. Dialog Box for Selecting Display Option of the Analyzed Results.
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Figure 17. Dialog Box for Specifying Display Range of the Analyzed Results.

In the Cavitation Susceptibility mode, only one graph (Figure 18) is

displayed:

o  Filtered Received Signal Amplitude vs. Applied Voltagerequency.
A vertical line indicating the determined threshold voltage for cavitation

susceptibility is also displayed.
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Figure 18, Display of cavitation susceptibility results.

4.8 Reference Signals

% After this button is highlighted, the signals acquired by clicking on

s
the Acquire button % | are designated as reference signals (see Generate
Reference Data in 4.2). This button is automatically released after the
acquisition is finished. Also note that this button has to be clicked to

release the Cavitation Susceptibility mode if it is activated.

4.9 Continuous Mode

% In some cases it may be desirable to monitor the bubble

characteristics continuously. Click this button to activate the Continuous
Mode which runs the ABS continuously. Before activating the Continuous
Mode the user needs to make sure that the reference data are available. A
dialog window (Figure 19) appears after the button is clicked to allow the
user to set up the Continuous Mode. The Time delay between sequences
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specifies the time delay before one sequence of emission/reception and the
next. The Qutput options allow the user to choose whether the analyzed
results are written to a file. If No output is selected, the results of the
sequences are not output to files, however results for the most current one
can be displayed on the screen. If Qutput results is selected, the results of
the sequences are written to files at the desired frequency (see 4.10 for
detail). While the Continuous Mode is activated, the button will be disabled
until the Continuous Mode is deactivated.

Continue Mode Options [X|

Time delay between sequences | (=]

Output options
* Mo output

" Output results

-
o | Cancel |

Figure 19. Dialog Box for setting up the Continuous Mode.

One restriction to the Continuous Mode is that the cursor has to be left on

e
top of the 6" button to run the ABS continuously if there is no mouse
activity, otherwise the Continuous Mode will be idle unless a mouse
activity is detected.

4.10 Stop Continuous Mode

e

‘&= This button is enabled when the Continuous Mode is activated. Click
this button to deactivate the Continuous Mode. After the Continuous Mode
is deactivated, the button will be disabled.
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4.11 Cavitation Susceptibility Measurement Mode

ﬂl This button activates the Cavitation Susceptibility mode if the
system is capable of this functionality. After this button is highlighted, the
system is operated under Cavitation Susceptibility mode.

4.11 Files and I/0

Important data are automatically saved to files during the experiment. In
both Acquire and Analyze processes, the following files are generated:

®  ATTENUATION RATIO Vs FREQUENCY.pAT This file includes the
attenuation ratio at each frequency.

e~ a3vsrl.par. This file includes the number of bubbles at different
bubble size bins.

e ~_avsrl.par. This file includes the number of bubbles per unit bin
size at different bubble sizes, i.e. number of bubbles divided by bin
size.

e ~cGrourl.par. This file includes the number of bubbles, the surface
area of the bubbles, and their contribution to the void fraction at
different bubble size bins.

e sorn_paraml.par. This file gives the statistics of the analysis.

e  SOUND SPEED sATio vS FREQUENcY.pAT. This file includes the sound
speed ratio at each frequency.

e yrpar. This file includes the contributions to the void fraction at
each frequency.

The following files are generated only in the Acquire process:

e pest mrpar. This file includes the time delay obtained from
analysis at each frequency.

e reags.par. This file includes five time delays between the
transmitted and received signal that have the highest correlation
values at each frequency.

e or.par. This file includes both the sound speed ratio and the
attenuation ratio at each frequency.

The following file is generated only in the Analyze process:
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e Buspie size pistriBuTion.paT. This file includes the number of
bubbles and its contribution to the void fraction at different bubble
siZes.

In the Continuous Mode, all the above files are generated for the latest run.
In addition, void fraction and bubble size distribution information for
selected runs in sequence are also generated.
¢ BUBBLE SIZE DISTRIBUTION cont _Mope.p4ar. This file includes the
number of bubbles and its contribution to the void fraction at
different bubble sizes for each selected run in the Continuous Mode.
In addition the total void fraction and the time at which output is
generated are also included.
e VormpFracrion_vs_tiME.DAT. This file includes the variation of void
fraction with time for the selected runs in Continuous Mode.

Raw data and processed results from an experiment can be saved or
reopened by two means.

Save/Open

Clicking on File/Save will save all the information in a single binary file
readable by the software with a name chosen by the user. The extension of
the saved file i1s “.48s”. Clicking on File/Open enables users to open a
previously saved .ass file. With this feature, users can view signals and
results acquired previously. Users can also re-analyze the signals (solve
the inverse problem) differently.

Export/Import

Clicking on File/Export to export the acquired signals to individual files
for each frequency in ASCII format. Two types of data files are available
for export, the .par files contain the transmitted and received signals vs.
time, and the .cpv files are used by graphic software DF CONTOUR®
developed by DYNAFLOW, INC which is provided with the ABS. Clicking
on File/Export to export the experiment data to current directory, at first a
window pops up to let the user decide whether to export the .cpi files.
Then a series of files are generated with names of the form xxxxaz par
and/or xywxaz.cpv based on the users’ choice, where vvx 1s the frequency
of the signal (in AHz).
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In addition to exporting an individual file at each frequency, the following
files are also exported:

e correration.nar. This file includes at each frequency the sound
speeds based on time delay between the detected starts of
transmitted and received signals and based on correlation as well
as the time delay obtained from the correlation.

o recampLiropeDAT. This file includes the amplitude of the received
signal at each frequency.

e recrower.par. This file includes the power of the received signal at
each frequency.

e 7rRaampLITUDE.DAT. This file includes the amplitude of the
transmitted signal at each frequency.

e 7R4POWER.DAT. This file includes the power of the transmitted signal
at each frequency.

e urrane. This file includes the sound speed ratio and the attenuation
ratio at each frequency.

The reference data can be exported individually by clicking on File/Export
reference results. A .rer file with a name specified by the user will be
exported. In addition to the total number of sampling frequencies used, it
also exports the corresponding time delay between transmitted and
received signal, the power of the signals, and the gains for the transmitted
and received signals at each frequency.

Clicking on File/Import to import the individual .pAT files for each
frequency listed in the property page Signals in the experiment settings as
described in section 4.2 Note that if a corresponding .par file does not
exist for a frequency listed an error message pops up to show the
information about the missing data file.

40



ABS Acoustic Bubble Spectrometer™® USER MANUAL: 7-077v. 5.0

5. Example ABS Acoustic bubble Spectrometer™
Experiment

An example of taking a set of measurements with the ABS Acoustic

bubble Spectrometer™* is provided in this section. The bubble population

in water at an ambient pressure of //0 kPa and a temperature of /5C is
determined. The gas in the bubbles is air. The following procedures are
performed.

1. Run the ABS Acoustic bubble Spectrometer™® software by double
clicking on the ABS icon. A screen with blank plots and a tool bar will
appear. If desired, an existing file from a previous session with a .48s
extension may be opened as a starting point.

2. Use the File / Save As a utility to create a new file.

Select the Experiment Settings button from the tool bar.

4. Go to the General information page and fill in the information desired
(Figure 1).

5. Go to the Signals page. Edit the default frequencies to those desired.
Edit the default gains (applied to the voltages of the transmitted and
received signals by the data acquisition board) such that sufficient
resolution is attained for the particular configuration without saturating
the received signal (Figure 2).

6. Select the box “Generate Reference Data” option to obtain the reference
background data set.

7. Go to the Physical Parameters page. Edit the default values of these

physical conditions to correspond to those of the experiment as

required (Figure 3).

5]

.

8. Click on the Acquire button. % | A “no-bubble” reference state is
generated and the sent and received raw signals are displayed (Similar
to Figure 5). It is very useful to inspect the signals to assure that
sufficient resolution was obtained and that there are no other problems
such as no received signals or no delay between emitted and received
signal which usually indicates electric leak problems between the
transducers. If these signals are not satisfactory, one should return to
the Signals page and modify the settings accordingly or inspect the
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experimental setup for problems. A new reference state can then be
acquired.

9. Experiments in the presence of bubbles will now be conducted having
a suitable reference state in memory.

10. Select the Experiment Settings button again and go to the Signals

page. Turn off the “Generate Reference Data™ option
e

o
e

11. Click on the Acquire button. The sent and received raw signals in
the presence of bubbles are displayed (Figure 5). Again, it is useful to
inspect these signals to assure that sufficient resolution was obtained
and that there are no other problems.

12. Go to the Physical Constraints page and edit these as needed.

13. Select the Analyze button \ﬁl to process the acquired experimental
data. The results will be displayed as in Figure 9.
14. 1f desired, one may alternately view the raw signals and the calculated

results by use of the View Signals ‘ﬂ and View Results ki buttons.

15. The experimental data (including reference state data) and results may
be saved to disk at any time by use of File/Save.

16. Based on these results, refine the parameters if desired and repeat the
experiment.

6. Advanced Features

6.1 Utilizing the Signal Dropping Option

In version 5.0, the user has the option to actively interfere with the signal
processing. This option should only be used by a very educated user and,
if not properly used, could result in very erroneous results. With this
option the user can define criteria for dropping signal from the analysis.
Figure 20 shows the signal drop option page which can be activated by
requesting a Key from DYNAFLOW. The user can choose to drop a signal if
the signal to noise amplitude ratio is less than a given threshold or if the
sound speed ratio from the analysis is outside of the user specified range.
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7. Useful Tips for Running Measurements

To maintain the best signal possible, make sure that the battery in the
amplifier is powerful enough. Also keep the hydrophone surface clean and
bubble free as much as possible.

Experiment Settings rz]
Genaral | Signats | Prysical Parameters | Physical Constraints  Sigral Diop Options Dilog ]

Sigral Dnopping Criterion
" Mo signal drocping
= Dhon signaks ot meets the iolovang cikeriort

[+ Fatio of signal to nosse ampltude less than |2

Iv Sound speed ratio bepond the folowing rangs:

Minimum raticc {7 1 M andmum ratio: |7 5

Figure 20. Signal dropping options.
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Accessories \

REDLAKE @
MotionPro X3 ‘

Redlake's new MotionPro® X3 high-speed motion camera combines excellent resolution to frame
rate performance, along with the advanced features you require for accurate high-speed motion
analysis on your PC or Mac laptop or desktop computer. The enhanced sensitivity of the
MotionPro® X3 combined with 1000 fps at 1280 x 1024 is perfect for research and development
laboratory environmenits.

The new X3 camera features uses the latest Gigabit Ethemet along with USB2.0 for easy inferface.
It also features live video for continuous monitoring.

With the MotionPro® X3 camera integration could not be simpler. Just install the software, connect
one or mere X Series cameras to USB 2.0 or Ethernet ports {or both), and you are ready to capture
high-speed digital imagery. Control the camera with the feature-rich MotionPro® X software or use
the LabVIEW™ or MATLAB® plug-in to integrate it into a larger experiment setup. To create your
own conftrol software, an SDK is included.

The extensive image processing algorithms include binning {2x2, 3x3, and 4x4), filtering, advanced color control, and programmable
LUT enable you fo maximize the image quality under various lighting conditions.

Flexible recording options allow the user to capture pre-selected number of frames before and/or after receiving a trigger. Double-
exposure mode, with a 100 nanoseconds inter-frame time, is perfect for motion analysis on okjects moving at very high speeds.
Memory may be divided into multiple sessions with or without automatic download to assure no event is missed.

Applications: Microscopy, Ballistics and Munitions esting, Biomechanical research, Fluid dynamics research (PIV), Off-board vehicle
impact testing

et

Features

I |

Up to 1280 x 1024 resolution High resolution allows fine detail to be captured even at high frame rates
color or mono

Fast frame rates from 1000 fps at Perfect for capturing movies of fast dynamics of a process or event

full resolution to over 64,000 fps at
reduced resolution

Gigabit Ethernet and USB2.0 Operate camera from remote locations via Gigabit Ethernet while using USB 2.0 for local
monitoring

100 nanosecond inter-frame time in perform particle imaging velocimetry (PIV] measurements to study fast moving fluids
double exposure mode

iPod and PDA compatibility Store movies on to iPod (video) for quick review. Control the camera cperation remotely and
wirelessly via PDA interface

Sample Frame Rates ‘

Vertical Resolution Max. Horiz. Resolution = 1280
1024 1000
768 >1300
512 2000
256 4000
128 8000
64 16,000
32 32,000
16 64,000

Nate: Horizontal resolution does not offect frame rate performance. Al X cameras con record af any frame rate at full horizontal resclution.

|
X Timing USB digital interface, integrated control software with 8 outputs,
Hub 2 inputs

USB Foruse up fo 15m
Repeater

MotionPro X3 Rev AD page 1 of 2
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MotionPro X3 Performance Specifications

CMOS Imager

Sensor Array Area Array with 12um x 12um pixels, color or monochrome
Image Resolution Up to 1280 x 1024 at 1000 fps

Dynamic Range 59 dB at sensor

Memory and Record Rates

On-board Storage 4 GB
Recording Rates Selectable, up to 64,000 fps
Playback Rates User selectable

Camera Confrol

Shutter Global Electronic Shutter variable from 1us, optional 100 hancsecond exposure*
Exposure modes Single, Double, XDR {extended Dynamic Range)

Trigger Frame Variable position from start to the maximum available frame capacity

Trigger Mode CMOS level {3.3v) via BNC connectors

Time Stamp Each frame

Control Software MotionPro X; Windows 2000/XP, Mac OS X** {10.3 or later)

Image Processing Binning. filtering, advance color control, and programmable LUT

Algorithms

Plug-ins LabVIEW™for PC; MATLAB® for PC and Mac; Twain Driver for PC and Mac

File Formats TIFF, BMP, PNG, MRF, MCF, AVI, BLD, MPEG, and MOV {Mac only)

Mechanical Description

Camera Dimensions 3.7in {95 mm) H x 3.7 in {95 mm) W x 6.4 in {162 mm) L

Camera Weight 4.2 Ibs {1.9 kg)

Camera to PC Interface USB 2.0, USB 2.0&Gigabit Ethemet {optional)

Camera Cable Lengths 5m {USB2.0); Longer cable lengths {not supplied) may be used with GigE
Lens Compatibility 1" C-mount

Lens Mount C-mount, F-mount adapter {optional)

Synchronization

Synchronization All cameras are synchronized with each other using an external sync pulse on 3.3v CMOS BNC
(USB Hub Optional) connector

Camera Power +24 vdc {100-240 VAC, 50-60 Hz ac/dc convertor)
Operating Temperature +5°C to +40°C Ambient {0°F to 122°F)
Emission/Safety CE approved, FCC Class B comgliant, UL listed
Input/Ovutput

Trig In (BNC)

Sync In (BNC)

Sync Out (BNC)

USB 2.0 (LEMO)

Gigabit Ethernet

Live Out (BNC) RS170 (NTSC/PAL)
DC Power (LEMO)

*Enquire with factory
**GigE interface is not supported under Mac.
Specifications are subject ta change.

www.redlake.com email: info@redlake.com
REDLAKE USA +1 800.462.4307 Asia/Pacific +65 6293.4758

Japan +81 3.5639.2770 EMEA +31 347.32.4989

MotionPro X3 Rev AD
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1. Precautions

1.1. Cleaning the sensor

Clean the optical surfaces with filtered, compressed air and glass cleaner or distilled water.
Use a cotton swab or lens paper. Do not use alcohol or other solvents as these may damage
the optical coating and cements.

1.2. Laser

Do not focus a laser beam on the sensor directly or by reflection, it can cause permanent
damage to the sensor. Any laser powerful enough to produce localized heating at the surface
of the sensor will cause damage, even if the camera power is off. Laser-damaged sensors
are NOT covered by the warranty.
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2. Warranty

IDT, Inc. provides warrants to the original purchaser that, from the date of delivery, the
hardware components of the MotionPro X™ System or the MotionScope M™ System or
the MotionPro Y™ System, the MotionXtra™ N System or the MotionXtra™ HG System
(the “Product”) will be in good working condition for a period of one (1) year on all parts.
Should any of the components of this Product fail to be in good working order at any time
during this warranty period, IDT, Inc. will either repair or replace those components at its
factory at no additional cost. This warranty does not include service to repair damage to the
Product caused by accident, disaster, misuse, abuse, or non-IDT modification of the Product.
All service shipments to IDT must be sent pre-paid. Warranty service may be obtained by
contacting IDT in writing during the warranty period.

Integrated Design Tools, Inc.
1202 E Park Ave
TALLAHASSE FL 32301 - USA
Attn.: Service Department

T: (850) 222-5939

F: (850) 222-4591

Note: It is requested that the product be returned to INTEGRATED DESIGN TOOLS, Incorporated for
warranty service in its original packaging.

Users Manual 9



Motion Studio

3.

System Overview

3.1. Introduction to the cameras

10

A “state-of-the-art” CMOS sensor combined with the most advanced features we and our
customers could think of, resulted in a new product line: the Y-series.

The Y3 captures the 1280 x 1024 images with a speed of 1000 fps. Up to 2000 fps in Plus™

mode and frame rates up to 100.000 fps possible at lower vertical resolution. A large internal
RAM memory, up to 16 GB accommodates long recording time.

Two interfaces (Gigabit Ethernet and USB 2.0) accommodate easy communication with
multiple cameras (a mix of Y, X, M, and MotionXtra cameras).

The new design offers a high refresh rate during recording and playback through the digital
HDMI output. The use of composite materials and a smart mechanical design results in a
shock resistant camera up to 100G.

The optional battery pack offers the backup of the images in case of power surge but also an
autonomous use up to 60 minutes.

Current MotionPro Y models are Y3, Y4L, Y5, Y6 and Y7 HDiablo (1920x1080 — 1700 fps)
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The MotionXtra N-series cameras include the capabilities of the Y-series in a small camera
package.

The N3 captures the 1280 x 1024 images with a speed of 1000 fps. Up to 2000 fps in Plus™
mode and frame rates up to 100.000 fps possible at lower vertical resolution. The internal
RAM memory, up to 2.5 GB accommodates compressed images.

The Gigabit Ethernet accommodates easy communication with multiple cameras (a mix of Y,
X, M, and HG cameras).

The optional battery pack offers the backup of the images in case of power surge but also an
autonomous use up to 60 minutes.

Current MotionXtra N models are N3, N4L, N4 and N5.
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12

The MotionScope M-series comprises two configurations of area scan cameras which are
designed for use in industrial and research environments. The M-3 features a 1.3 Million pixel
sensor delivering over 500 fps via a standard Camera Link® interface, whereas the M-56
provides a very high resolution image with 4 Million pixels and sustained rates over 150 fps.
The camera electronics are packaged in a very compact and rugged housing capable of
withstanding high-G forces and vibration.

Image capture to a computer system is done via a full Camera Link™ frame grabber. To
ensure the best possible performance and ease of use the M-series have seamlessly
integrated to operate with the Motion Studio software suite. The Motion Studio suite and SDK
integrates the M-series in a single software platform with IDT X-series, Y-series and Redlake
MotionXtra camera systems.

The camera benefits of such features such as pre and post triggering for event capture,
circular buffering, external synchronization and flexible choice of ROIl. When very long record
times are required this compact camera system is configured with a dedicated disk array
system.

This flexible and compact camera system is well suited for a variety of vision inspection
applications as well as for R&D laboratory usage.

Current MotionScope M-series models are M3 and M5.
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The X-Series is the first high-speed camera featuring a CMOS sensor that can support a
double-exposure mode. This mode advance allows two consecutive exposures within a
100-nanosecond interval, a revolution for capturing the motion of objects at ultra-high speeds,
as in Particle Image Velocimetry. High framing rates are achieved using the partial
windowing capability. The X-Series cameras are designed for use in industrial and scientific
applications that include machine vision, microscopy, and flow and spray analysis.

The camera is supplied in one basic memory configuration: 4 GB.

The cameras feature a USB 2.0 digital interface and Giga-Ethernet (1000 Mbps) that
provides true and easy plug-and-play installation and capabilities at a high-speed rate of
transfer to a desktop or laptop computer with a single cable. Also, the readily accessible sync
input and output signals quickly integrate the camera with illumination sources, such as laser
or strobe light. A video output signal (PAL/NTSC) and IRIG-B are also available.

Current MotionPro X models are: X3, X4, X5 (2352x1728 — 250 fps).
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HG systems are rugged cameras that can withstand violent forces up to 100 G. They come
equipped with an internal battery for memory backup, and feature a synchronization scheme
via a hub that has become the standard among many automotive manufacturers.
HG camera designs are ideal for Range, Aerospace, and Ballistics applications due to their
rugged build, and their ability to perform in a wide range of environments. Accurate phase
synchronization between cameras is easy using GPS signals, even when the cameras are
miles apart.
The unique ability to process images via look-up tables (LUTs) on the fly allows the system to
acquire and download 10 bit dynamic range images at the same fast rate as downloading
8 bit images. Custom LUTSs can also be created for the specific needs of any application.
Current HG models supported by Motion Studio and the SDK are:

e Legacy Redlake cameras (HG-2000, CR-2000, HG-TX).

¢ HG-100K, HG-LE, HG-TH.

¢ New HG-XR, HG-XL and HG-CH.
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3.2. System components

The systems components are listed below.

Camera: it is the first high-speed camera featuring a CMOS sensor capable of
supporting a double-exposure mode. The camera body accepts standard C-mount
lenses.

MotionPro X/Y and MotionXtra N Digital Interface: The USB 2.0 (480 Mbps) cable or
Giga-Ethernet (1000 Mbps) provides data and control signals to and from the camera as
well as it connects the camera to any USB 2.0 or Ethernet port on your personal
computer or laptop. N cameras do not have any USB interface.

MotionScope M Digital Interface: the camera interfaces to a computer system via a Full
Camera Link™ frame grabber. Currently supported frame grabbers are the Dalsa-Coreco
X64 Xcelera-CL PX4 and the National Instruments PCle-1429.

Power Source: The power source provides external power to the camera

Trigger and Synchronization Connectors: The camera has three BNC connectors for
input and output of synchronization signals and triggering. These signals are CMOS level,
and provide a means to synchronize the camera with an external clock or triggered it with
relationship to a given event. The synchronization signals are generated for every image
frame produced.

Software and SDK: operates in Windows 2000, XP, Vista and MAC OS X (10.2 and
later) environment.

Optical Interface: The standard interface is C-mount. C-to F and Canon mount
converters are available upon request.

3.3. System accessories

MotionPro Timing Hub: USB 2.0 digital interface, integrated control software with 8
outputs and 2 inputs.

MotionPro Data Acquisition (DAS): USB 2.0 digital interface, integrated control
software with 16 analog inputs, 4 analog outputs and 16 digital I/O channels.

Galileo Wireless Sync/Trigger system.
USB repeater: forup to 15 m.

3.4. Note on cross-platform manual

The cross-platform manual provides instructions on using the camera on the Windows and
MAC OS/X platforms. The Windows and MAC icons below denote differences in setup,
procedures and commands between Windows and MAC users.

[ .I;"J “

Users Manual 15



Motion Studio

3.5. Software Development Kit

I
a

16

Upon the installation of the Motion Studio software package several options are available to
the user. These options are easily accessed via the Program menu under the Windows Start
button. The programs and associated files are organized under the IDT/MotionProX folder
(IDT/MStudio64 for the 64 bit version and /Applications/MotionProX for the MAC version).
The folder includes the example programs and the associated documentation. The software
components included in the Software Development Kit are:

= SDK modules with example source code in MSVC++ and VB.
= TWAIN driver.

*  Plug-in for LabVIEW™ (Windows only).

= Plug-in for MATLAB™.

The SDK modules provide an API interface to develop applications to operate the camera
and access all the camera capabilities using a programming language such as C++ and Java.
A C/C++ header file is included in the SDK (XStrmAPLh file in the Include sub-directory).

Most compiled languages can call functions; you will need to write your own
header/import/unit equivalent based on the C header file.

A Visual Basic module is included in the SDK (XStrmAPl.bas file in the Include sub-
directory). VB cannot use XsQueueOneFrame or XsQueueCameraSettings or related
functions, because these functions have callbacks which occur on a different thread. If you
want to use VB, you might need to write some C code depending on your application's
requirements. The same issue with asynchronous callbacks, above, also applies to Java.

The Windows driver is a DLL (XStreamDrv.dll) that resides in the system32 directory. It may
be found also in the Bin sub-directory.

MS Visual C++™: A Visual C++ 6.0 stub COFF library is provided (XStreamDrv.lib in the Lib
sub-directory); if you are using Visual C++, link to XStreamDrv.lib. The DLL uses Windows
standard calling conventions (_stdcall).

Borland C++ Builder™: the XStreamDrv.lib file is in COFF format. Borland C++ Builder
requires the OMF format. To convert the library into to OMF format, use the IMPLIB Borland
tool with the following syntax: “IMPLIB XStreamDrv.lib XStreamDrv.dIl”.

Other compilers: the Most other compilers can create a stub library for DLLs. The DLL uses
Windows standard calling conventions (_stdcall).

MS Visual C#: the XsCamera.cs file has been added to the include folder. It wraps the APIs
into a C# class. Just include the file into your C# project and call the “XsCamera” class
members.

MAC OS Project Builder™: the driver is a Framework that resides in the
/Library/Frameworks folder. If you use Apple Project Builder 2.1, add the
XStream.framework file to your project.

For a more detailed description of the SDK please refer to the Motion Studio SDK
Reference.
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4. Installing the System

This section specifies the minimum recommended computer requirements and gives the
procedures needed to install the Camera Head, Camera Cable, Power Supply, /O Cable,
and software.

4.1. Minimum computer requirements

MotionPro X/Y — MotionXtra N

PC (Win32 and x64) MAC
Operating System Windows XP, Vista and 7 MAC OS X 10.3 (Panther) or higher
Processor Pentium Il or equivalent with 500 ;
MHz processor. G4 MAC OS X compatible
RAM 2GB 512 MB
USB 2.0 Port USB 2.0 port that is NOT shared | high speed USB port that is NOT
with other devices (X and Y) shared with other devices (X and Y)
Network adapter Giga-Ethernet (recommended) or | Giga-Ethernet (recommended) or
10/100 Mbps. 10/100 Mbps (Y and N).
Hard Drive 60GB or greater hard drive | 60GB or greater hard drive
(recommended). (recommended).

NOTE: Use an USB 2.0 port on the computer or a Giga-Ethernet port. USB 1.1 DOES
NOT support camera operation.

MotionScope M™
PC Win32 PC x64 MAC

Operating Windows XP, Vista and 7 @ | Windows XP, Vista and 7 @ 64-
System 32-bit bit BicHSUpRaTEd
Processor Intel CORE 2 at 2 GHz Intel CORE 2 at 2 GHz. Not supported
RAM 2GB 4GB Not supported
Frame Coreco X64 Xcelera-CL PX4 Coreco X64 Xcelera-CL PX4
Grabber NI PCle-1429

EPIX PIXC| E4 EPIX PIXCI E4 Not supported

Bitflow Karbori Bitflow Karbon
Computer One available x4 or larger | One available x4 or larger PCI T
Slots PCI Express slot Express slot PP
Hard Drive 100GB or greater hard drive | 100GB or greater hard drive Not supported
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4.2. Package contents

Before beginning the installation process, check that the following items are present in the
package. If you are missing any of the items listed below, please contact IDT, Inc. or your
sales representative.

= Camera.

= |/OUSB 2.0 Cable (MotionPro X and Y camera).

= CD-ROM of Motion Studio software suite and documentation.
= Power supply.

»  Cross-platform Quick Start Guide.
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4.3. MotionPro X/Y and MotionXtra N camera Installation

4.3.1. Software Installation

8 |

[T Windows 2000/XP/Vista
A

Before installing the software make sure that the computer has Windows 2000, XP or Vista
installed as operating system.

1.

Log into Windows with a username and password that has ADMINISTRATIVE
PRIVILEGES.

Insert the Motion Studio CD in the CD drive. If the computer is configured to AUTORUN,
the installer will run automatically. If not, click on the Windows Start button. Select Run
from the menu. Use the Browse button to locate the SETUP.EXE file on the CD and click
the OK button.

Select the “Install” option and follow the on-screen instructions.
EXIT when the installation is complete and restart your computer.

MAC OS/X

Before installing software make sure that your MAC has MAC OS X 10.2 (Jaguar) or higher,
installed as operating system.

1.

Log into Mac OS/X with a username and password that has ADMINISTRATIVE
PRIVILEGES.

Insert the Motion Studio CD in the CD drive.
Locate the mstudio.dmg file in the MAC sub-directory of the CD.

Double click on the mstudio.dmg to run installation program and follow the on-screen
instructions.

EXIT when the installation is complete and restart your computer.
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4.3.2. Hardware installation (USB 2.0)

A 24 VDC, 1 Amp supplies the camera with the necessary power. This power supply unit is
included with the camera system package. All communication and data transfer with the host
computer is done via the USB 2.0 or the Giga-Ethernet interface. The USB 2.0 interface
requires a single cable, which is also supplied with the camera package. External triggering
and synchronization are done via the two connectors (BNC type). Triggering is expected to
be done with a TTL pulse. The synchronization signal is also TTL level.

NOTE: Connect the camera to the computer before connecting the camera to the power
source.

/Wy Windows 2000/XP/Vista

I

20

1

2.
3.
4

Connect the USB 2.0 cable to an available USB 2.0 port on your computer.
Connect the other end of the USB 2.0 cable to the back of the camera.
Connect the camera to the power source.

Turn the camera ON/OFF switch to the ON position and wait a few seconds for the
camera to initialize it self.

Follow the on-screen instructions. Click on the YES or Continue Anyway button when
prompted by the Windows 2000 or XP Operating system to proceed with the installation.

MAC OS/X

N

Connect the USB 2.0 cable to an available USB 2.0 port on your computer.
Connect the other end of the USB 2.0 cable to the back of the camera.
Connect the camera to the power source.

Turn the camera ON/OFF switch to the ON position and wait a few seconds for the
camera to initialize it self.

NOTE: Use an USB 2.0 port on your computer. USB 1.0 does NOT support camera
operation.
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4.4. MotionScope M camera installation

4.4.1. Installing the Dalsa-Coreco X64 Xcelera-CL PX4 frame grabber

Install the frame grabber in a PCle x4 slot and power up your computer.

Install the “X64 Xcelera-CL PX4 driver for Sapera LT Image Library” and follow the
procedure below to update the firmware.

1. From the “All Programs -> DALSA -> X64 Xcelera-CL PX4 Driver’” menu, select the
“CorDeviceManager” item.

Select the Firmware Update Tab.

From the Configuration combo, select the “10 Taps Format 2" option.

Click the Start Update button.

Restart the computer.

o N

w2 DALSA Device Manager v:2.69

File Help
Firmware Update Manager
Start Update
Board | Field | Yalue
HeelersCL_FP=4_1 Senal Mumber S00E1040
[4 |Board Yersion Al

ACU/DTE + PCle »4 Interface 1.00.00.0127
Configuration '
Information Fomnat 2. 10-Tap configuration file for be cameralnk Full boards. See board maral |

" Devicelnfo  Fimware Update

Output
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Install the “Sapera LT Image Library” version 6.04. Then follow the procedure below to edit
the camera serial port. The configuration is necessary to correctly operate the camera.

1. From the DALSA -> Sapera LT menu, select the Sapera Configuration item.
2. From the Maps to combo-box in the “Serial Ports” group, select the “COM 4” option.

3. Exit the program and restart the computer.

mY Sapera Configuration

Server List
Index | Name | Serial Nurmnber |
0 System (None]
1 Reelera-CL_P4 1 SO0E1040
Contiguous Memary
Used for allocating buffers- Uzed for allocating messages
Requested Fequested
|5 - MBytes [6 -+ MBytes
Allocated Allocated
5 MEytes |6 MEytes
Serial Ports
Phwzical Port Mapz to
Serial_0 on Xcelera-CL_P4_1 | |COM4 |
Selected physical port iz prezent
N\ Ve Camera Link AP port index =0
— Save Settings Now Close
JALSA

NOTE: if more than 1 frame grabber is installed, you have to select a different COM port for
each frame grabber (COM4 for FG1, COMS for FG2, etc.).
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4.4.2. Installing the National Instruments PCle-1429 frame grabber

e Install the software by following the instructions below.

1. Install the “NI VISION Acquisition software” version 8 or later, which includes the NI-
IMAQ driver software.

2. Install the Motion Studio software suite (see the following topics).

+ Install the frame grabber in a PCle x4 slot and power up your computer.
+ Connect the camera (see the following topics).

¢ Run the NI “Measurement and Automation” utility and follow the instructions below.

‘% Channel 0: IDT MotionScope M3 - Measurement & Automation Explorer
Fle Edit View Tools Help
Configuration
= 2 My System

= @@ Devices and Interfaces

(= (=8 NI-IMAC) Devices
= gl imgD : NI PCle-1429
L] Channel 0: 1DT MationScope M3

& [ Softwars

+ 9 Remote Systems

Bsave giccvet  I»snap B Grab WA Histogram 7 ¢ Show Help

00 1%

Camera Desciption

Manufactuer. |IDT ]

Modek |MotionS cope M3

i3 General | » Acquisition Parameters | 43 Camera Attributes | £ LUT |

1. From the left pane, expand the “Devices and Interfaces” branch of the configuration tree
2. Expand the “NI-IMAQ Devices” branch.

3. Expand the “NI PCI2-1429” branch.

4. Right click “Channel 0” and select “Camera”.

5. From the menu, locate IDT, then “MotionScope M3” or “MotionScope M5” and select it.

6. Exit the measurement and Automation utility.
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4.4.3. Installing and configuring the EPIX PIXCI™ E4 Frame Grabber

Install the software by following the instructions below:

1. Install the “XCAP Imaging Application for Windows 95/98/ME/NT/2000/XP/Vista”
software.

2. Install the Motion Studio software suite (see the following topics).

Then power off the computer, install the frame grabber in a PC| Express x4 available slot and
power up the computer.

Install the drivers for the frame grabber form the location where XCAP has installed them.
The default is C:\Program Files\EPEX\XCAP\Drivers\WinXP.

Run “XCAP for Windows". Enter the activation code and restart the application.
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4.4.3.1. How to set the M3 or M5 camera as default
To set M3 or M5 as default, the board sub-model must be changed.
1. Fromthe PIXCI menu item, select “PIXCI| Open/Close”.

2. If the Close button is grayed out, click Open. A window with a pre-configured camera
model will be open.

3. From the PIXCI Open/Close window, click “Board Info”. The dialog box below will appear.

%o PIXCl® Board Info

Imaging Board Model |PIXCI E4

Imaging Board Submadel |||3'T M-5
Configured as Submocel |IDT M-3
Frame Buffer Memory |32.IJIJ (MByte — IEC MIB] Memory Setup |

Imaging Boards in ze |1

4. Click “Submodel Setup”. The PIXCI Maintenance dialog box will appear, like in the picture
below.

5. From the Set new submodel list” select IDT M-3 or M-5.

6. Click OK.

“& PIXCI® Maintenance

et Sub del

'  Change Default Submodel
Use this option to reprogram the board's submodel - the default catmera which is

azsumed by software. The newve default will have effect the next time the board is
opened. Unlike software overtide of the board's default, the new programimed

default will be effective even if the board is moved to another computer.

Original (Factory) Submadlel |Generic Camera Link
Currrt Submodel |IDT M-5

Set Mew Submodel [IDT p-3 |

Cancel
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4.4.3.2. How to increase the amount of memory allocated for the acquisitions

The PIXCI E4 drivers do not allow increasing the number of buffers to acquire via the XCLIB
library. It may be done only via the XCAP Imaging application.

The PIXCI driver allocates the memory when Windows starts up, then each change is
followed by a computer reboot.

1. Fromthe PIXCI menu item, select “PIXCI Open/Close”.
2. Ifthe Close button is active, click Close.

3. Click the “Driver Assistant” button and select the “Set Frame Buffer Memory Size” item.

b

Change the memory size in the “Memory requested for Frame Buffers” control.

™ Inestall PIXCI® Driver
ng the 'Forcaful’ moce!
" Uninstall PIXCI& Driver
" Inetall PIXCI® Camera LinkE Serial DLL
ation
[ Uninstall PIXCIE Camera Link® Serial DLL
cation
[ Install Mewwer Yersion of PRGCKE Driver
(¥ . Set Frame Buffer Memory Size Memory Requested for Frame Buffers |128.00 (MByte — :
™ Irstal Authorization Key Driver Frame Buffer Memory Partition Size [‘1 6.00 (MByte —1 = Use Defautt v
" Uninstall Authorization Key Driver
" Download & Update Program Total Computer System Memary ['l 024.00 (MByte _—:j
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4.4.4. Installing and configuring the Bitflow Karbon-CL Frame Grabber
First install the software by following the instructions below.

1. Install the “Bitflow SDK. When the setup asks for serial number, enter the value “0”. It will
install all the binary modules necessary to operate the camera.

2. Install the Motion Studio software suite (see the following topics).

Then power off the computer, install the frame grabber in a PCI Express x4 available slot and
power up the computer.

Follow the instructions on video when Windows detects the frame grabber. When Windows
asks to verify the driver, click “Install anyways”.

Run the “SysReg” application from the desktop link. When the utility starts, it will show the
frame grabber information.

Boards installed: 4 (0] - KBN-PCE-CLA-F, YFGO, CL1/2, Master
RE4 (1) - KBN-PCE-CL4-F, VFG1, CL2/3

Board operation: Configure... |

Other bus mastering devices: [~ Pragram their latency

Latency ta program: |

Camera configuration file path: Il:: \Pragram Files\BitFlow SDK 5.00\Cor

Change path: M
Cancel | ITI
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4.4.4.1. How to attach the correct camera file to the frame grabber
From “SysReg" utility, click on the “Configure...” button next to “Board Operation”.
From the “Board Details” window that appears, click the “Add...” button.
In the “Choose camera file” dialog box that opens, locate the “Make: IDT, Inc.” tree item.
Expand the tree to the bottom and select M3 or M5 camera file.

Select OK.

(X

Board Details

Board type [model): ]H54 (0) - KBN-PCE -CL4-F, VFGO, CL1/2, Master

Board ID register; |3

Board DMa latency: |55

Attached cameras:  HlaNE NI RNz

Camera file operation: Add... | Change... Remaove I Recent -» I

Special firmware; M

Cancel I | 0K I
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4.4.4.2. How to install the correct firmware on the frame grabber

From the “Board details” window, click on the “Configure...” button next to “Special firmware”.

In the right pane of the window that appears, select “Ten tap, ten way interleaved”.

Click Apply and wait until the firmware is updated.

Click OK to close the “Board details” window.

Click OK to close SysReg.

Firmware Details EJ

Firmwane Component

KBM4FLX

Selected Firmware

Standard

Ten tap, ten way interleaved

Standard

Four tap segments, two right taps inverted
Eight tap zegmented cameras

Eight tap segmented, odd/even pixel. four righ

Cancel |
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4.4.5. Installing the Motion Studio software suite

Before installing the software make sure that the computer has Windows XP or Vista installed
as operating system.

1. Log into Windows with a username and password that has ADMINISTRATIVE
PRIVILEGES.

2. Insert the Motion Studio CD in the CD drive. If the computer is configured to AUTORUN,
the installer will run automatically. If not, click on the Windows Start button. Select Run
from the menu. Use the Browse button to locate the SETUP.EXE file on the CD and click
the OK button.

Select the “Install” option and follow the on-screen instructions.
EXIT when the installation is complete and restart your computer.

4.4.6. Connecting the camera

30

A 12 VDC, 1 Amp supplies the camera with the necessary power. This power supply unit is
included with the camera system package. All communication and data transfer with the host
computer is done via the Camera Link interface. The Camera Link interface requires two
cables. External triggering and synchronization are done via the three SMA connectors.
Triggering is expected to be done with a TTL pulse. The synchronization signal is also TTL
level.

NOTE: Connect the camera to the computer before connecting the camera to the power
source.

1. Connect the Camera Link cables to the frame grabber on your computer. Connect the
lower connector on the camera side to the connector on the computer that is near the PCI
slot.

2. Connect the camera to the power source.
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4.5. Camera back panel

4.5.1. MotionProY

The MotionPro Y-series camera back panel (revision 5) is shown below.

Trigger In
And LED

Sync In
And LED

IRIG
(optional)

Control

Users Manual

Gigabit Ethernet connector

Synch Out
And LED

USB-2 connector

Power
(12 VCD, 3A)

HDMI
output
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Control pins (Rev 5 and below)

The Sync/Trigger signals are available through the pins of the Control LEMO Connector. The
connector is located in the central part of the back panel. The signals mapping is listed in the
table below:

PIN # Position Type Signal
1 Upper-Left INPUT Trigger In
2 Lower-Left INPUT Sync In
3 Lower-Right | OUTPUT Sync Out
4 Upper-Right - Ground

Control Pins (Rev 7 and above)

In hardware revision 7 (H) cameras, the control connector is an 8 PIN size 1 LEMO and it's
located in the left side of the back panel. The pins indexes are listed below:

¢ PIN 1: upper position close to the red dot.
¢ PIN 2 to 7: counter clockwise from PIN1.

¢ PIN 8: central position.

The pin-out is in the table below.

PIN # Type Signal
1 - +12V
2 - Ground
3 IN Trigger In
4 IN Sync In
5 ouT Sync Out
6 IN RX
7 ouT TX
8 IN GPS

RX and TX are “receive” and “transmit” signals of the new internal serial interface.
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4.5.2. MotionXtra N

Power Connector
(12VCD, 1 A)

Power LED

Users Manual

Gigabit Ethernet connector

LEDs

Sync Out

SyncIn

Trigger In
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4.5.3. MotionScope M

34

The MotionScope M-series camera back panel is shown below.

LEDs

Power LED

Power Connector (12 VCD, 1 A)

Camera
Link

Trigger In

Sync In

Sync Out
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4.5.4. MotionPro X

The MotionPro X USB 2.0/Gigabit-Ethernet camera back panel is shown below.

Gigabit Ethernet connector

USB-2 connector

GIGABIT ETHERNET
Trigger In K ' 2 Synch Out
And LED SYNCIN SYNC OUT And LED
Sync In
And LED
IRIGB Live Video Output (PAL/NTSC) | Power Connector (24 VCD, 1.6 A)

Users Manual
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4.6. IRIG Support

X cameras support IRIG B-120. The signal should be connected to the Trigger In connector.
Y cameras support the IRIG modes listed below.

¢ Modulated IRIG: A,B,D, E, G, H

¢ Level Shift IRIG: B simple and B differential.

The IRIG signal is detected by an external box docked to the camera and connected to the
“Control” 8-pin control LEMO connector.

The module has three LED:

* Red: power.
¢ Yellow: IRIG signal is locked

« Green: 1 PPS reference signal sent to the camera.

LEMO connector for control signals

GPS antenna
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4.7. IRIG-Flash Device

E / GPS antenna
-]

LEMO connectors for control signals

The IRIG flash device is an external box that can be connected to the Y cameras via the
external 8-pin and 4-pin control LEMO connectors. The device can be easily hooked to the
camera. It is provided with a connector for a GPS antenna and it is fully compatible with the
Motion Studio software.

Also, it is provided with a smart card slot that can contain a 16 GB SD card (SD-HC), for a
direct download of the acquired images.

SD-HC card slot

WARNING: DO NOT CONNECT the control cables between the module and the camera
when the camera is powering up. Connect the cables BEFORE powering up the camera
or AFTER the power up cycle is completed and the back “Status” light is turned into
green,
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4.8. Camera lens adapter

The cameras are supplied with a standard C-mount. Alternatively, a C to F mount adapter is
available to interface with F-mount (Nikon type) lenses. Use Nikon lenses with a tilt/shift
capability when imaging at an angle. As an option, mounting hardware for tilt/shift lenses by
Canon is also available. Contact your IDT sales representative for ordering information.
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5. Configuration of Giga-Ethernet cameras

5.1. Motion Studio Network Configuration Utility
The network configuration utility is an external application that allows the user to configure the
IP addresses of the cameras.

From Windows “Start” menu, select All Programs, then IDT, then Motion Studio, then Tools
and then “Network Configuration”

T Motion Studio Network Configuration

PC Metwork Adapter
‘Bruadcast w ‘
Nebwork Performance: o J

Fast Most reliable
[JEnable Jumbo datagram size {9000 bytes). [ Edit Command Part. .. ]

[ Open Mebwark Connections. ., ] [ Find MotionPro ¥ camera. .. ] [ Refresh List ]

Zameras List

Camera 1P Address Jumbo
BB S Camera 2 - MotionPro ¥ (USB) [128.217.107.160] Yes
BB M4 Eng Camera - Motion¥tra N [192.168.32.39] Mo

Current Camera

Item Yalue
Cameta MAC Address 00-50-C2-74-30-00
Camera IP Address [128.217.107.160]

Camera Metwork Mask [255.255,255.0]

Camera Madel ¥-5
Camera Serial Mumber 20-1109-0001
Camera Revision d

[Edil: 1P address... ] [ Automatically assign IP addresses... I [Reset DHCP Table
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Some of the parameters that can be configured are the same for all the camera models.

Network adapter: the default value is broadcast, i.e. the driver searches for cameras through
each enabled network adapter. If a specific adapter is selected, the driver searches for
cameras only through it.

Network performance: it's a delay added to the data exchange between the cameras and
the computer. If there is traffic on your local network, then move the slider to “More reliable”
to avoid loss of data during the communication

Network Connections: click this button to open the “Network Connections” control panel
applet and configure the network adapter’s IP address.

Enable Jumbo datagram size: see one of the topics below.

5.2. Configuring the Y camera IP address

Y cameras are delivered with a specific IP address. If the address is not compatible with your
network parameters, the camera is not able to establish a communication with the computer
through the network. To set the IP address for the first time, please follow the instructions
below.

e Connect the Y camera to the computer through the USB 2.0 cable.

e From the Motion Studio program group, select Tools and run the “Network
Configuration”.

e The Y camera will be listed as “Camera Name — MotionPro Y (USB)”. Select it, and click
the “Edit IP Address...” button.

¢ Enter the IP address and the subnet mask. Then click OK and exit the configuration
utility.

e Turn off the camera and tum it on. The new IP address is stored and will be used by the
camera in Giga Ethernet communication.

NOTE #1: the computer network adapter may not have a specific IP address because it's
assigned by the DHCP. If there is any problem for the software to detect the camera, it's
better to assign a specific IP address also to the computer adapter. To do that, open the
“Network Connections” window and select the Properties of the network adapter. Select the
“Internet Protocol (TCP/IP)” and click the “Properties...” button. Select the “Use the following
IP address” option and set the IP address and subnet mask values.

NOTE #2: if the camera IP address is not compatible with the adapter's IP address, the

camera will be listed with a yellow exclamation mark. If you try to open a session the software
will not be able to grab images from the camera and an error message will appear.
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5.3. Configuring the N camera IP address

N cameras are delivered with a specific IP address. If the address is not compatible with your
network parameters, the camera is not able to establish a full communication with the
computer through the network. To set the IP address for the first time, please follow the
instructions below.

e Connectthe Y camera to the computer through the Ethernet cable.

e From the Motion Studio program group, select Tools and run the “Network
Configuration”.

e« The N camera will be listed as “Camera Name — MotionXtra N”. Select it, and click the
“Edit IP Address...” button.

o Enter the IP address and the subnet mask. Then click OK and exit the configuration
utility.

e Turn off the camera and tumn it on. The new IP address is stored and will be used by the
camera in Giga Ethernet communication.

NOTE: if the camera IP address is not compatible with the adapter's IP address, the camera

will be listed with a yellow exclamation mark. If you try to open a session in this condition the
software will not be able to grab images from the camera and an error message will appear.
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5.4. Large datagram size (Jumbo packets)

42

Some Giga-Ethernet network adapters are able to send and receive large data packets. The
usual datagram size is 1500 bytes. Large datagram packets, called Jumbo packets, are up to
9000 bytes.

If both the camera and the adapter can use jumbo packets, the transfer speed is increased.
To activate jumbo packets, do the following.

Configuring Jumbo packets on the Network adapter

1. From Windows “Start” menu, open the “Network Connections”™ window and select the
network adapter.

2. Right click and select the Properties menu item.
3. From the Properties dialog box, click the “Configure...” button.

4. From the network adapter configuration dialog, select the “Advanced” tab.

NVIDIA nForce Networking Controller #2 Properties @g|

_.Generd| Advanced_-|nme; Fesources | Power Management |

The following properties are available for this network adapter. Click
the property pou want to change on the left, and then select its value
on the right,

Froperty: Walue:

EEBCIEW'TI Offload I‘IEOD (Standard frame] :]
W Lot 1500 [Standard frame|

|EEES0Z2 1P Support 2500
Jumnbo Frame Payload Size 4500
Lows Posser State Link Speed
Network 2ddress
Optimize For
Segmentation Offload
Speed/duplex settings
WLAN Id
VLAN Support
Walke on Magic packet
‘Wake on pattern
WWakeOnLAN From PowerQFff

[ ok || cancel |

5. From the property list, locate the “Jumbo frame...” item (or anything similar to that) and
change the value to 9000.
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Configuring Jumbo packets on Network adapter

1. From the Motion Studio program group, select Tools and run the “Network
Configuration”.

2. Make sure that the camera is listed and the “Jumbo” item in the camera list is set to
“YeS”.

3. Check the “Enable Jumbo datagram size (9000 bytes)” item.
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5.5. Configuring the X camera IP address

When a MotionPro X camera is powered up, it does not have an IP address. Without a valid
IP address the camera can be enumerated, but some parameters, such as camera model,
serial number, etc. cannot be read. The Configuration utility enumerates all the
MotionPro/MotionXtra GE cameras and shows each camera’s IP address or “none”. A
camera without a valid IP address is listed with a red spot on the icon.

For each camera the user may:

1. Click the “Edit IP Address...” button. If the camera has an IP address, it may be edited,
and otherwise the application “suggests” a value. See the picture below.

Camera: ] Y5 Camera

MAC Address: |  00-50-C2-7A-80-0B

IP Address; | 169 . 254 . 81 . 201 |
SubnetMask: | 255 . 255 . 255 . 0 |

Cameta Command Port: 1028

[ Test IP Address ]

[ O H Cancel I

The user may edit and test the camera IP address and subnet mask. By pressing the
“Test IP address” button the user sends a PING command to the specified address and
checks if it is available.

2. Click the “Automatically assign IP addresses...” button. The utility runs a procedure that
automatically sets an IP address to all the enumerated Giga-Ethernet cameras.

3. Reset DHCP Table: the values of the IP addresses are stored in a table that may be
reset.

Sometimes a camera is not enumerated and the IP address cannot be configured. If the user
knows the camera’s MAC address (see glossary), he can try to set the camera IP address by
clicking the “Find X Camera..."” button.
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Find MotionPro X Camera EIEI

Enter the camera MAC address in the format
"00-00-00-00-00-00", the camera IP address
and then click OK {MotionPro ¥ only).

MAC Address: | 00-01-1C-00-08-FC |

IP Addvess: | 192 . 168 . 32 . 254 |

[ Test IP Address ]

[ 0K H Cancel ]

The user sets the camera MAC address and the desired IP address. Then he clicks OK. If the
configuration is successful the camera will be listed in the Network Configuration list.
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6. Motion Studio™ stand-alone program

This application allows the user to acquire, save/play-back image records, and control the
camera in Single or Double Exposure modes. It also allows the user to retrieve file images
from previous acquisitions for display and further manipulation. Upon execution the user can
select to use the application to open a file images or to open a camera window.

6.1. Open camera Wizard

Main Menu

Motion Studio

Images You may open a sequence of image files and apply
presel and user-defined filters as well as logic,
geometric, morphological, and LUT operations.

Cameras You may open a camera session, acquire images
and save them to the hard disk. You may also apply
filters and other operations to real time data.

DB viewer You may browse your images folder, enumerate
the cameras and devices, preview the images
sequences and open them.

Options  You may open the options dialog box and configure
the general seltings. This option allows the user to
personalize the general behavior of the program.

[¥]:Shaow this dialog boyx at starbup;

A discussion of the program interface as it applies to the live camera window is provided first.
Once the camera option is selected from the first menu the Camera Wizard is displayed. This
wizard allows the user to select which camera to control and access if more than one camera
is attached to the computer system. For each camera, the attribute ‘monochrome’ or ‘color’ is
displayed.
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Open Cameras

Motion Studio

Select the cameras from the list below:

Cameta Madel Plus Serial Type  Link
€8 Y5 ENG Camera 1 MokionPro ¥S No 20-1109-0001  color USE 2.0
BB S EMG Camera 2 MationPro ¥S Mo 20-1109-0002  color Gigakit

< | &

[ Refresh Lisk ] [ Find ¥ Camera... ] [ Edit camera name:... ] [ Edit IP Address. .. ]

[ Automatically assign IP Addresses... J l Enum Fileer. .. ] l Activation Key... ]

Interface: ‘ Expert v |

[ Activate Camera List, [ ] configure the cameras with the same parameters,

L Cpen ;I[ Cancel ]

|:| Reset camera canfiguration,

Refresh List
Click this button to restart the cameras detection procedure.

Find X camera
See the previous topic about the configuration of Giga-Ethernet cameras.

Edit camera name

Each camera has a name. If the camera has flash memory, the name is stored into it.
Cameras without flash memory have the name stored in a configuration file in the hard disk.
To change camera name, click the “Edit name...” button.

Serial Mumber:

-5_ [ 2304070244

Camera Name:
\ Cam_2304070244 \

l Ok l[ Cancel ]

Edit IP Address
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Click the “Edit IP address” button and manually assign an IP address to the camera.

Camera: | cam_t310060082
MAC Address: | 00-11-1C-00-05-63
IP Address: | 192 . 168 . 3 . [ |

Subnet Mask: ‘ 25 . 255 . z55 . 0 ‘

[ Test IP Address ]

[ OK ][ Cancel ]

The user may edit and test the camera IP address and subnet mask (disabled for X
cameras). By pressing the “Test IP address” button the user sends a PING command to the
specified address and checks if it is available

Enumeration filter

The user can select which camera type is enumerated and listed in the camera wizard
window.

1. Click the “Enum Filter...” button.
2. Check or uncheck the camera models.
3. Click OK.

Camera Enumeration Filter E|®

Check the camera types you wish to detect, uncheck
the others:

MakionPro X on USB 2,0,
MaotionPrao % on Giga-Ethernet,

MotionPro ¥ on USB 2.0.
MotionPro ¥ on Giga-Ethernet,
MaotionXtra M on Giga-Ethernet,

MotionScope M on Camera Link.,

Maotion¥tra HG on Giga-Ethernet,
MaotionXtra Legacy on Giga-Ethernet,

| ok |[ Cancel ]
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Camera interface

Before opening camera windows the user may select the interface.

e Standard: a limited set of controls are displayed in a vertical bar on the right side of the
camera window.

+ Digital Cinema: a limited set of controls for recording and a full set of controls for image
processing.

e Expert: all the camera controls are displayed.

Activation Key

Some cameras have time limited license. If the license has expired and you have a 16 digit
activation key, click the button and enter the key.

Activate Camera List

If more than one camera is going to be used, the camera list interface may be activated. For
a more detailed description of camera list mode, see the “Multiple Camera Support” topic.

Plus Mode

The plus option can be activated on each camera independently. Just click on the Plus cell in
the camera list and select Yes or No. The option is disabled if the camera does not support it.
In Plus™ mode, the camera is capable of acquiring images at double speed and with double
memory space. See below.

Select the cameras from the list below:

Camera Model Plus Type Link.
BB ¥4 Camera MokionPro Y4 ‘Mo | color 1USE 2.0

Mo

Reset camera configuration

If this option is selected, the configuration stored in the camera is reset and the camera is
opened with default settings.
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Once the Wizard competes the initialization procedure for the camera the application window
for the active camera is open as shown below (expert interface).

™ Motion Studio - [Y5 Camera 2 (Y5 - USB 2,0)] =13
0 Fle Edt Imege Flber Camera Data Wiew Tools Window Help - & X%

Rec Stop-Snap Live Tig AR
Acquisition Settings
Camera  Record Image
Sensor Gan (-3dB % |_Aeset
FaelH  [100

Exposure [usk 3537 ' @

Exposure Mode: Sl-rlj; : v

(] Enable Auto-exposure.

Binning: Piial Depthc
LI T TS

|no:  [oozEzara | (2]

¥:1520 Y:0730  (ER PixelF
a

Along with the usual top bar menu structure the application also includes a docked dialog bar
on the right side and a pan tool. In this menu the main operational controls of the camera are
grouped by function: Camera Control (Live and Playback), Acquisition Settings (Camera,
record and Color). The function of these controls is in great part also accessible from the top
menu bar.
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6.2. Motion Studio Menu structure

The main menu bar contains the following options:

File

Edit

Image

Filter

Camera

Playback

Tracking

View

Tools

Window

Help

The application also includes a docked dialog bar on the right side. The Docked Dialog Bar
has the main operational controls of the camera and they are grouped by function: Camera

Configuration, Image Recording Configuration, Color Configuration (for color cameras only)
and Playback controls for acquired images.
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6.3. FILE Menu

The file menu contains the following options:

e Open previously acquired and filed images.

e Open the camera window.

¢ Open the database viewer window.

e Save images on the hard disk and close windows

e Select from a list of the five most recently displayed images.

6.3.1. Initialize a camera window

From the main menu select File > Open > Camera.

6.3.2. Open File Images

From the main menu select File > Open > Images.

FEN view Tools Help

| Open = Images...

1 Irngds.avi h Cameras...

2 C:\Program Files),. \Imaé.tif | Database Viewer...
3 C:\Program Files)...}\ImgA.kf

4 C:\Program Files)...\ImgA.kf
5 Z:\Program Filesy...\Imagd. kif

Exit
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6.4. Save images

Each acquired sequence may be opened and saved in a different format.

1. From the File menu select File >> Save
2. Select one of the options below:
e Create a new acquisition folder.

e Simply save the images.

6.4.1. Create a new acquisition folder

The program will create a new acquisition folder in the current database and save the images
and the acquisition settings. For further information about the parameters please refer to the

paragraph 5.20 (Saving acquired images and data).

Save Images As...

Acquisition Folder ‘Acq_A ‘

Image Prefix ‘Img& ‘
Comment ‘Erief description of image acquisition ‘
File Type ‘ Compressed AV [*.avi) v ‘ [ Codec... ]

Output Pixel Depth Rate [fpz]

[] Reset Frames Mumbering.

Frorn Frame |-100 ToFrame |+100 Step D

ROl |(0.0)1280x1024 | Edt.

Data Acq File Type ‘ Excel XML Spreadsheet D ata File (*.xml] ‘

Save

l[ Cancel ]

Select start index, stop index and step.

U R

Edit button.
6. Select the Data Acquisition File Type, if present.

Users Manual

Enter the folder name, the image prefix and the comment (optional).
Select the file type and the rate. If the file is compressed AVI, select the codec.

Select the Reset Frames Numbering option to change the start frame index to 0.

Also a subset of the sequence can be saved. Select a region of interest by pressing the
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6.4.2. Save the images only

This option saves the images, but not the acquisition settings.
1. Select the desired folder.

2. Type the image name, the image format and the sequence rate. If the file type is
compressed AVI, select the codec.

3. Also a subset of the sequence can be saved. Select a region of interest by pressing the
Edit button.

4. Select the Reset Frames Numbering option to change the start frame index to positive or
change the Image Step.

?X

Save Image Files Sequence

Saveir: | 3 Color - Fish "" (€ ¥ £° [
r |2 Trackoon
{ Ea [H Imga.avi
My Fecent
Documents
=
|
Desklop
My Documents
by Computer
g File name: Imga, i ‘ | Save |
My Network  Save as bype: Compressed &Y Files [* avi) v | [ Cancel l
Pivel Depth: 24Bit v | Rate[Hz} 500 | [ Codec... ]
Fram Frame: -100 To Frame: |99 | Step: |1
[[] Reset Frames Humbering.
ROL: [0.0) 1280:1024 | | Edit... I
DatadeqFile: | ASCH Data Fie (*.asc) v|
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6.4.3. AVI Codec/JPEG quality selection
The default codec used in Motion Studio to save compressed AVI files is “Indeo™ Ver. 5.11".
If the codec is not installed on the computer the software automatically asks the user to select
a new default codec.

The default codec can be changed each time a new sequence of images is saved in
compressed AVI format.

Video Compression @@

Compressor:

‘ Indeo® viden 5,11 ™ ‘
Compression guality: T

i L] 1 1 ] ] 1 i J 1 1 i
0 S0 100

[ ok |[ Cancel ]

e« Select the codec from the list.
e Select the compression quality with the slider (0 to 100).

Also, JPEG compression quality may be selected in the same dialog box. The default is 100.
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6.5. Database viewer

The database viewer window browses the current Images folder and enumerates the
acquisition folders. It shows also the cameras and devices connected to the computer
(Timing Hub/Data Acquisition).

The window has three panes.

B Database Viewer - [DB:/hg100_001]

(= W& My Computer # | Description Yalue
B Cam_2305060058 (X3) Irmages 300
D Y3 Camera 33 (¥3) Type fudio Video Interlsaved (AV) File
=-| | Databass Width 1504
& uh 1 Height 1128
Hh 6 Pixel Depth “
[#\ (b Back + Front 7

& ballonpop 10000-6%s

Bat

Color - Fish

COLORy

Copy of RotorzHz_20msTrig_1kfps
Copy of Rotor2Hz_20msTrig_exp200_3_1kf
Foot

Froa

Gun

hgloo_0oo

hgl0o_o01

g Irngd, avi

‘b Trackioo

hgloo_ooz

hploa_no3

hgl00_004

hplod_nos

() haldo_oos

-y 15001

@i Lockhead Test

[# (1 LogoTest

(v Mono - Fan

#  (+ Mono - MouseTrap v

s Acquired Images Preview
==}
]
[#
@
[E3]
=]
]

[H

- -§

*
G666

Left Pane: the left pane is a tree view and displays the tree structure of the images database.
It shows also the detected cameras and devices, such as timing hubs and data acquisition
modules.

Right Upper Pane: it's a list view and it shows the main parameters of the selected item. If
the item is a device it shows the device ID, serial number, etc. If the item is an acquisition it
shows all the acquisition parameters.

Right Lower Pane: the pane is used to preview the first frame of a sequence or the data
acquired with the data acquisition module.

56 Users Manual



Motion Studio

6.5.1. The viewer Toolbar

New Database

The selection of this item opens the 'Create New database' dialog box. The user may browse the
existing directories in the hard disk or create a new directory. If the OK button is pressed the root
database files are copied in the new directory and the user can start saving new sequences in the
new folder.

Open Database

Browse the directories in the hard disk and locate a database folder. The program recognizes as
valid database locations the directories where the file xvdb.mdb is found. Changes to the
currently selected database are reflected on the settings.

Refresh
Click this button to refresh the viewer contents.
Open ltem

Click this button to open the currently selected item. The button is enabled if the selected item is
a sequence or a camera.

Edit ltem

Click this button to edit the currently selected item. The button is enabled if the selected item is an
acquisition folder. The user may change the folder name, date, time and acquisition comment.

Delete Item

Click this button to delete the currently selected item. The button is enabled if the selected item is
an acquisition folder.

iPod Synchronization

If your iPod is connected to the computer, Motion Studio can detect it and allow you to transfer
your acquired sequences. You may transfer the sequences from iPod to the current database and
vice versa. You may also eject the iPod.

Users Manual 57



Motion Studio

6.6. EDIT menu

The Edit menu contains UNDO and REDO for image operations. It also has a “Go To...”

function for jumping to a particular frame in a sequence.

<[ Image Filker Playback Tracking

) Undo Sobel Filker e -
5 >

Redo sharpen Image

Go Ta... Chrl+G

58
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6.7. IMAGE menu

The Image menu contains the LUT operations. It also allows flipping and rotating of the
image. If the Camera window is open and the Thumbnails bar is in use, the “Thumbnails
Cfg...” option displays for Thumbnail view configuration options. For more information, refer to
“View Thumbnails”.

Filter Playback Tracking Data VYiew Tools ‘Window Help

‘ adjust .= Color Map...
Lookup Table »| 528 Invert

AL Orientation,.. Remove background...

Info...

If an image sequence is open, the Image menu has an Image Info option for displaying and
editing the acquisition settings. The Adjust sub menu has controls for the following:

e Color Map for colorizing monochrome images
¢ Inverting.

e Background removing for monochrome images.

Filter Playback Tracking Data ‘iew
Adjust ey I=licr

Exponential...

‘ Lookup Table | Linear...
4\ Orientation... | | Equalize...
Info || Logarithmic, ..
L
!

Gate. ..

The Lookup Table submenu has controls for the following LUT transformations: linear,
equalize, logarithmic, exponential and gate. For further information on Lookup Tables,
please refer to the appendix.

NOTE: Brightness and Contrast, Gamma, LUT, Invert and Histogram Equalize are intensity
operations. Any intensity operation can be applied to the image only once. If the user applies a LUT to
the current image and then selects “brightness and contrast’, the preview window will show the original
image without any LUT modification, and so on.
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6.8. Image Info

The main acquisition parameters may be displayed and edited.

1. Select Image from the main toolbar.

2. Select Info from the drop-down menu.

3. Edit the parameters.

4. Click OK to change the parameters on the acquisition.

60

Rate [fps]:

Sensor Gain:

Record Mode:

Sync In Cfag:

Camera Model;

Exposure [ps]:

Trigger In CFg:

MotionPro 3 v|

1000

‘Nu Gain V‘

‘Internal V‘

‘Edge-High v‘
I Ok ] [ Cancel I
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6.9. Color Map Adjustment for monochrome images

The Color Map has controls for displaying black and white images in color using a pre-
loaded, user-defined color scheme.

Select Image from the main toolbar.

Select Adjust from the Image drop-down list.

Select Color Map.

Select Base Color Map from the drop-down list.

Change the RGB values and Point Index.

I -

Click OK to change the image.

Color Map E|El

Base Color Map: ‘ Small Rainbow

Paint Index:

Contral Point RGE Settings:

Red . o
0 255

Green 0
0 285

Blue J [25
0 205

[ Rediztribute Contral Paints ] [ Reset I

[_ 0K ][ Cancel H Apply ]
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6.10. Sharpen, gamma, brightness, contrast, hue, saturation

Some image adjustment controls have been added to the image vertical bar. The parameters
improve the image quality.

Dynamic Noise Reduction: it reduces temporal noise on images. The range is from 0 to 30.
The default value is 5.

Sharpen: it sharpens the image edges. The range is from 0.0 to 1.0. the default value is 0.0.

Gamma: introduces a gamma correction to the image. The range is from 0.1 to 4.0. The
default value is 1.0,

Brightness: it increases or decreases the image brightness. The range is from -0.25 to 0.25.
The default value is 0.0,

Contrast: it increases or decreases the image contrast. The range is from 0.5 to 1.5. The
default value is 1.0.

Hue (color images only): it modifies the image hue. The range is from -180 to 180. The
default value is 0.

Saturation (color images only): it modifies the color saturation. The range is from 0.0 to 2.0.
The default value is 1.0.

Playback | Image Tracking
C[@] (e ](n]m]

0 (1710)
0.000000 s

O ———

Stark: Stop: Skip frns:

o |l o 3|[cot.]
Dynamic NR: El
Sharpen: —]_ W
Gamma: —
Brightness:  —  J
Contrast: — U [1.00
Hue: = U0 El
Saturation;  — U0
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6.11. Remove background
This tool is very useful to remove temporal noise background from images taken with the X4
camera. It requires a very dark and uniform background.
1. Select Image from the main toolbar.
2. Select Adjust from the Image drop-down list.
3. Select one of the options.

e Subtract minimum value: on each row the minimum value will be subtracted.

e Subtract value on column: on each row the value on a specific column will be
subtracted.

4. Use the Zoom drop-down list to inspect the image details.

Temporal Noise Reduction E]@

() Subtract minimum value,

(*) Subtract value on column, |17

0 439
Profile

Zoom Fit ko window,

0k I[ Carcel ]
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6.12. FILTER menu

The filter menu has several preset filters as well as user defined filters. The filter menu for
Windows differs from the Mac filter menu. The Windows version offers two additional Effect
filters Uniform Noise and Gaussian Noise. A preview window with an image thumbnail is
available and includes the filter kernel display box.

Ay Windows

a From the main toolbar select Filter > the desired filter submenu from the following:

e Sharpening filters: Laplacian, Prewitt and Sobel.
« Smoothing filters: Average, Gaussian, Smooth, and Median.

o Effect filters: Minimum, Maximum, Uniform Noise, Gaussian Noise, Erode, Dilate, Open,
Close.

3= Playback Tracking Data Wiew T
sharpening » |mm (07 [oeor

| Smoothing 7, Average...
Effects k| T, Gaussian...
User » Ty Blr..
Iy Median...

. MAC
ﬂ From the main toolbar select Filter > the desired filter submenu from the following:

e Sharpening filters: Laplacian, Prewitt and Sobel.
« Smoothing filters: Average, Gaussian, Smooth, and Median.

o Effect filters: Minimum, Maximum, Erode, Dilate, Open, Close.

Playback View Tools Window

File Edit Image

Sharpening
Smoothing
Effects

User
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Average Filter @@

Zaom
Fit to window.
Size = v

Filter Kernel Display
ofi|z[sf4]s]
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6.13. Create a User-defined filter

The User filter utility has the flexibility to apply a custom filter and save the kernel for future
use. The filter kernel size, anchor point and image divisor are custom configurable.

Once a custom filter has been created and saved, the user-defined filter is added to the Filter
drop-down list.

1. Select Filter from the main toolbar.
2. Select User from the drop-down list.

Edit User Filters

Create pour own filker kernel by editing the matrix, then press the 'Save As...' button to add the
filter to the list. Once the filter is in the list, you may select it from the FiltershUser' sub-menu.
Press the 'Save' button to save any modification or 'Delete’ to remove it from the list.

Filter: | Average 545 v‘ l Mew... ][ Delete ] [ Save ] [SaveAs,,,]
ol1lz13lalslel7ls Farameters
g T s O s ) s Columns: El
11212 Rows B
- ol Anchar Point &
i i 1 1 i Anchor Point :

Divisor:

Preview...

WO |~d|on|n|de|W|MN|= |

Click aver the filker coefficient you want ta edit.
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6.14. CAMERA Menu

The Camera Menu on the main toolbar offers an alternative to using the buttons and dialog
box provided by the Docked Dialog menu including the following functions:
Record

Stop

Play

Playback

Select previous and next acquisition settings.

Start and Stop the remote connection server (see chapter 7).

Edit Region of Interest (ROI).

Edit Video Options.

Show and Hide the HDMI Pad (new designed Y cameras only).

adll ol Ul

Tracking Data MWiew Tools

) PRecord

. Stop

»  FElay
Trioger

E‘Iayl;ack r |
Previous Acquisition
Mext Acquisition

u]| Edit ROL..

| Wideo Options...

MW HOMI Pad

Skart Remote Conneckion Server

Adwvanced r
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6.15. Camera Control - Live

The Camera Control Tab at the top of the Docked Dialog menu has camera control functions
including the following:

Record.

Live play of images (continuous).
Trigger.

Attach.

Stop.

o Rl

Live | Plagback | Tracking

PIEIMY

: Fec Stop-Snap Live Trg Al
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6.16. Camera Configuration

Expert Interface

Use the Camera Tab on the Docked Dialog menu at the right of the image to configure the
camera. The configuration options are as follows:

[ Camera Sensor Gain
LHacord| Image Use the sensor gain drop-down list to select a Gain
SR G \ e | [ Reset ] value ranging from “-3 dB” to “+6 dB” (“-6 dB” to “+3
dB” for X4, and “-3 dB” to “+3 dB” for Y5).
Rate[Hzp  [1000 v .
Reset
Exposure [ps]: |99? ‘ -E Click the Reset button if a Device 10 Control error

message appears. The Reset button restores the
camera from the error condition.

Enable Auto-exposure. | Rate

Exposure Mode: Single v ‘

Dynamic Hange Use the Rate drop-down list to select a new Frame
B Bit Rate value. If the current exposure is too large for
Binring: Pixel Depth: !he selected rate, the program automatically adjusts
\1;:1 v‘ ‘24 Bitlupel W | it to an acceptable value.
Low Light mode
ROl (00128041024 | . Click the button to set the rate to 25 Hz and the

exposure to four times the current value. If the
button is clicked twice or an acquisition is started the
&b beq B BIE original values of exposure and rate are restored.
. The option is useful for preview in low light
conditions.

Exposure
Use the f-stop buttons to select a new exposure

value. The value is in microseconds.

Exposure Mode
Use the drop-down list to select either Single, Double or XDR exposure mode (for XDR see
the appendix).

Auto-Exposure
Select this option to activate the automatic exposure adjustment.

XDR contrast
Use the slider to select the contrast in XDR mode (see the appendix).

Dynamic range
It shows the image dynamic range in XDR mode. If the image pixel depth is 8, the range may
be 9, 10, or 11 bits. If the pixel depth is 10 bit, the range may be 11, 12, or 13 bits.

Binning

Use the Binning drop-down list to select a new value from 1x1 to 4x4. Pixels may be grouped
to form a larger pixel, which results in added SNR and sensitivity. When this parameter is
changed, the Region of Interest (ROI) is reset. The control is disabled when the camera is in
live mode.

Pixel Depth
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Use the Pixel Depth drop-down list to select from the following options: 8-bit (Gray 8) or 10-bit
(Gray 16) for monochrome cameras, or 24 bit (RGB) for color cameras.

ROI
Click on the ROI button to open the ROI dialog, and change the current settings. For more
information, see “Set a Region of Interest (ROI)".

Live Time Out
If the camera cannot snap a frame during live mode, a time out may occur. Type a new value
into the text box to change the duration of the time out. The value is displayed in seconds.

Compression

In N camera models the frames are stored in compressed format. The compression rate can
be configured. The values are from 0 (uncompressed) to 100 (fully compressed). The size of
a fully compressed frame is about 40% of the original size.

Standard Interface

If the Standard interface is selected, only a subset of the controls is shown in the camera
Tab (see below).

Camera i

Sensor Gain: ‘-3 dB v‘ [ Reset ]
Rate [Hz]:
Exposure [ps] | 1000

Fixel Depth: ‘24 Bit [upper] V‘
Compression. — ) | EO

Record Mode:

Frames: 1000 | |2000s |

Trigger Adjust
Fre-Trigger Post-Trigger
0(0000s) | 1000(2.000s) |
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Digital Cinema interface

If the digital cinema interface is selected, a subset of camera controls and image processing
controls are shown in the camera Tab.

Camera ‘

Sensor Gain: |-3 dB VH Feset ]

Rate [Hz]:
Exposure [ps]

Fixel Depth: l 24 Bit (upper] v ‘

Compression. ]
Record Mode:
Frames: |98 | |0.980000s |
Trigger Adjust

Pre-Trigger Post-Trigger
‘D (0.000 5] ‘ 98 (0.980 s) ‘

Apply! [Heset”

Sharpen: J

—y
=

Gamma: =t
Brightness: J
Contrast: ' J - [1.00

Hue: ' J
Saturation: ' J

=7
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6.16.1. Auto-exposure
When this option is selected, the camera automatically adjusts the exposure to match a
specified average luminance value. The camera reacts to any change of external light
intensity by changing the current exposure value.

1. With the auto-exposure disabled, click the “Set” button on the camera bar to set the
reference luminance value.

2. Enable the auto-exposure.

3. Click the “Edit...” button and change the parameters below.

Edit auto-exposure

GretagMacbeth™ ColorChecker Color Rendition Chart

ROl Speed
X | i |255 ‘ | Center | Iy
Wwidh (1280 || Height 512 | [ Feset | gl e

I oK I[ Cancel ]

ROI: the statistics region of interest. It's the area of the image where the average intensity is
computed and compared to the reference value to compute the new value of exposure.

Speed: the reaction speed to changes of image intensity. The larger is this parameter, the
faster the camera corrects the exposure.
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6.16.2. Set a Region of Interest (ROI)

The MotionPro camera system has a Partial Windowing capability that can be selected and
set via the software interface. Using this setting a region of interest for the image that is less
than the total available area of the sensor may be selected. This region can be interactively
adjusted and can occupy any area of the sensor’s active pixels.

1. Click on the ROI button on the Camera Configuration Tab.

2. From the Edit Region of Interest dialog box, select the ROl by setting the numerical
values for its origin and dimensions or by dragging the handles of the red box that
highlights the ROI within the sensor area.

Once the ROI is configured only the active portion of the image is acquired and displayed. It
is important to note that the maximum framing rate of the camera is inversely proportional to
the number of rows in the ROI.

Region of Interest options:

Resolution: select a resolution from the drop-down list or select User and edit the values in
the X Origin, Y Origin, and Width and Height text boxes.

Center ROI: click the button to center the current ROI.
Reset ROI: click the button to reset to the maximum value.
Max Rate: displays the maximum acquisition rate for each ROI.

After the ROI is set, the selected region will appear in the main viewing window. To resize the
image to the screen area, select the Fit to Window from the main toolbar.

Edit Region of Interest

Resahition | v [ Center ROI | [ Reset ROI I

XOrgn (315 | [ Y0nign [159 MaxWwidth  [1280
widh (462 | [ Heigt [459 | [ MaxHeight [1024
MaxRate [1384fps
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6.16.3. Edit video options

74

Video Output

This option enables or disables video output in X, Y and MotionXtra Legacy cameras.

Y cameras: the video output modes are listed below:

PC only: images are sent to the computer via GE or USB, no HDMI output is produced.

PC and HDMI: any time an image is sent to the computer (playback or live) the same
image is sent also to the HDMI output. The live/playback speed is reduced because a
double output is done.

HDMI only: any time an image is read from the camera, the image is sent to the HDMI
output. No images are sent to the computer. Live/Playback speed is increased because
the images are not sent to the computer via USB or GE.

Independent HDMI: computer and HDMI operations are independent. The user can do
live on the computer and playback on HDMI or vice versa autonomously. Live/Playback
speeds are independent. This option is active on new design Y cameras only.

Video Format
X and MotionXtra legacy: select NTSC or PAL format.
Y cameras: select two HDMI formats (1280x720p, 1920x1080p or extended 1280x720p)

Preview Mode

Y cameras: select full resolution or decimated (on the computer).

Camera Video options m@

Yideo Output; PC and HDMI &
Video Format: 1260x720p %

PC Preview Mode: | Ful resolution % |

I ok |[ Cancel ]
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6.16.4. HDMI Pad

New design Y cameras support an “Independent HDMI” video output mode. In that fashion,
the HDMI output is independent from the computer output. The HDMI output is controlled via

the HDMI pad.
From camera menu, select HDMI Pad.

HDMI Pad (%)

Video oukput:
‘ Independent HOML ~ » ‘

Ll a ]

KEN D
(W )
 -47 (4f100)
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6.17. Record Configuration

The record configuration Tab may have two layouts according to the camera type: cameras
with 2 BNC connectors and cameras with 3 BNC connectors.

X-Stream XS-3 cameras with 2 BNC connectors have a single sync/trigger input and a
single sync output. The input may be used to provide a pulse train for sync or a single pulse
for triggering in circular mode.

Other Cameras with 3 BNC connectors have one input for the sync signal, one input for the
event trigger, and one output for the sync output. The “trigger in” signal may be configured to
accept IRIG signals.

Use the Record tab on the Docked Dialog box at the right of the image to set the record
options.

6.17.1. Record Configuration (3 BNC cameras)

76

= “Record LEol Record mode
e Lo, ] Use the drop-down list and select one of the

Record Mode: Circular v ] | following options:

e Normal: the camera acquires and stops when the

Frames: |10 JELLIE | memory segment is filled.
| BROC Length: | ! ¢ Circular. the camera acquires and restarts when
P e — the memory segment is filled. The camera waits for
Frame Sync: [""temd "! . an event trigger to complete the acquisition.

| o« BROC (Burst Record on Command): the memory

: segment is divided into sub-segments; the camera
Trigger Cfg: | Edge-High v‘ acquires in circular mode in a sub segment. When
the event trigger is issued, the camera completes

|
T Atk [ Advanced... || the acquisition and start acquiring in the following

Sync Clg:

T =1 sub-segment until the memory segment is filled.
Pre-Trigger Post-Trigger Frames
||:|[|1|J|:|u s | [o@zooos) || In the text box edit the number of frames to be

: — | recorded to the camera memory in a single

Aeq B ©||= acquisition. The values can be set from 1 up to a
, maximum number depending on the amount of free
memory and the number of rows on each frame.
Select the number of rows on each frame with the
ROI setting.

BROC Length

If BROC mode is selected, use the text box to type the number of frames of each sub-
segment. If the number of frames is 1000 and the BROC length is 100, the camera will
acquire 10 sub-segments.
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Frame Sync / Sync Cfg

Sync Configuration and Event Trigger configuration are separated. Synchronize the camera
with a pulse train and simultaneously issue an event trigger from the “Trigger In” BNC
connector. Use the drop-down list to select Internal or External synchronization source. If the
“Frame Sync” is external, use the “Sync Cfg” drop-down list to select one of the following
options: edge-high, edge-low, pulse-high, and pulse-low.

IRIG Frame Sync

Some Y cameras have the IRIG option, which can be activated from the Frame Sync drop-
down menu. When the option is selected, the camera sync source is internal, but it is phase
locked with the GPS signal (1 Hz frequency). Also, the camera detects the IRIG time stamp
and the software displays it (See Options).

Trigger Cfg

In Circular or BROC mode, select from the following event triggers options:
+ Edge High

+ Edge Low

+» Switch Closure

Trigger Adjust

When the record mode is set to Circular or BROC, the Trigger Adjust controls are active. In
this mode the camera acquires the set number of frames before the trigger event (pre-trigger)
and the remaining after (post-trigger) the trigger event. Use the slider to adjust the number of
pre- and post-trigger frames.

Advanced Sync/Trigger Configuration
Use the Advanced... button to open the Trigger, Sync In and Sync Out configuration dialog.

Acquisitions Configuration
Use the Wheel Icon button to open the Advanced Acquisitions Configuration dialog.

Select Acquisition
Use the arrow buttons to select the previous or next acquisition.

Memory Indicator Bar
The colored bar depicts the available memory.
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6.17.2.

78

[:ame[al Record |

Record Made: Circular v

Record Configuration (2 BNC X-Stream XS-3 cameras)

Color |

Frames: (500 | |0500000s |
BROC Lerght [ ]
Sync/Trigger: Internal ~
Sync/Trig Cfg:

Trigger Adjust

Pre-Trigger Post-Trigger

147[0.2945) |

353(0.7065) |

b Acquis000

*|o]

Sync/Trigger and Sync/Trig Cfg

The external synchronization and the event trigger
have a single input and cannot be issued in the
same time. The Sync/Trigger parameter controls the
source of synchronization. If the source is external,
the input may be configured (edge or pulse). If the
mode is normal, the parameters control the sync, if
the mode is circular or BROC they control the event
trigger.

Users Manual



Motion Studio

6.17.3. Advanced Sync/Trigger Configuration (Y/N and HG cameras)

Trigger In

The Y camera can enforce a minimum time that the trigger input must remain continuously at
its active level before it recognizes a valid trigger. This parameter is called “Debounce” and
can be used to reject noise pulses on the trigger input, or to debounce mechanical contacts
used as trigger sources.

After it recognizes a valid trigger pulse, the camera can wait for a few microseconds before
issuing the trigger. This parameter is called “Delay”.

Sync In

The “Debounce” and “Delay” parameters can be applied to the sync in source as well (see
above). If an external sync source is connected to the camera, the software is able to detect
the rate and the pulse width of the signal. If the user sets the frame sync parameter to
external and no signal is active on the sync In, the program displays a warning message.

Sync Out
The sync out mode can be configured:

+ Default: the sync out signal follows the sync in (internal or external). The signal width is
the exposure time.

+ Inverted Default: the signal follows the sync in as in the default, but it's inverted.
+ Configurable Width: the user can define the width of the sync out signal.
+ Inverted Configurable Width: like in the option above, but inverted.

+ Disabled: the sync out signal is disabled.

A “Delay” can also be added to the Sync Out signal.

Alignment: when the auto-exposure option is selected the exposure is done at the end of the
acquisition period. Then the period and exposure are not aligned. The alignment option is
used to decide whether the sync out will be aligned to the period or to the exposure.

Marker

If this option is enabled, the user can send to the camera a pulse that gets recorded in one
frame. The recorded pulse is a marker in the frame and lets the user know that something
happened at that time. The marker is shown in the frame if the “Marker” Time stamp option is
selected.

The pulse can be sent through the “Sync In” connector or the “Trigger In” connector.
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Advanced Sync/Trigger Configuration ]EHE

Trigger In
Debounce [ps]: Delay [ps]:

Sync In

Debounce [ps]: Delay [ps]:

Frequency [Hz]: Pulse ‘Wid [ps]:

‘ Ext Svnc ‘ 0 ‘ ‘ 0 ‘
Sync Quk

Mode: ‘Default v ’
Alignment: ‘Align to the exposure w ‘
Width [ps]: Delay [us]:
Marker

Mode: ‘ Disabled v ‘

[ Ok ][ Canicel ]
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6.17.4. Advanced Acquisitions Configuration

Image Folder

Browse to the directory of selections for saving acquired images. This is the parent directory
for the saved images. Each time the images are recorded a new sub-directory containing the
actual image files is created.

Download images after acquisition and stop

Check this box to automatically save the data to the computer's hard disk after each
acquisition.

Download images after acquisition and restart... times

Check this box to automatically restart the process of saving data to the computer’s hard disk
after each acquisition. Use the corresponding text box to type in the number of times to
repeat the process.

Post-recording operation

After the acquisition, the camera can automatically download the images to the IRIG-Flash
device. For further information about the device please refer to the appendix.

Overwrite existing folder

If this option is unchecked, any time an acquisition is done, the program checks if the folder is
already present and, if yes, it generates a new folder names with decimal digits. Example: if
the folder name is A, the program checks if A is present. If yes, it generates A_000, then
A_001 and so on.

If the parameter is checked we have two options:

1. The “Download images after acquisition and restart” option is unchecked. In this case the
program saves the images in the same folder all the time. Example: the folder name is A.
then the program creates the folder A the first time and saves the images. If subsequent
acquisitions are done, the program saves the images in the same A folder and overwrites
them.

2. The "Download images after acquisition and restart” option is checked. In this case the
program creates folder names from the acquisition name with 7 digits. Example: the
acquisition name is A, then the program creates A_0000000, then A_0000001, then
A_0000002 and so on.

Acquisition Folder name

The first acquisition directory name defaults to Acquis000. Subsequent acquisitions are
stored in sequentially numbered directories, (ex. Acquis000, Acquis001, Acquis002...).

Image Prefix

Type the image prefix into the text box.

Comment

Type a comment to the acquisition.

Frames

Use this dialog box to set the number of frames to record.
Time

It displays the acquisition record time.

File Type
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Use the drop-down list to set the image type format for archiving files to the hard drive of the

computer.

Memory Size Display

The dialog box displays the total memory size in GB and MB. XS-3 models acquire 10 bit
images and the pixels are stored in the camera memory in a packed format. Ten pixels are
stored in 16 bytes of data, so the size of a frame in full resolution is 2 MB.

New

Create new acquisition folders to store a new sequence of images using the. Configure all of
the parameters independently for each folder.

Defrag...

Click on the Defrag... button to re-organize the camera memory using the defrag utility.

Delete and Delete All
Delete a selected folder or all folders.

82

Advanced Acquisitions Configuration

Images Folder
‘ C:AProgram FileshDT4MotionPraiiImages2y ‘ | Browse... |

Suto download
[[] Download images after acquisition and stop.
[] Download images after acquisition and restart

)

times.

Post recording operation: ‘ Download to IRIG-Flash module. v ‘

‘wiite Ta Disk

Ernakla
[ SRR [ 8] e

Acq A |

[[] Ovenwrite existing folders.

Folder ' Aocg A Irng Prefix

Comment ‘Generi-: image acquisition

Delete...

1 Pl
A

Delete All..
Frames | Time |1.600s Defrag...
File Type | Single TIFF File [~ v|

Camera Memory Map: Total Size = 7.59 GB (7776 MB)
Legend: Green = free memory - Fled = done acquisition - Blue = undone acquisition

[ 0K ][ Cancel ]
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6.17.5. Write To Disk Option

M cameras can activate the direct write to disk option.

Advanced Acquisitions Configuration

Images Folder
‘ C:\Program Files\D T M otionProxh mages2 ‘ Browse...

duto download
[] Download images after acquisition and stap.

[] Dowrload images after acquisition and restart I:l times.

i

Post recording operation: | Download to IRIG-Flazh module. v ‘
‘wiite To Disk

Memory Buffer Size [MB]. | 256 [ Edt. |
Disks: Folder: |M2Disk_écq | [ Delete Files.. |
Acq A |

[] Overwrite existing folders.

[ Comment ‘Generic image acquisition | Delete Al
Frames 800 Time 1.600 s | Detrag |

File Type | Single TIFF File (*tif v

Camera Memory Map: Total Size = 33.93 GB (34747 MB)
Legend: Green = free memary - Red = done acquisition - Blue = undone acquisition

[ DK ] [ Cancel]

Enable “Write To Disk”
The option is active if the camera is an M-series and the computer has a license file.

Delete Files
Click this button to delete the files stored in the acquisition folder.

Edit

Click this button to change the write to disk settings.
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Write To Disk

Disks;
Disk Total Disk space  Free Disk space
D“‘-?'LDI:EH Disk (C:)  118.1GE 16,9 GB
D e 1P 32bit (E:) 97.7 GB 71.6GB
“ee\ista 32bit (F1)  117.2 GB 68.1 GB
WLocal Disk (G:) 132.5GB 33.9GB

Available free disk space For acquisition: ‘ 33.9 GB

Folder name: Memory Buffer Size [MBE]:
M2Disk_Acq \ 256
I 0K I l Cancel I
Memory Buffer Size

It indicates the amount of computer memory allocated for the acquisition. The camera
acquires images in this memory buffer and the data is automatically saved to the hard disk in

real time.

Disks
Select the disk drives used for the acquisition.

Folder

Type the name of the folder where the images will be stored.
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6.18. Load camera configuration

From File menu, select “Load camera Cfg...”

X

Load Camera Configuration

Marme: [ 5 cameras ‘
Comment: ‘ Configuration with 5 N4 ‘
Cameras:
Camera Serial ~
BB Camera 02-1209-0358
0 Camera 0z-1209-0380
B0 Camera 0z-1209-0361 a
€ Camera 02-1009-0347 v
Select Al Deselect Al
Configurations:
Marne Cornrnent ~
Configuration with 5 N4
é 6 cameras Configuration with 1 N3 and S
;ﬂ cfglz cam1, 2
é cfgl23 cameras 12 3 b
< | =
[ 0K ] [ Cancel ]

Select one of the available configurations and click OK. The camera settings stored in the
configuration will be loaded and any previous setting (included memory segment
configuration) will be overwritten.
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6.19. Save camera configuration

From File menu, select “Save camera Cfg...”

X

Save Camera Configuration

Mame: ‘ Test ‘
Comment: ‘ Configuration with 2 cameras ‘
Cameras:

Camera Serial

B Y6 Pedone 26-0208-0001

€0 4 Cam 4500 fps 19-0708-0020

[ Select Al ] [ Deselect Al

Configurations:

Marne Cornrnent ™

=| 5 cameras Configuration with 5 N4

é 6 cameras Configuration with 1 N3 and S

ﬁ cfglz cam1, 2

é cfgl23 cameras 12 3 b

b | | &

[ 0K ] [ Cancel ]

Select one of the available configurations or type a new name and comment. Then click OK.
The current camera configuration (included the memory segments for the acquisitions) will be

stored for future use.

In a multi-camera environment you can select the cameras from the list and save only the
configuration of the cameras that are selected.
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6.20. Saving acquired images and data

The acquired images stored in different areas of the camera memory can be saved to the
computer’s hard drive.

Click the Save button on the main toolbar or select File from the main toolbar > Save
Acquisitions...

The program displays a list of the acquisitions. For each acquisition the program displays the
following save options and acquisition file information.

Enable Fast Download and Convert

If this option is enabled, the camera downloads the images in a temporary file, and then a
new process is launched. The process converts the temporary file in the selected output
format and the user may start a new acquisition. After the fast download the conversion
process may be activated right away (Convert after download) or later (Convert later). The
conversion option is active only if the fast download item is selected.

Show the download progress in the Status Bar

During the download, the dialog box that shows the progress is not displayed. The download
progress is shown in the program status bar.

Save extra data

The program saves exira data to the images file. Exira data may include IRIG time stamp,
temperature, image index, exposure, rate and other time stamp information.

Acquisition Folder

The program creates a new folder for each saved acquisition. Type a new name for the folder
directly into the text box.

Overwrite folder
Please refer to the Advanced Acquisition configuration topic.

Image Prefix

Type a prefix into the text box to change prefix. If the prefix is ImgA, the images will be saved
as “ImgA000000.”

Camera name

If this option is selected, the image prefix is created with the camera name.

Comment
Type a brief comment/description of your acquisition.

File Type

Use the drop-down list to select one of the following image formats: TIFF, BMP, PNG, MPT,
MRF, MCF, MOV (Mac) and AVI (PC). For more information, see the Appendix.

Output Pixel Depth

The output file pixel depth may be different from the original image's pixel depth in
monochrome cameras. Use the drop-down list to select one of the mono or color pixel
depths. Bit images with 8 bits can be saved in 8 and 10 bit output files, while 10-bit images
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can be saved in 8-bit and 10-bit image files. TIFF, PNG, MPT, MCF and MRF support both 8
and 10 bit; BMP, AVl (PC) and MOV (Mac) support 8-bit only. Color images are saved in 24-
bit RGB format.

Rate [fps]
If the sequence is saved in AVI format, the playback rate may be configured.

From Frame/To Frame/Step

Type the desired Start Frame Index, Stop Frame Index and Step value directly into the text
box. For example, if from=2, to=10 and step=2, only the following frames will be saved: 2, 4,
6, 8 and 10.

Reset Numbering

In Circular mode the frame number can be negative; also, the Step may be different from 1.
Select the Reset Numbering Option to save images with numbers starting from 0 index and
step 1.

Data Acquisition

If data acquisition is connected and some data have been acquired with the images, the user
may select the file format. Available formats are: ASCII, Tecplot, LabVIEW, Excel XML
spreadsheet and Excel XLS workbook.
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Save Acquisitions

Images Folder
‘ C:\Program Fileg\D T 5MotionProstlmagesh ‘ [ Browse... ]
Fast download. Corveert later v ‘
Show the download progress in the status bar. Save extra data.
Select the acquisitions you want to save from the list below:
M ame Frames Bit In Bit Ot File Type

Acg Y4 Otod939 (1) 24 24 TIFF

Acg Y44 76 B23 (1) 24 24 TIFF

Acq Y4 B -298 to 301 (1) 24 24 TIFF

Selected acquisition settings

' Acquisition Folder ‘.ﬂ.cq_“r'fl ‘ [] Overwrite folder.
. Image Prefix ‘lmgﬁ ‘ [] Camera Name.
Cornment . ‘Generic image acquisition ‘
| File Type | Single TIFF File [~ i & [ Codec..

Output Pisel Depth | Rate [fps) - D
_“From Frame |EI | ToFrame |439 | Step |1

[] Fieset Frames Numbering,

Tile Images and Data Acquizition Graph.

Save I[ Cancel ]

Example: start frame is 10, stop frame is 16 and step is 2. If Reset Numbering is unchecked
the output file names will be: Img000010, Img000012, Img000014, and Img000016. If it is
checked the image names will be: Img000000, Img000001, Img000002, and Img000003.
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6.21. Fast Download and Raw Converter

The user may enable the fast download when the images are saved to the hard disk. To do
this, select the “Fast Download” option in the “Save Acquisitions” dialog box.

Once the fast download is activated, the program transfers raw data from the camera to a
temporary file that must be converted. The conversion may be done automatically (“Convert
after download” option) or later (“Convert later” option).

1. Convert after download: the file is automatically converted after the download. The raw
converter runs in background and converts the file. A progress bar is displayed in the tray
notification area of Windows.

Raw Converter
icon

‘Y, "a @ S5:23PM

2. Convert later: the file is converted manually by the user. From the Start menu select “All
Programs”, then “IDT", then “Motion Studio”, then “Tools” and then run the “Raw
Converter”. Locate the args.ini file in the acquisition directory and click OK.

Open Raw Image Header file

Look n: | 3 Acq_C_001 v| @ * > @
- L) Trackoon
D |bem
My Receant
Dozuments
@
Deskiop
tdy Documents
My Computer
s File name: | args.ini o
MyNetwork  Flesofper  |[ini fle (ini) v
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Then select the conversion options. The file format may be changed and the raw file can
be kept and converted more than one time.

Raw Conversion Options &‘

File Type:
'Single TIFF File (* ti) v|

Delete raw file after conversion,

[ oK J[ Cancel I

When the OK button is clicked, the raw converter starts the conversion and a progress
dialog box appears.

B Raw Image Converter

Converting:
acq_y4 008\args.ini

Elapsed time: 0:06 min - 60X

[!Illlll!l!lllllllllllll!l!lllll
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6.21.1. Raw converter batch files

If the amount of raw sequences to convert is large, the user may generate a batch file and
run the conversion once. From Tools menu, select “Raw batch editor...”

RAW Converter Batch File Editor

[ Mew batch file ] [ Open batch file... ] [ Save batch file. .. ]

‘ Mew File ‘

Acquisition ‘
m C:\Program Files\IDT\MotionProXiImages\acq_Raw_001
!Il C:\Program Files\IDT\MotionProxiImagesiAcq_Raw_00Z2
m C:\Program Files\IDT\MationProXiImages\Acq_Raw_003

|1l\
| ™

[ add.. { l Remove. .. I [ Remove al I

New batch file: click this button, to reset the current batch configuration and generate a new
batch file.

Open batch file: opens a previously generated batch file.
Save batch file: save the changes in the current batch file or in a new file.

Add: adds a sequence to the current batch file (ARGS.INI file)
Remove: removes a sequence from the current batch file.
Remove all: removes all the sequences from the list.

Once the batch file is generated and saved, launch the raw converter and open the batch file.
All the sequences included in the batch file will be converted.

92 Users Manual



Motion Studio

6.21.2. Raw Sequences and Database Viewer

If the “Convert later” option is selected, the sequence is saved in RAW format. The database
viewer shows the folder with a different color (green).

F Database Viewer - [DB:/Acq_C_002] 9=t

=Wty Computer || Description Value
B Cam_2305060066 (%3) Name Acq_C_002
= V3 Camera 33 (Y3) Comment Generic image acquisition
= | ] Database Date 04/13/2008
; i1 Time 17:26:40.040
b 6 Sensor gain No Gain
= Rate [fps] 50
b Acg_C_001 Exposure [ps] 6324,0 (Single) w

| Back i| Refresh 2

(b ballc pS— 0
() Bat it
b Cole 7 Edit
0 o X ke
(b Fool =

1} Froc_

(b Gun

) hatoo_ooo
b haioo_ooi
b hatoo_ooz v

| >

|

iBad
VT iPod

|

The user may right click on the red folder and select the “Convert Raw” option. The raw
converter will be activated and the sequence converted to the image format.
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6.22. Download data to SD card and convert

To activate the automatic download of the acquisition to the IRIG-Flash module (SD card), do
the following:

« Open the Advanced Acquisition configuration dialog box.

e Select the “Download to IRIG-Flash module” option in the Post-Recording Operation
control.

e Click OK.
« Start the acquisition

When the acquisition is done, the camera automatically starts the download of the memory
into the SD card. Motion Studio displays a progress window. If any error occurs, an error
message is displayed.

|  Thecamerais saving the images to the 5D card.
Saving 64 MB of 595 ME.
Elapszed Time: 00:00:09.

(Eanes )

The content of the SD card can be converted into images.

¢ From the File menu, select Open, then “SD cards/RAW files...".
e Locate the SD card from the list
e Click Open.

Open 5D card / RAW files

Motion Studio
Mame Model Serial Type Link
[#] <o Removable Disk ([)  MationPro ¥5 20-1108-0001  coke 50 Card
Inkerface: | Expart b Resfresh List

The SD card content is enumerated as a “Virtual camera” and will be open in a camera
window. Then the user may download images and save them in any file format.
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6.23. Images Recover

After each acquisition a local configuration file is saved in the database directory
(_nnn_recover.xsv, where “nnn” is the serial number of the camera). The file contains the
information about the latest acquisition. If any error has occurred after an acquisition and the
program has been restarted before the images have been saved, the acquisition may be
recovered.

1. From the main toolbar select the File menu.
2. From the drop-down menu select the “Images Recover” item.

3. Select one of the options.

Warning El

The images recover file has been detected.

- Click "fes' ko load the acquisition configuration fram the recover file and save images.
- Click "Mo' bo recover images with the current acquisition configuration.

- Click ‘Cancel' ko return ko camera control and change the parameters manually.

| Yes |[ Mo ][ Cancel ]
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6.24. Image Configuration

The image tab includes controls for color reconstruction and white balance and controls for
image improvement. Dynamic NR, sharpen, gamma, brightness and contrast are active also
for monochrome cameras

' Camera Hecde Image | Interpolation

— Use the drop-down list to select the color
CFA interpolation: interpolation algorithm (used to convert color filter
' array data into RGB data). The available algorithms
Light Source: are Advanced, Nearest and Bilinear.
e — 1.0 Light Source
& Gair: —7 D-U Use the drop-down list to select the light source that
‘ : best fits the current environment. Select the User
B Gain:  ~J n.a option to manually change the color gains or
[ - ” | balance the colors with an automatic balance
eze prOCGdLI[B.
Sharper: | RGB Gains
e 1.0 If the User light source is selected, use the Color
) 1 Gain sliders to increase or decrease the
Brightness: corresponding color component (red, green or blue).
Contrast: —_—— The range is from 0.5 to 2.5.
Hue: —0— [0 ] Sharpen
. + @ It sharpens the image edges. The range is from 0.0
Saturstior: ¥ : to 1.0. The default value is 0.0.
Gamma
It introduces a gamma correction to the image. The
range is from 0.1 to 4.0. The default value is 1.0.
Brightness

It increases or decreases the image brightness. The range is from -0.25 to 0.25. The default
value is 0.0.

Contrast
It increases or decreases the image contrast. The range is from 0.5 to 1.5. The default value
is 1.0.

Hue (color images only)
It modifies the image hue. The range is from -180 to 180. The default value is 0.

Saturation (color images only)
It modifies the color saturation. The range is from 0.0 to 2.0. The default value is 1.0.

Default
Click on the Default button to reset to the original values.
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6.24.1. Automatic White Balance
Edit color gains manually or use the automatic balance procedure:
1. Select the Color tab from the Docked Dialog Bar.
2. Select the User option in the Light Source drop-down list.
3. Click Reset and snap an image (Stop button).
4. Press the Target button. A target will appear on the image.

5. Click on the image to move the target. Move the target over a gray, non-saturated area.

6. Click the Apply button.

™ Matien Studie - [Y5 Camera 2 (Y5 - USB 2.0)] fEx
ED Fle Edt Jmage Fiter Camers Deta Yiew Iools Window Help -
.o n v
Fieady
Live  [Playhack |
()= ]
Fae Stap-Shep Live Tig Al
Acquisition Settings
Camera| Record | Image |
CFA intespolation:
Light Source:
RBan I—— 110 |
GG [10 ]
BGa [1e ]
| Applyd 203, 136, 1|
Shapsn ]
Gamma: T
Brightress: ]
Cortrat @
Hue: , 0
Saturaticre 0 ll]
Cafauk
iretagMacbeth™ ColorChecker Color Rendition Chart
Ready %1171 Y0780 () Fixel RGB: 165,50,27
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6.25. Data Acquisition module

The MotionPro Data Acquisition System is integrated in Motion Studio. When a Data
Acquisition module is detected the camera window is split in two panes and an “Analog In”
tab is added to the “Acquisition Settings” Tab. See the picture below.

™ Motion Studio - [¥3 Camera 33 (Y3 - USB 2.0)]
BB File Edt Imsge Fiker Camera Tracking Data ¥Wiew Tooks ‘Window Help

- ¥ 1
1 = J‘

40% W .*.\

AEE

2]

Ready
Live  Playback

(o) = JLJ

Rec Stop-Shap Live Trig At

Acquisition Settings
Camera Fecord  Color | Analog In
Record Mode: Circular v
Frames: 200 0.400000 s
BROC Lenagth:

Frame Sync:

Sunc Clg EdgeHigh |
Trigger Cfg Edge-High v
Trigger Adpust
Pre-Trigger Post-Trigger
100 (0.200 5 100(0.200 5

©)[3)

Aca B
Analog In Live Data

WP @EZ )

Horizontal [ms/div]: Wertical [\/div]:

Fit ko window ¥ |25mY bl

Show Channel: All channels v

'1-.Avg:—0.6m\\'—SD: 40my -

Datalde: Time: __ Vahe(s):

[-@833 [-0.153333 | 0.000

< > Resst

Lad Ready %1102 ¥:0997 () Pixel RGB: 80,42,25
— - ——
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6.25.1. Data acquisition cables and back panel

The picture below shows the data acquisition module back panel

Power Connector USB 2.0 Connector

Analog Inputs Group Analog Outputs Group

The BNC connectors are grouped in two groups:

Analog Inputs

+ AIN1 to AIN15: the analog input channels

¢ Sync In: the analog input external synchronization input
¢ Trig In: the analog input external event trigger input

e Sync Out: the analog input output signal.

Analog Outputs

¢ AOUT1 to AOUT4: the analog output signals

¢ Sync In: the analog output external synchronization input

« Trig In: the analog output external event trigger input
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For the connection of the DAS to the camera there are 2 possible scenarios.

6.25.1.1. Simple connection

The “Sync Out” connector of the “Analog Input section” of the Data Acquisition back panel is
connected to the “Sync In” connector of the camera. The Data Acquisition module generates
the camera acquisition rate, the camera acquires in Extemal Sync In configuration.

Data Acquisition Module

Trigger signal
(Camera only)

Sync signal
(from DA to camera)

SYNCIN  SYNO OUT

v @Q r

LUVE ouT PR

NOTE: The trigger signal must be connected to the camera “Trigger In” connector
only, not to the Data Acquisition module
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6.25.1.2. Connection with “Trigger In” signal

In some specific conditions it is convenient to connect the Trigger In signal to the Channel 1
of the data acquisition. The “Sync Out” connector of the “Analog Input” section of the DAS
back panel is connected to the “Sync In” connector of the camera. The trigger signal is
connected to the “Trigger In” connector of the camera and to the “AIN 17 connector of the
DAS. In the software, the option “Trigger on Chn 1” must be selected.

Trigger signal
(Camera and DAS)

Data Acquisition Module

Sync signal
(from DA to camera)
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6.25.2. Analog Input Configuration

Camera | Record | Image | Analogn |

S ampling rate: 10 KHz v

Samples/Frame: 10 v

Camera recording rate; | 1000 Hz

LB E(E]
Bl &G EE

Current channel
On/0f.
Label | Channel_1 |

Ipiits; | [v]
Conversion factor: 2000

Camera recording rate

On/0fE. [] Trigger on Chn 1. —‘

On/Off

The acquisition module may be enabled and
disabled. If enabled, the camera rate control is
grayed out and the acquisition rate is automatically
computed and configured. See below.

Trigger In on Chn 1

Select this option and connect the trigger signal to
the channel 1 input. The sampling of the trigger
signal will help synchronizing the images with the
data.

Sampling Rate

Select the number of samples per second. The
max sampling rate is 500 KHz.

Samples per frame

Select the number of data samples per camera
frame. The value is used a divider of the
acquisition rate to compute the camera acquisition
rate. The number is a multiple of the active
channels number.

The camera rate is automatically computed with the formula below:

Cam Rate = (Data Acq Rate) / (Smp per Frame)

Channels selection

Each channel may be independently enabled and configured.

Channel On/Off
Enables and disables the channel

Label, Units, Conversion factor

Enter the channel label, the units and the conversion factor.
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6.25.3. Analog Input Data Pane

First Sample| [Previous Sample

Next Sample

Last Sample

Horizonkal [ms/div]:
Fit to window ~ »

Show Channel:

Data Idx:  Time
-3833

Process

Information

Configuration | | FFT/Power Spectrum

The acquired data is displayed in a pane of the camera window. The display may be
configured.

Navigation buttons: first sample, previous sample, next sample, last sample.

Data graph configuration: see below.

FFT and Power Spectrum: see below.

Data Processing Menu: see below.

Data Information: see below.

Horizontal resolution: select the graph horizontal resolution in milliseconds per division.

Vertical resolution: select the graph vertical resolution in Volts per division.
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Show Channel: select if you want to be displayed all the channels or one single channel.

Average and Standard Deviation: for each channel the average and the standard deviation
are shown.

Data Index, Time and value: the index, time and value of the currently selected data item.

Operations list: see the Data Processing topic below.
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6.25.4. Data Graph Configuration

From the data pane, click the data graph configuration button.

Data Graph Configuration

Colors Units Display
Background: E O valts.
@ Scaled Uniks.

Grid: 1 &l channels conversion fackor:

Cursor: E ‘ Channel 1 v ‘

1,000 - [V]

Channel settings

Channel: ‘Channell v‘ Colar:

| oK |[ Cancel ]

Background color: the data graph background color.

Grid color: the data graph grid color.

Cursor Color: the data graph cursor color (vertical line).

Units Display: the graph may be displayed in Volts or in converted units.

All channels conversion factor: If all the channels are shown in the graph window, select
which conversion factor to use for the visualization.

Channel color: select the channel and set the graph color.
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6.25.5. Data Processing Menu

The acquired data may be processed in the current window. To activate the filters or the
mathematical operations, click the Data Processing button.

Select the Filter submenu or the Math submenu.

Filter | Low Pass Filter

Math »| | High Pass Filter
| Band Pass Filter
| Band Stop Filter

| Remove Average

Filter operations: low pass filter, high pass filter, Band Pass filter, Band Stop filter or
Remove average.

Filker »

Math | Megative
L=

Inverk

o] Square
| Sguare Root

Mathematical operations: Negative, Invert, Square and Square Root.

If the filters or the mathematical operations are activated the operations list is filled with those
operations. The user may:

e Select the items in the list and activate the single operation.

¢ Reset the list and delete the operations.
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6.25.6. FFT and Power Spectrum

Click the FFT button. The FFT dialog box appears. The user may select the channel to
display, the FFT and the power spectrum.

charrel 1 KB v

S000 1addd 15000 25000

[H=]
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6.25.7. Data Information

From the data pane, click the data Info button.

General information about the data acquisition is displayed.

Data Information

X]

Description Value
Channels 1
Sampling Rate 500 kHz
Sampling Rate per channel 500 kHz
Total samples 400000
Samples per channel 400000
Total samples per camera frame 100
Channel samples per cameta Frame 100
Start time -0.6000 s
Duration 0.8000 s

6.25.8. Note about the “Overrun” error

The “Overrun” error appears when the buffers allocated for the data acquisition are not
enough and the acquisition is too fast. The error appears more easily when large sampling
rates are configured (100 KHz, 250 KHz or 500 KHz). To avoid the error, increase the
number of frames to acquire.
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6.26. Advanced Camera Configuration in Camera menu

From the main toolbar select Camera > Advanced to access operations for the noise
calibration file management and the Advanced Color Balance.

Advanced - " Copy Calibration File from CD...

Download Calibration File from Flash memory. ..

Camera Calibration

. Elash Memory Diagnostics...

Color Balance

IRIG Calibration. ..

6.26.1. Copy Calibration file from CD

Each camera is shipped with a calibration file. For versions of Motion Studio below 2.07.04,
the file is stored in the WINDOWS\System32 directory (WINNT\System32 for Windows
2000). For versions of Motion Studio above 2.07.04, the file is stored in “C:\Common
Files\IDT\CameraFiles”.

If the file is not stored in the local directory, it may be copied from the camera CD.

6.26.2. Download Calibration file from flash memory

Giga-Ethernet cameras have on-board flash memory. The calibration file is stored in the flash
memory and may be downloaded and copied to the hard disk.
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6.26.3.

Camera Calibration

To reduce the noise associated with CMOS sensors and improve the performance of the
default calibration file, Motion Studio offers a Calibration dialog box.

1. Select Camera from the main toolbar.

2. Select Advanced > Camera Calibration.

To reduce the noise associated to the CMOS sensor and improve the performance of the
default calibration file, select the following options:

Enable background removal {factory calibration): it removes the background from
any acquired images and reduces the noise.

Enable pixel sensitivity correction (factory calibration). it enables the
compensation of differences in pixels sensitivity.

Acquire the background images in the optimal conditions: the camera lens cap
must be on. The driver acquires the background images in the optimal conditions for
all the parameters (exposure, rate, sensor gain and pixel gain). The background
images are not saved into the calibration file.

Reload factory calibration file: the driver loads the default camera calibration file.
This option is useful if the user wants to reload the default background images

To reduce the background noise in current conditions, select the following options.

Users Manual

Enable current condition background removal: if this option is selected the driver
uses the background images that have been acquired in current conditions and
corrects the images. The background calibration data is saved in a file and reloaded
when the program is launched.

Enable current condition pixel sensitivity correction: if this option is selected the
driver uses the coefficients that have been computed in current conditions and
corrects the acquisitions. The coefficients are saved in a file and reloaded when the
program is launched.

Acquire the background images in current conditions: the camera lens cap must
be on. The driver computes the background images for the current operating
conditions. If the sensor gain or the region of interest change after the calibration,
the correction may be wrong.

Acquire the PSC images in current conditions: the lens must be removed and a
constant light should illuminate the sensor. The driver computes the pixel sensitivity
correction coefficients for the current operating conditions. If sensor gain and region
of interest change after the calibration, the correction may be wrong.

Reset current conditions file: if this option is selected, the current conditions
calibration file is deleted and the current images and coefficients are reset.
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112

Camera Background Calibration

Factory Calibration
Enable backaround removal (Factary calibration).
Enable pixel sensitivity correction (factory calibration),

Click 'Acquire backaround' to acquire all the backaround images in
optimal conditions For all the sensor gains.

Click 'Reload Factory. .. to load the Factory calibration File and
restore default calibration,

[ Acquire Background. .. I [ Reload Factory calibration file ]

Current Conditions Calibration
[(]Enable current: condition background remaonval,

[TJEnable current condition Pixel Sensitivity Correction,

Click 'Acquire background' to acquire the backaround in current
conditions. Click ‘Acquire PSC' ko acquire pixel sensitiviky images in
current conditions.

| fcquire background., .. |[ fcquire PSC... I

Reset Current Conditions File

|Factory Calibration File: Yes - Current Calibration File: Mji

[

[ Show Histogram Abort
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6.26.4.

Flash Memory Diagnostics

It's a tool to test the camera flash memory.

1. Select Camera from the main toolbar.

2. Select Advanced > Flash Memory Diagnostics.

3. Click Test Flash Memory to perform a read/write test.

Users Manual

Camera Flash Memory Diagnostics E]

Description Value

Serial 13100600583
Link. UsE 2.0
Link. Firmware Yersion 2.0
On-board Flash Memory Yes
Calibration File ©n Flash Memary Mo
Configuration File On Flash Memory Yes

| Test Flash Memory |

lock
lock
lock
lock
lock
lock
lock

£ 0|

4: OK
5: OK
&: OK
7: OK
g: OK
a: OK
10: OK

Successfull test!

|

| >

(€
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6.26.5. Color Balance Adjustment

114

Build user-defined color tables with the Color Balance procedure.

1. Select Camera from the main toolbar.
2. Select Advanced > Color Balance.

3. Use the Color Balance Pad, to create new color schemes (Light Source Tables), edit or
delete them.

New Table: Click the button to create a new default diagonal table.
Delete Table: Click the button to delete the currently selected table.
Default: Click the button to load the default configuration.

Color Matrix Units: Click the appropriate button to select either the RGB or YUV color
matrix.

¥ Motion Studio - [Y4 Cam 4500 fps (Y4 - USB 2.0)] =3
D Fle Edit Image Filter Camera Data Yiew Took Window Help - 0 X
| | = O 50%
Y4 Cam 4500 fps 46.5 °C . R =3 HEach
r Balance Pad e it )
T O[EN[o
[ ew Tabe... | [Deiste Table... | [ oefat Hac Step-Snap Live Trig Al
R I B Acquisition Setl'mgt
R [0.900000 | 0.225050 |[o0.043881 Comera Record Image |
G [0.115092 |[1.228950 |[ 0043881 CFA irterpalation
B [o.11s02 |[0.zzsws0 |[1.745788 e
F Gain J El
Color Matrixunks [ Ree | [_ywy GG — Tz |
Colar Tnterpolation Thresheld BGan — o+ — [17 |
T Elrnene
Sharpen: 1 oo
Gamma: =) ||-D |
Brighnese:  — 000 |
Contrast: ! I'I.DEI |
Hue: — & [0
S sturation: i 1.3 |
igMacbeth™ ColorChecker Color Rendition Chart
x07
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6.26.6. IRIG Calibration (X cameras)
This option is enabled only on X/HS cameras when the IRIG B-120 item is selected in the
Time stamp tab of the general options. The calibration is a automatically started after each
acquisition if the “Run IRIG calibration after each acquisition” option is enabled.
The IRIG precision is 1 s. The calibration procedure checks the images IRIG flags in order to

find a “one second” transition. Once the transition is found, the time precision is increased
according to the acquisition rate.

F—
E Mation Studio is calibrating IRIG: checking image
65, Please Waitl

[-ﬁ'Eﬁﬁ.nhﬂ'ﬂi“ﬂiﬁ'ﬁﬁﬁ.nhﬂ ]
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6.27. Multiple cameras support

Motion Studio supports multiple cameras systems.

Open Cameras

Motion Studio

ﬂCarn_lEuUBD?Dl 14 MotionScope M3 Mo 16-0807-0114  mono

<

N\
Select the cameras from the list below:
Cameta Model Plus Setial Type  Link
a4 Eng Camera Motionxtra M4 Mo 02-1009-0347  color Gigakit
B Y5 Camera 2 MotionPro YS Mo 20-1109-0001  color USE 2.0
Cameral

| &5

[ Refresh List ] [ Find ¥ Camera... ] l Edit camera name. .. ] [ Edit IP Address. .. ]

[ Automatically assign IP Addresses. .. J l Enurn Filker ... J

Interface; ‘ Expett v |
[] Activake Camera List. [] Configure the cameras with the same parameters,

|:| Reset camera canfiguration,

L Cpen J[ Cancel ]

The way the camera views are shown depends on the selected options.

If none of the “Activate camera list” and “Configure the cameras with the same parameters”
options is selected, the program opens a separate window for each camera. The windows are
tiled and each camera can operate independently from each other. Each camera may have
different parameters from other cameras. The cameras may be also configured as

master/slave.
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Activate camera list

If this option is selected, the program opens a vertical “camera list” bar. From this bar the
user may:

e Select a camera: do a single click on the camera thumbnail to activate it. Do a double
click to activate the camera and start Live.

e Select a subset of the cameras: check the check boxes at the left side of the camera
thumbnail and operate the camera control bar. Click “Select All” to select all the cameras,
click “Deselect All” to deselect all the cameras.

« Synchronize camera configurations: click “Sync Cfg” to copy the configuration of the
foreground camera to all the selected cameras.

« See the status of the cameras: below the camera name, model and serial number, the
camera status is displayed (Ready, Live, Recording...).

« Exit the session: Click the Exit button to exit the session.

™ Motion Studio - [Y5 ENG Camera 1 (Y5 - USB 2.0)]

5 Fe Edt Imegs Flter cComera Daty Viw Tools Window Help

[(setectall ] [Desstectan | sweCia |[ Emt Hes
[#] Enable sutamatic debection of newls cornected Live | Playback
Caimedas. — g —
¥5 ENG Camera 1 [_‘._] l__f.._.] D

MationPro Y5 Fiec Stop-Snep Live Tig At

20-1109-0001 [] Master Camera

Ready

Acquisition Settings
[ Camera | Record | Image:
SensmGan [3d8 [ Reset |
Raislizl 100w [3e
Exposslpsl BB | £ )
Expasuie Mods: Single  w

Dynamic Rangs
3Bt

e

|por  [WozEarz | (o))

|E Ready w0294 v:0e61 il Plel RGE: 10,3,7
e

Configure the cameras with the same parameters
If this option is selected, the program sets the same value to most of the cameras

parameters. A separate window for each camera is activated. The values that may be
different are exposure, pre-trigger and post-trigger.
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6.27.1. Master/Slave operation mode

In this operation mode, one of the cameras acts as the master and the others as slaves. The
master camera controls itself and some of the configuration parameters of the slaves, such
as record mode, acquisition rate, etc. To set one camera as master, check the “Master
Camera” check box on the “Camera Control” group in the camera control bar. The check box
is hidden when only one camera is connected.

Live | Playback | Tracking

(o] @ P ]lv] @
Fec Stop-Snap Live Trng Al
[] Master Camera.

The master camera drives the slaves’ acquisitions via the sync out signal. The slave cameras
are automatically configured to operate with external frame sync. The picture below shows
how to configure a two cameras master/slave layout.

Master Camera Slave Camera

FGANT

TRIG IN SYNCIN  SYNC OUT

@

R

i

Trigger

Master camera “sync out” signal must be connected to slave’s camera “Sync in” connector.
To provide simultaneous trigger to cameras (circular and BROC mode), master camera and
slave camera should receive the same trigger signal.
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6.27.2. Master/Slave vs. Global Configuration

The global configuration is active when the “Configure the cameras with the same
parameters” option is selected in the “Open Cameras” wizard. The table below shows the
main differences between the two operating modes.

ltem Master/Slave Global
Preview is synchronized Yes No
Recording is synchronized Yes No
Playback is synchronized Yes Yes

Cameras have the same parameters

No (only rate, record mode
and exposure mode are equal)

Yes (only exposure
time can be different)

All the images are saved once

Yes

Yes
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6.28. Playback Controls

The Playback controls work like other familiar media player controls. The controls include the
following:

¢ Directional play

« Forward or reverse

+ Step forward and reverse

e Skip to first or last frame

e Stop play

6.28.1. Frame by frame review

The frame number and corresponding time from the initial frame (or from the event trigger
frame, if the mode is Circular or BROC) are displayed in seconds. Use the slider bar to
browse through the frames. In Circular or BROC acquisition mode when the pre-trigger and
post-trigger have been selected, a red marker shows the position of Frame 0 (the trigger
frame). Indexes of frames before the trigger frame display Negative and indexes of frames
after the trigger display Positive.
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6.28.2. Playback Speed and Playback Settings

Playback slider

Move the slider to select a frame. The red triangle indicates the position of frame 0 (circular
mode only).

Loop playback button
Click on the button to continuously loop the acquisition.

Zero button
Click this button to set the frame 0 position (trigger).

Start Frame

Type the number directly into the Start Frame text box.

Stop Frame

Type the number directly into the Stop Frame text box.

Skip frames

Use to skip frames during playback.

Goto Button

It opens a dialog box. Enter the image index to be displayed.

Playback rate Slider

Use to adjust the speed of the playback. The actual playback rate depends on the processor
speed and it is shown in box above the slider. If the actual rate is slower than the desired
one, use the skip frames control to increase it.

| Live ‘ Playback |

WHEEEE

-12 (427100)
-0.128513 s
-53 45

Start [ e -12 [-53 to 46)
. [ L‘TH
Actual rate [fps]: -

115 0

Ao Vb

| Annotations.
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6.29. PLAYBACK Menu

The Playback menu displays when file images are open. When the program is in Camera
mode, access the Playback menu through the Camera Option on the main toolbar. Standard

operations include the following:

¢ Play Forward or Backward

e Jump to First or Last frame

¢ Loop Through

e Playback Speed

 Playback’s Start and End frames for loop through.

HEMEES Tracking Data

(4 Firskt Frame
w4 Lask Frame
i Previous Frame
Mexk Frame
Stop Rewind/FF
4 Rewind

»  FEast Forward

== Loop Sequence

The items share their functionality with the docked button bar on the right side of the

application window.
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6.30. Annotations

The Annotation button on the playback tab shows the annotation dialog box.

™ Annotations E]E]
@ IIn‘uage-gS

Annotations map:
[
1104 ! L / 95!

General annotation:
General note about the acquired sequence of images.

Images annokation:
MNote about the current image

Daka annotation:

Mote about the data correspanding ko the current frame,
This note is useful if the cameras are used with a DAS,

General annotation
Add a general comment to the acquired sequence.

Images annotation

A note may be added to the current image. Use the playback button to locate an image and
add the note.

Data annotation

Add a note about data (for future use).

The horizontal bar shows the positions of the notes (black vertical lines) and the position of
the currently displayed image (gray handle). Buttons operations include the following.

e Use the arrow controls to locate the annotations.
¢ Reset all the annotations.

« Delete an annotation.

¢ Undo the latest edit of an annotation.
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6.31. TRACKING menu

The Tracking Menu on the main toolbar offers an alternative to using the buttons and dialog
box provided by the Docked Dialog menu including the following functions:

e Enable and disable tracking.

e Open the tracking configuration dialog.
¢ Add, remove or reset the track-points.
e Compute tracking.

e Show or hide the vectors, the table/graph dialog box and the correlation windows.

Data View Tools Window Help

Show Tracking Q Q o)

Configuration. ..

Calibration

Save Data...

=
4]
b

Mew Trackpoint
Reset Trackpoink
Delete Trackpoint

X X

Delete All Trackpoints

| Compute 4, Tothe start frame

Yiew » |4, Orne step backward
WM One step forward
b Tothe stop frame
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6.32. Tracking control

The tracking control tab appears on the main dialog bar if the “Tracking” option is enabled in
the General Options (“Enable Motion tracking” in the Miscellaneous Tab).

P Motion Studio - [C:\Program Files\IDT\MotionProX\Images\Color - Fish\MimgA.avi] Ej@i@
- Fil= Edit Image Filter Playback Tracking Data ‘iew Tools ‘Window Help - 8 X

- E_n | ¥ ] R ‘};—4 5% ¥ *) y= @

m— Fonds
‘ + i-PlajlhacI{- Tracking |

0/ C1 /RN (EY/E3(CY C

1 (2/40)
0.010000

= :
(o) JHmm——————
Stark: Stop: Skip frms:

|u 33 ][o ““Golo J

[¥] Show Tracking.

KB/ 1 3 )

Faitit: Calor: Size:
o000 s - ~ | |B4 -

[ Mew H Reset l ’ Deblel

[ Configuration “ Save... l

|_Calbration || ON

Irfa

] 580%880 - 24 bit - 100 fps
Annotations.

= ready %:0872 v:0010 | () Pixel RGE: 206,202, 1"
—
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Use the tracking tab to enable and configure the tracking points. The options are as follows:

Playback | Image |-TT3CkiﬂQ |

(D@

-199 (2/300)
-0.398000 s
-a00 ggl '
o e
Statt:  Stop: Skip frrns:
200 Jjaa |0 2||Geto. ]
Show Tracking.
L) [
Faint: Color: Size:

ooo0 v | M v 128 2

[ Mew H Reset ] [ Delete ]

[ Configuration “ Save... ]

OFF

Show tracking: enables or disables the display of
the tracking point and trajectory. If this option is
unchecked no tracking can be computed.

Track computation buttons: click the track buttons
to compute tracking cne step forward or backward,
to the start frame or to the stop frame.

Table/Graph: shows or hides the table graph
window.

Vectors: shows or hides the trajectory vectors.
Point: select the track point to configure
Color: the track point color

Size: the correlation area size in pixels. The area is
a square.

New: click the button to add a new track-point.

Reset: click the button to reset all the computed
positions.

Delete: click this button to delete the current track point.

Tracking Configuration: click this button to open the configuration dialog box.

Save: click this button to save the tracking results in ASCII, LabVIEW, Tecplot or Excel
format.

Calibration: opens and closes the tracking calibration dialog box.
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6.33. Tracking procedure

6.33.1. Add a new track-point and compute
To add a new track-point, follow the steps below:

1. Click the New button on the tracking tab. The cursor will change into an arrow with a plus
symbol.

2. Move the cursor to the image and click on the position where the track-point needs to be
added. The cursor will change to the standard arrow.

3. The track-point position may be changed by dragging the central cross (see below).

4. Then the point trajectory may be computed by clicking the green arrow buttons on the
tracking bar.
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6.33.2. Edit the tracking configuration

Click the “Trk Config" button on the tracking bar or select the “Configuration” item from the
tracking menu. The options are as follows.

Tracking Configuration EIEI
Tracking
Set image intensity. Filter image.
Mode: ‘ Deformable translation v |

Displacement range:

24 |lane (24|
|-24 l[<r< [2¢ |

Yectors

Display vectors as: ‘Arruws v ‘

[ Ok H Canicel I

Set Image intensity: when a new track-point is added the program computes the intensity
range on the current image. The current image will be considered as a reference image for
the computations. If the option is disabled, no intensity is computed.

Filter image: before each computation a set of sharpening filters is applied to the images.
The filters reduce the effect of the background on the computation. If the option is disabled no
filter is applied before the computations.

Mode: the tracking algorithm can be adapted to different tracking conditions (deformable
translation, rigid translation and rigid translation with rotation).

Displacement range: the displacement from one point to the next may have a limited range.
Enter the values to avoid errors.

Display vectors: the track-point trajectory may be displayed as a sequence of arrows, a
continuous line or a dotted line. The trajectory is shown is the “Vectors” button in the tracking
bar is selected.
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6.33.3.

Show the tracking data and the vectors

From the tracking bar, click the Table/Graph button. The same dialog box shows the table
with the computed values and the graphs.

Tracking Table - Graph

Frame  Time [ms] Pt1 s | Al ~
u] 0.000 33.69, 101.88 234.677, 86.726 -536.078, -50.424

1 100,000 54.59, 110.10 181.070, 51.634 -536.073, -50.424

2 200.000 69.92, 118.35 127.462, 76.642 -536.078, -50.424

3 300,000 79,96, 125.50 77.982, 75.074 -472.086, -7.579

4 400,000 84,74, 132,50 38.255, 79.946 -340,383, 95,474

5 500,000 86,18, 140,47 10,980, 86.031 -198,999, 79,203

=] 600,000 85,88, 150.62 -3.774, 82,4358 -87.142, -108,746

7 700,000 84,71, 159,37 -7.617, 63,456 10,5895, -295,331

g 800.000 83.60, 164.46 -3.479, 36.847 82.134, -298.285

9 Q00.000 83.59, 165.71 2.517, 14.087 67.191, -175.241

10 1000.000 g4.72, 165.80 5.210, 1.460 -5.500, -62.063

11 1100,000 85.44, 165,38 4,568, -7.490 -31.151, -74.772

12 1200,000 85,44, 165,08 6,283, -23.423 39,289, -214.511

13 1300,000 85,65, 162,44 15,156, -46,303 140,068, -286.665

14 1400,000 87,63, 155.76 33.280, -71.873 227,464, -247.611

15 1500,000 91,74, 147.15 59.471, -64.732 299,440, -56,605

16 1600.000 95.98, 136.62 85.618, -93.369 264,760, -28.093

17 1700.000 109,78, 129.33 108.001, -101.769 181.472, -129.343

18 1800.000 121.42, 117.87 122.134, -114.677 99,487, -166.150

19 1900,000 134,70, 105.74 128,938, -133.915 32,740, -195.033 B
20 2000,000 147,77, 91,73 134,692, -155.047 49,840, -234,068

21 2100,000 160,93, 74,92 146,030, -177.289 157.682, -224.668 “

The first column lists the frame number, the second lists the time. Then for each point there
are listed the position (in pixels or mm if the calibration is on), the speed and the acceleration.
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Point
oooo b
Shows

Each component of the data can be separately displayed in a graph. The “Point” combo-box
lists the configured points, and the “Show” combo-box lists the components (X, Y, Vx, Vy, AXx,
and Ay).
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6.33.4. Save the tracking data

The tracking results are always saved in a default binary file and reloaded when the image
sequence is open again. The user may save the data in a different format:

1. From the tracking bar, click the “Save...” button.
2. Enter the folder name, the file name and a comment (optional).

3. Select the file format:

¢ Binary file (BIN).

o ASCIl text file (ASC).

o Tecplot Text file (PLT).

e LabVIEW Measurement file (LVM).
o Excel XML Spreadsheet file (XML).
o Excel XLS Workbook file (XLS).

4. Click the OK button,

Save Tracking results 1'@

" Folder Mame [:)

File Mame Foot
Comment ‘ Tracking Test ‘
File Type ‘Excel ®LS Workbook Data File (*.xls) v ‘

[ Ok H Cancel I
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6.33.5. Calibration

The tracking displacements are computed in pixels and can be converted into mm through a

calibration.

Click the calibration button on the tracking tab to open the calibration window.

Calibration 33

Calibration

“0n aaa

‘Basic V‘ | Calbrate... |

Save calibration image.
Create a new calibration folder.

Browse for calibration image andfor
settings,

=] (€] §

[ Discard Calibration ]

[E]

Show/Hide calibration image.

On/Off: when a calibration is loaded the
button allows activating/deactivating the
calibration.

Model: select the calibration model
(basic, simplified, generic)

Calibrate: click this button to start the
calibration.

Save image: click this button to save the
current frame as a calibration image and
create a new calibration folder.

Browse: click this button to browse for a
calibration image and import it in the
current acquisition.

Discard: when a calibration is loaded, it may also be discarded.

Show/Hide Image: toggle this button to show or hide the current calibration image.

The calibration procedure may be divided into two steps:

1. Save a calibration image and create a new calibration folder or browse the database and

import a calibration image from existing folders.

2. Select the calibration model and calibrate.
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6.33.6. Save the calibration image

Select the image from your sequence or snap it from the camera window.

Click the “Save calibration image” button from the calibration configuration window.
Enter the calibration folder name.

Select the calibration file type (TIFF, Bitmap or PNG).

Enter a comment (optional).

Click OK to save the calibration image.

Save Calibration Image E]E]

Calibration folder name:
‘ Calibration A ‘

Image kype:
'single TIFF File (* if) v|

Cornmenk:
‘ Simple calibration test ‘

OK l[ Cancel ]
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6.33.7.

134

B N

Browse the database for a calibration image

Click the “Browse..." button from the calibration configuration window.

Select a calibration image form the list.

Click OK to import the calibration image and the settings, if any.

Click the Browse... button to import a calibration image and/or settings from a directory

external to the database. The image will be listed with a pink icon and the name will be
editable.

Browse Calibration @@

Select the calibration From the list below:

Marne File Marne Comment Model |
@ Aspiring Vitamines_MNew?2 kf Influerza None
‘@ Kodak kodak1.bmp Mone
Half _lighthouse, HF None
&ﬂ] Images2 ImgAD00000, kif MNone

256 x 384 - 8 bit [ |

0K ][ Cancel ]

Users Manual



Motion Studio

6.33.8. Calibrate

Three calibration models are available: basic, simplified and generic.

6.33.8.1. Basic model

The basic model is the simplest. The user is asked to drag a line on the calibration target and

enter a distance in mm.

P Motion Studio - [Calibration Image]
i File Edit Image Fiter Playback Tracking Data Yiew Tools ‘Window Help

O =

% Ready

Scaling and Tile
Distance [mm]:

Tilt Angle [dearess]:
Grid Color:

100.000 |

0.71

-

[ calbrate! | |

Exit

X:1240 Y0126

Ready

Playback | Tracking |
()R] 0] )

ooy
- o ssl
)| nninnninet’
Start  Stop
o = |
Show Tracking.

E[™

Foint: Color: Sizer
000 v || v B¢ T

| New” Resst ] [ Delete ]
[ 4% Tk Corfig || b Save... |
[ cabraion]| oM

Into

| 8801880 - 24 bit - 100 fps

Arnotations.

The calibration grid has two handles. The handles may be dragged over two reference points

on the calibration image.
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Basic Calibration

Scaling and Tilk
Distance [mm]:
Tilt Angle [degrees]:

Grid Color:

200

IE

[ Calibrate!

|| e |
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6.33.8.2. Simplified model

This method requires that the calibration target is vertically aligned with the camera, i.e.
vertical lines in the target correspond to vertical lines on the target image. The rectangular
grid has four handles that may be dragged over four reference points of the calibration image.

¥ Motion Studio - [Calibration Image] EWEIB_&
| Flle  Edit Image Fiker Playback Tracking Data Yew Tools Window Help - & %

* =8 f ) W | s v & € @

Ready
mplified Plagback | Tracking
Callbration rectangle

Wil [ YOl [doalom] ME)CICM]
(200 |[a00 | S

— T @

Camera parameters
Focal Length [mm] 50 Stat  Stop

Pixel Size [um] 12.0 I—I 3
Lse Parspective, [¥] Show Tracking.

ll@ll@

Color: Size:

v [
[ New” Fazat | [ ] ]
(o | (oo
[l Calbsion] | 0FF

[ cabratel |[ Bt |

Info
| BB0xAAO - 24 bit - 100 fps

. Annotations.

L% Ready #1012 ¥:0006 @Pi!d\falue:ﬂ(ﬂh)

To achieve more precision the zoom factor may be set to 300 or 400 and the handles may be
positioned upon the calibration target marks.

With the simplified calibration two options are available:

1. The camera plane is parallel to the target plane and there is no perspective: the
calibration is just a way to find a constant value that will be multiplied by the pixel
displacements to find the space displacements. Both horizontal and vertical lines of the
calibration target are perfectly parallel to the rectangle sides. In the Calibration dialog
box, the “Use Perspective” option is OFF, and the rectangle sides are parallel.

2. The camera plane is not parallel to the target plane and there is a perspective effect. The

effect is computed only on horizontal lines while vertical line must be parallel to the
rectangle vertical sides. In the Calibration dialog box, the “Use Perspective” option is ON.
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Simplified Calibration [ [X]
Calibration reckangle
% [mm] ¥ trnm] diaq [rnm]

| 200 | 200 | |

[Juse diagonal, | color

Camera parameters

Focal Length [mm]

Pixel Size [um] 12.0
[[Juse Perspective,
| calbrater || et |

X/Y Dimensions: the user enters the dimensions in mm of the rectangle. The distance
between the points of the calibration target is known. The values are in mm (1 inch = 25.4

mm).

Focal Length: the camera focal length in mm.
Diagonal: when the “Use perspective” option is off, the user may check the “Use diagonal’

check box and enter the rectangle diagonal length instead of Width and height.

Grid Color: the color of the calibration grid may be changed.

Pixel size: the user may edit the pixel size. Click “Find size...” to select the camera model

and find the correct size.
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6.33.8.3. Generic Model

The generic calibration considers different kind of distortion due to optical and/or perspective
issues. The calibration grid is more complex than a rectangle, is a multi-point grid (see
below). The points of the grid will be positioned over the marks of the calibration target. Then
the program computes the parameters of a third grade polynomial which maps the points of
the image (pixels) into the points of the real space (mm).

P Motion Studio - [Calibration Image] !Tlr_ﬂ___lgl
= Fle Edt Image Fiter Hayback Trading Data Yiew Tools Window Help

i - BT ™ pN | o v € & @

Ready
| Playback | Tracking |
WEMELIEm

1 (2/40)
0.010000 5

e

[#] Shows Tracking.

AL ()
Point Color Size
[oco | mm ~| 5t 3|

#le Corfig i—;‘ Save ...
+| Calbration OFF

Inifo

BE0WED0 - 24 bk - 100 fps
Annclaions.

\od Reacy Kil468 Yi0p22 Q Fixel ahaz: O (0R)

The grid may be moved and resized. The way the grid is resized is controlled by the “Grid
Mode” in the calibration dialog:

Zoom: in this mode the handles are positioned over the four external corners of the grid. The
grid may be zoomed or moved.

Constrained: in this mode the handles are positioned over the four external corners of the
grid. The grid can be distorted.

Free: in this mode each point of the grid has its own handle and can be moved
independently.
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Generic Calibration

CGridsze  [200  [[z00 |
Nodes ‘ 4 = ‘ ‘ 4 - ‘

| calibrater || Bt |

Once the grid handles are in the correct position, the user enters some parameters, and then
clicks “Calibrate!”.

Grid Size (X/Y): the user enters the dimensions in mm of the grid (distance between the grid
corners). The distance between the points of the calibration target is known. The values are
in mm (1 inch = 25.4 mm).

Grid Nodes (X/Y): the user enters the number of nodes in the grid. The minimum is 4, while
the maximum is 20. The number of nodes depends on the calibration target.

Grid Mode: see above.
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6.34. DATA menu

When acquired data pane is visible and some data is displayed the DATA menu is active.

Use the Data menu to apply fiters and mathematical operators, to show or hide the
FFT/Power Spectrum window and to open the data graph configuration dialog box.

View Tools Window Help

| Filter || Low Pass Filter...
Math »| | High Pass Filter...

1) ;F .| Band Pass Filter...
& W | Band Stop Filter. ..
| Remove Average

BEEN Yiew Tools ‘Window Help

Filter > i e ™ ‘
| - 7] Megative
i1 Show EFT | Invert
¢ Configuration... ol Square

| Sguare Root
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6.35. VIEW menu

Use the View menu to magnify the image, restore the original size (100% zoom) or compute
a zoom factor that fits in the window.

Use the View menu to select the toolbar options.

142

FNoNC

RRARE:

[<]

Zoorn Sk
Drynamic Zoom
Full Size

Fit ko Window

Main Toolbar
Skatus Bar

Camera Toolbar
Thumbnails Toolbar

Pan Toal

Acquired Data pane

Annotations

3000 %
2500 %o
2000 %
1500 %
1200 %%
1000 %
800 %
600 %
S00 %
400 %
300 %
200 %
100 %
o0 %
80 %
70 %
60 %
a0 %
40 %
30 %

20 %
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6.35.1. Zoom Tools

The Zoom In and Zoom Out tools let you change the image magnification.

The Dynamic Zoom tool lets you zoom in or our by dragging the mouse or mouse wheel up
or down.

To Increase or decrease magnification, do one of the following:
+ Select a magnification percentage from the toolbar Zoom menu.

¢ From the View menu, select the Zoom In or the Zoom Out tool, and then click the image.
To zoom in on a specific area, use the Zoom In tool and draw a rectangle.

¢ From the View menu, select the Dynamic Zoom tool and then drag up to zoom in to the
area where you begin dragging, or drag down to zoom out from that location.

To deselect one of the Zoom tools, press the ESC key on the keyboard.
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6.35.2. View Thumbnails

144

Select View menu > Thumbnails Toolbar. Once an image sequence is opened or
acquired, the Thumbnail Toolbar is populated with images.

Use the arrow buttons on the Playback Control tab to scroll through the images.

Click on a Thumbnail in the sequence to select a frame for display. The selected image is
highlighted in the sequence.

P Motion Studio - [C:\Program Files\IDT\MotionProX\images\Color - Fish\ImgA.avi]

= File Edit [mage Fiker Playback Tracking Data View Tools Window Help -8 X
- t:] | = | " . 60% ™ ®’\: Qﬁ @

Ready
Playback | Tracking |

(kL (=] ]
1(2/40)

0.010000 5

i [ asl
O —
Start:  Stop: Skip frme:
o (@ |0 @

Flayback rate
Actual playback rate [fps]: l:l

W

1 % ;0

[] Synchionize views.

Infio

[ BB04BB0 - 24 bit - 100 fps
Annatations.

IE Ready X:0873 V:0033 @ Pixel RGB! 200,192,183

X

000003 000004

000000 000am
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6.35.3. Configure the Thumbnail Parameter

1.

From the main toolbar, select Image > Thumbnails Cfg... to configure the thumbnail
viewing parameters.

Type the number of the start frame in the Start Frame text box.
Type a number of frames to skip in the Frame Step text box.

For example, if you select Frame Step 2 and Start Frame 2, the thumbnails will have the
index 2, 4, 6, 8.

Thumbnails Configuration @@

| Select the step between frames to display
UJ ir the thurbnails bar and the index of the
first frame.

Starting Frame

-
Frame Step

0K ][ Cancel ]
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6.36. TOOLS menu

The Tools menu has the General Options for the program and the Timing Hub control dialog.

If a Camera window is open, the Tools menu contains the following options:

146

Advanced Acquisition Configuration dialog box (see Advanced Acquisitions Cfg on the

Record tab).
Histogram window.

Focus Line tool for help focusing the image.

Motion Trigger configuration.

Timing Control for the generation of timing signals with the MotionPro Timing Hub.

Analog output for the generation of analog waveforms with the MotionPro Data
Acquisition System (DAS).

Wireless Sync/Trigger for the use of Galileo™ Wireless System.

Giga-Ethernet cameras network configuration.

Raw Image converter.
Vidi Motion (Lens Calculator).

Image tile utility.
Options dialog box.

Language selection.

Window Help

I'_|¢F

G B

L
¥

4

€ L =

%

9

Advanced Acquisitions Cfg. ..

Histogram YWindaw
Reticle

Focus Line | Image Prafile
Motion Trigger

iiming Control

Analog Oukput

wireless SwncfTrigger
Network Configuration. ..
RawW Converter...
Image Tile Utility. ..

Yidi Matian, ..

Options...

Language. ..
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6.36.1. Options
The General Options provide the option defaults for the program.
Select Tools from the main toolbar > General options.

Image Folder

It shows the directory where the images will be stored after each acquisition. Click the
Browse button to change this setting.

Memory Limit

Sets the maximum amount of memory the program allocates when opening a saved
sequence.

Options

EAEEl  cCameras  Time Stamp Miscellaneous

General

Current Default Image Folder:
‘ C:\Pragram Files\| D ThkMationPrax magesh ‘

Browse...

b axirurn amount of memorny that the program may allocate when a
sequence of images iz loaded.

Physical Memory [MB]: ]201 5
Memary Limit [ME]

OK l[ Cancel ]
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6.36.2. Camera Options

Enable double exposure
Select single or double exposure.
Live While Record

During a recording session the preview can be enabled on all cameras, fully disabled or
activated only on the camera window that has the focus.

Trigger Hot Key

The software trigger can be sent to the cameras by clicking the Trigger button on the camera
toolbar or by pressing a keyboard key. The user can configure that key.

Get raw gray data from color cameras

Grayscale images coming from the sensor are not converted into RGB format. The frames
are acquired and displayed as black and white images.

Convert color data to grayscale
Converts color RGB images into 8-bit grayscale images.
Network performance

The network performance is a delay added to the data exchange between the cameras and
the computer. If there is traffic on your local network, then move the slider to “More reliable”
to avoid loss of data during the communication.

Options

g i"::""‘", ‘ [ﬁ] l
b —

General [ENEER  Time Stamp Miscellaneous

Cameras

Enable Double Exposure.

Live while record: | Preview all cameras A ‘

Trigger Hot Key: i v

[] Get raw gray data from color cameras.

[] Convert calor data ta arayscale.

Metwork Performance: 100

-

J
Fast Most reliable

OK. ” Cancel ]
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6.36.3. Time Stamp Options
To display frame information directly on the images, check the corresponding boxes:

Comment

The acquisition comment.

Date

The acquisition date.

Marker

Display the frame marker.

Time

The acquisition time (or current time during live).

Frame Number

The frame index.

Rate and Exposure

The values of rate and exposure during the acquisition.
IRIG

IRIG information in B-120 format (date, time, CF and SBS).
Acquired data value

The data acquired with the Data Acquisition module.

Time from acquisition start

If the record mode is BROC it shows the time elapsed from the start of acquisition.
File Name

The name of the file where the image is stored.
Temperature and units

The camera board temperature and the units (degrees Celsius or Fahrenheit).
Time from trigger and precision

The elapsed time from the trigger frame. The number of digits is configurable. You may either
display in seconds with up to 6 decimal digits or in milliseconds with up to 3 decimal digits.

Add Logo

A bitmap can be displayed on the acquired frames and saved to the image files. Click the
browse button to locate a TIFF, BMP or PNG file.

Run IRIG Calibration

When this option is selected, the program automatically starts an IRIG calibration after each
acquisition.
Add vertical offset...

If this option is selected the time stamp is not printed on the image, but on a horizontal black
stripe set above or below the image. The stripe is saved on the images when the frames are
saved.
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Font

Select the font for the time stamp.

Position

Select the display position Top/left (default), top/right, bottom/left or bottom/right.

Color

Select the time stamp color. If the image is monochrome, the color will be converted into
grayscale when the images will be saved.

Size

Select the font size.

150

Options

l

General Cameras IR et Miscellaneous

[] Comment. [ Date. Marker.
[] Time. [] Frame Mumber.

[]Rate [fps]. [] Expasure [us].

CJIRIG. [] Acquired Data value [DAS).

Camera Mame. [] Time fram acquisition start (BROC).

[ ]File Mame. Temperature.  Units; | Celsius v

[] Time from Trigger.  Precision [digits]:
DAdd logo. |‘f ‘ Browse, ..

[]RunIRIG calibration after each acquisition.

[] &dd vertical offset to image to show time stamp.

Pasition: | Top/Left v Color:

Fant; ‘ Courier Mew " ‘ e 22 B

[ OK ” Cancel ]

N
(x)

Time Stamp
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6.36.4. Miscellaneous Options

Show Main Menu dialog at start-up

It displays the main menu dialog box when Motion Studio is initialized.
Prompt before closing camera windows

The program will prompt the user before closing any camera window.
Show cameras enumeration filter at start-up

If the option is checked the camera enumeration filter dialog is displayed when the camera
wizard is started.

Check Calibration file at start up

If this option is selected the program checks the calibration file when the camera is open. If
the camera does not have a calibration file, the option may be unchecked.

Enable motion tracking

This option enables and disables the motion tracking.

Save Tracking data with IRIG time

If this option is selected, the tracking data is saved with the IRIG time information.

Enable Camera Diagnostic Trace

It logs each camera operation in a text file in the program directory for diagnostic purposes.
Enable Remote Diagnostic Trace

It logs the communication between the cameras and the client Palm when the remote
connection server is active,

Enable Remote Connection server

If this option is selected the remote connection server may be started and the camera may be
remotely controlled by a Pocket PC via the wireless LAN. For more info, see the “Motion
Studio Remote Control” paragraph.

Save ISO MME data

ISC MME data is generated and saved in the acquisition folder. The files are _config.mii and
_config.mme.

Reticle Color
Select the color of the reticle in the tools.
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General Cameras Time Stamp QR EpEEE

Miscellaneous

Show Main Menu dialog at start-up.
Frompt before closing camera windows.

[ Check calibration file at start up.

Show cameras enumeration filker at start-up.

Enable mation tracking.
Save tracking data with IRIG time.

[] Enable camera local trace.

[[] Enable camera remote trace.
Enable Remate Connection Server,
Save |50 MME Data,

Reticle Color:

oK

] [ Cancel

]
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6.36.5. Reticle

The reticle is a pair of crossed lines drawn over the image. It may be used to vertically or
horizontally align the camera. The color of the cross may be edited in the general options. To
move the cross just click on the image.

™ Motion Studio - [Cam_2304070244 (X3 - USB 2.0)]
D Fle Edt Image Fiter Camera Tracking Data View Took Window Help

s0% v &

Ready
i Live -iul'-‘layl.lac.lé .'I'.laci(.ilg

@6

| fiec Stop - Snap Live
Acquisthion Sethings
Camera  Record | Color |

Sensor Gar: | Mo Gain %

Rate [Hz} | 100

Exposure [ps]: E

Tog  Aik |

]
[1o]

v

Exposure Mode:

E

Binning
1x1

Dynamic A ange
& EBit
Pivel Depth:

24 Bit

v

¥

RO

10.0)1280x1024

5.000

Live Time Cut [s|

Acq A

x:0952 v:0834 (0 Pixel RGE: 39,56,46
—--
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6.36.6. Histogram

The image intensity Histogram is used to set the camera exposure parameters and with the
camera focusing to optimize the dynamic range. Color cameras have three color
components, red, green and blue. The histogram is computed for each of these components
separately. For monochrome cameras the histogram is computed on the grayscale pixel
values.

Histogram

Current Component

&uto Bin Size.
Bins l1IJU v | | | 1
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6.36.7.

Focus Line / Image Profile

The Focus Line Intensity dialog box displays the values of image intensity (levels of gray in
monochrome images and levels of green on color images) along the points of the focus line.
If the image is well focused, you will see the intensity changing when the line crosses an

edge of the image.

1.

2.
3.
4

From the main toolbar select Tools > Focus Line/lmage Profile.
Use the “Type” drop-down list to select Focus Line or Image Profile.
Use the “Color” drop-down list to select the Focus Line color.

To position the focus line, drag the line handles and position them across the image
edges.

™ otion Studio - [Cam_2305060068 (X3 - USB 2.0]] EIEI@
- B X

€8 Fis Edt Image Filter Camera Teacking Data Yiaw Took Window Help

= i s v| B G @
Feady
Live  Playhack | Tracking
()= 0]

Fec Stop-Snep Live Tng ANt
Acquisition S etlings

Camera | Record | Colot

Senecr Gaine MoGan | [Fest |

FateHzp (500 L @

Expozure [p=] 165 [ﬂliﬂi

Exposune Mode: Sng W
Dypnamic Ranga

aEi
Birming Fiiel Diapith
(11 \-'. “24 B | v
ROL|(0.0] 280a1024 Q

Live Time Dut [s] |5.000

¥
#1059 Y0910 @nw AGH:5,7,9

Focus Line Intensity / Profile

!

Twe  [Focusline | LineColr [N ~
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6.36.8. Motion Trigger

™ Motion Studio - [Y4 Cam 4500 fps (Y4 - USB 2.0)] =13

@ Fle Edit Image Fiker Camera Data View Tools Window Help - 8 X

o [50% ™

Ready
Live Playback
(o] L]
Fec Stop-Snap Live Tng Al
Acquisition Settings
Camera | Record | Image

CFA merpolaon: [Advanced ]

Light Sowrce: User v
R Gairc B 10
G Gain: ) 10 |
e T v B Gaire ! 1.0
Trigger (tﬁ;_ ion = ) --
Motion Detection ' Shapere ) (00 |
45 % 3, Giamma: ' LR
T Enghtress: J 0.00
Reference: |0 -
) Conlrast: J 1.00
Image Region e - 5 T
e L f"‘ - WETET | Rl : S aturation: J [1.00 |
width | 192 Height 212

coor [ v

The Motion Trigger automatically generates a trigger when a condition becomes true in a
region of the image. The ROl is set by a rectangular grid that may be dragged and positioned
anywhere in the image. The option is valid if the camera acquires in circular mode.

The Trigger condition is configurable. Four options are available.

e The average intensity in the ROl changes by a configurable amount.

¢ The average intensity in the ROI decreases by a configurable amount.

« The average intensity in the ROl increases by a configurable amount.

e A general motion is detected in the ROI.

In new design (pipeline) Y cameras, the motion trigger is implemented in the firmware and the
trigger condition can be detected in real time during the acquisition.
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Trigger condition
Select the condition that generates the trigger and the levels.

Reference/Current

The Start average is the value of average computed when the acquisition starts, the Current
Average is the value computed on the current preview image.

Threshold slider

The range is from 1 to 400. It indicates a percentage of the reference intensity of the image.

X, Y, Width and Height

The position and size of the trigger ROIl. The user may also drag the handles of the grid to
change the size or the entire grid to change position.

Center
Click this button to center the position of the trigger ROL.

Motion Trigger Configuration E]E]

Trigget condition

Users Manual

Mation Detection b ‘
as% S

Reference: El Current: El

Image Region

X Origin ¥ Origin.

| width Height |212
Color
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6.36.9. Timing Hub Control

Motion Studio provides the controls for the MotionPro Timing Hub. If a Timing Hub is
detected, the Timing Control menu item is displayed in the Tools menu.

From the main toolbar select Tools > Timing Control.

6.36.9.1. Channels selection and controls

Current channel ‘ Channel 0 “ ‘
4
Signal generation |User Vi
Labsl  |Channel 00 |
tMade ||nlernal Vl Invert []
B
=
Gate |N-:-ne Vllnvert!:l
IFrequenc:y [Hz] vi ‘Duty Cycle [%.] j .

oJojojofi]olofgolofo]s]ofol
EEEEEEE EEEEEE | (g

4 [ [

el ofo]of1]ofoofo |
EEEEEEEE

External Frequency A External Frequency B
O D O
Current channel: select the channel you want to configure.
Signal generation: see the “Signal generation” topic below.
Label: The user may change the label of the output channel.

Mode: The operating mode may be selected. For a more detailed description of the modes,
refer to the topics below.

External In: when the selected mode is “external’, the user may select the external input
channel (0 or 1).

Gate: each channel may be gated. The gate channel may be one of the two external inputs (0

or 1) or one of the other output channels. The gate selection is disabled if the mode is
“Start/Stop” or “Rate Switch”.
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Invert: the output signal, the input signal (external mode only) and the gate signal may be
inverted.

Frequency/Period: the user may select the frequency in Hz or the period in us of the
selected channel.

Duty cycle: the user may select the channel duty cycle in percentage (1 to 999) or duration
of the high value of the channel in us.

Pulses: if the mode is burst the user may select the number of pulses generated by the
trigger.

Delay: the output delay may be adjusted. The range is from 0 to 9 s (steps of 100 ns). If the
mode is external the delay steps are in external signal clocks.

Reset: the delay may be reset to the default value (0).

External Frequencies: the extemal input channels frequency may be displayed by selecting
the check box.

Signals buttons: each channel may be turned on and off by clicking the corresponding
button.
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6.36.9.2. Signal Display and lock

LOCK
AT
L1
1L L
C
.
T
ririr g

Time Base [ps] Auto,

The output channels signals are shown in the black window. The user may select the Time
base period. If auto is selected, the application shows four periods.

Lock: two or more output channels may be locked by checking the “lock” check boxes. If two

or more channels are locked, they are simultaneously tumed on and off when one of the
locked buttons is clicked.

160 Users Manual



Motion Studio

6.36.9.3. Internal Mode

Output waveforms are generated by the internal clock. The user may adjust the internal
frequency or period and the duty cycle. The channel may be inverted and gated by another
signal. The gate can be selected among the external inputs (0 or 1) or among one of the
other output channels.

The diagram below shows an example with the following configuration:

= Output channel 0: F = 100 Hz, duty cycle 50%, no gate.

=  Qutput channel 1: F = 50 Hz, duty cycle 50%, no gate.

=  Qutput channel 2: F = 100 Hz, duty cycle 50%, gate = output channel 0.

The output channel 0 frequency is 100 Hz. The output channel 1 frequency is 50 Hz. The

output channel 2 frequency is 100 Hz but the channel is gated by the output 0, so the result is
a signal which has 100 Hz frequency and a duty cycle of 25%.

Output Channel 0 (100 Hz - DC = 50%)

Output Channel 1 (50 Hz - DC = 50%)

Output Channel 2 (100 Hz — gate=chn 0)

Users Manual 161



Motion Studio

6.36.9.4. External Mode

162

Output waveforms are generated by an external signal. The user may adjust the output
channel divider and duty cycle. The output channel may be inverted and gated by another
signal. The gate can be selected among the external inputs (0 or 1) or among one of the
other output channels.

Let's assume that the external frequency is 200 Hz. The diagram below shows an example
with the following configuration:

=  OQutput channel 0: F = 100 Hz, duty cycle 50%, external input 0, no gate.

= OQutput channel 1: F = 50 Hz, duty cycle 50%, external input 0, no gate.

=  Qutput channel 2: F = 100 Hz, duty cycle 50%, external input 0, gate = output channel 0.
The output channel 0 frequency is half the external frequency. The output channel 1
frequency is one fourth the external frequency. The output channel 2 frequency is equal to

the external frequency but the channel is gated by the output 0, so the result is a signal which
has half the external frequency and a duty cycle of 25%.

External Input 0 clock signal (200 Hz)

Output Channel 0 (100 Hz — DC = 50%)

Output Channel 1 (60 Hz - DC = 50%)

Output Channel 2 (200 Hz — gate=chn 0)
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6.36.9.5. Start/Stop Mode
The two external signals drive the output signals generation. The input 0 starts the output,
while input 1 stops it. The frequency and delay of the output are configured as in “internal”
mode. No gate is allowed. When the stop signal level is high, the output signal is truncated.

The diagram below shows an example with the following configuration:

= Output channel 0: mode = Start/Stop, F = 100 Hz, duty cycle = 50%.

External Input 0

—

External Input 1

Output Channel 0 (F = 100 Hz - DC = 50%)

I
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6.36.9.6. Rate Switch Mode
The two external signals drive the output signals generation at two different frequencies. Input
0 starts the outputs at the frequency 1, while input 1 switches the frequency to the Frequency
2 value.
The diagram below shows an example with the following configuration:
=  Qutput channel 0: mode = Rate Switch, F1 = 100 Hz, duty cycle1 = 50%, F2 = 50 Hz,

duty cycle1 = 50%. When the input 0 level goes high, the output signal starts at 100 Hz.
When the input 1 level goes high, the output 0 frequency switches to 50 Hz.

External Input 0

External Input 1

[

Output Channel 0 (F1=100 Hz, F2 = 50 Hz)
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6.36.9.7. “Burst Single” Mode

In burst (single) mode, one of the external inputs or one of the output channels is used as
trigger to generate one or more pulses. The frequency and the Duty cycle controls are used
to determine the duration of the pulse. The generation of the pulses may be also delayed.
Both the output signal and the trigger may be also inverted.

The diagram below shows an example with the following configuration:
= OQutput channel 0: mode = Burst (single), Trigger = External Input 0, F = 100 Hz, duty
cycle = 50%, pulses = 3. The external Input 0 serves as a trigger. When the trigger goes

high, three pulses are generated by the output channel 0. The duration of the pulses is
about 5 ms (50 % of 100 Hz). The pulses are generated once.

Trigger (External input 0)

Output Channel 0 (F =100 Hz, DC = 50%)
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6.36.9.8. “Burst retriggered” mode

166

The Burst retriggered mode is equivalent to the burst single mode. The pulses are generated
any time the trigger signal goes high and not only once.

The diagram below shows an example with the following configuration:
Output channel 0: mode = Burst (retriggered), Trigger = External Input 0, F = 100 Hz, duty
cycle = 50%, pulses = 2. The external Input 0 serves as a trigger. When the trigger goes high,

three pulses are generated by the output channel 0. The duration of the pulses is about 5 ms
(50 % of 100 Hz). The pulses are generated each time the trigger goes high.

Trigger (External input 0)

Output Channel 0 (F =100 Hz, DC = 50%)

Users Manual



Motion Studio

6.36.9.9. Signal generation (Camera synchronization)

Current channel ‘ Chanrel 0 v ‘
Signal generation | Camera [simple] ‘
Camera ‘ Camera & b |
Mode ‘Inlemal V‘ [rwert [

The MotionPro Timing Hub may be used to synchronize a camera or other devices. The
signal generation options are:

e User: the output signal synchronizes an external device. No internal control is done by
the program.

¢ Camera (simple): the label edit box will be converted into a list of open cameras. In the
camera dialog bar the “Rate” control will be disabled, the “Rate Sync” control will be set to
“External” and the camera operation frequency will be configured directly from the timing
panel. If the “Sync Cfg" value is set to “Pulse High” or to “Pulse Low", the camera
exposure is controlled by the duty cycle of the external square wave. In this condition the
exposure edit box is grayed out and the value is automatically computed.

1. Ifthe “Sync Cfg” value is set to Pulse High, the exposure is equal to the inverse of the
output channel frequency multiplied by the duty cycle.

2. Ifthe “Sync Cfg” value is set to Pulse Low, the exposure is equal to the inverse of the
output channel frequency multiplied by (100 - duty cycle).

« Camera (XDR): the signals are generated to have the best results from the XDR mode.
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6.36.10. Analog Data Output

Motion Studio provides the controls for the generation of analog output with the MotionPro
Data Acquisition System (DAS). The available analog output channels in the module are four.

From the main toolbar select Tools > Analog Out.

6.36.10.1.

General
Petiod [us]:

Rate [Hz]:

General parameters and channels configuration

Sampling Source:

| 100000

| 10.00Hz | |internal

Sampling Rate:

Trigger Source:

v\@

‘ 10 KHz w ‘ i Software A ‘
Channel Configuration
Current channel |Channel 0 v ‘
Waveform; | Square v ‘
Amp [rm] OFfset [my] Phase [deqg]
: 10.0% S 100 - 360
- s.00y L 0.00Y 180°
: .00y -10.0% - 0°
so0 | (o | | [0 |

Period and Rate: select the period of the generated waveform. The corresponding rate in

Hertz is displayed.

Sampling Source: the sampling source may be the internal module clock or an external

digital signal.

Sampling Rate: select the sampling rate in Hz. If the sampling source is external, enter the

external signal frequency.

Trigger Source: the event trigger starts the waveforms output. It may be software, external

edge high, or external edge low.

Current channel: select the channel you want to configure.

Waveform: select the channel waveform: square, sine, triangle, saw tooth, or waveform file.

168
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Amplitude, Offset and Phase: if a waveform is selected, edit the amplitude, the offset and the

phase.

Browse: if the “File” option is selected, click the “Browse” button to open a data file. The file

will be played back.

Signals buttons: each channel may be turned on and off by clicking the corresponding

button.

Users Manual

General

Period [ps]: Rate: Sampling Src:
100000 || 10.00Hz | Internal
Sampling Rate: Trigger Source:

‘ 10 KHz W ‘ ‘ Software L' ‘

Channel Configuration

Current channel I ‘ Channel 1 b ‘

Waveform ‘ File w ‘

Wavefarm File:
AM., wim ‘

Rate: 10 kHz
Samples: 1000
Time: 100,000 ms

Erowse, ..
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6.36.10.2. Data display and lock

170

Time Base [s]: Auka,

The output channels signals are shown in the black window. The user may select the Time
Base period in ps. If auto is selected, the application shows four periods.

Lock: two or more output channels may be locked by checking the “Lock” options. If two or

more channels are locked, they are synchronously turned on and off when one of the channel
buttons is pressed.
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6.36.11. Galileo Wireless Sync/Trigger

Cameras and light sources can be synchronized with the Galileo Wireless System. For more
information about Galileo, please refer to the documentation.

From “Tools” menu, select “Wireless Sync/Trigger’.

"~ Wireless Sync/Trigger Configuration

‘Wireless Devices:

(] Serial Status Camera

W 1001 - ¥ GPS Sync/Trigger 0000010001 GPS - Batke, .,  ¥5 Camera
ﬂ_b 1002 - LED Light Sync 0000010002  GPS - Batte... Mone
(_:} 1003 - Trigger 0000010003 GPS - Batte,., Mone

Current Device Configuration
1001 - ¥ GPS Sync/Trigger

Pulse Width [Js]: Phase [us]: I:l

[I1llumination Adjustment, 1.0 v

[ Search new devices ]

[ Gek Devices Status I

3ain:

Cameras
Select a camera and use Add and Remove to assign devices to the camera:

Camera |5 Camera (MotionPro VS - 20-1108-0083) v/
Available devices: Assigned devices:
ID | Add > | j(u]
() 1002 - LED Light Sync 1001 - ¥ GPS Sync/Trigger
< 2 < ¥

Refresh List: click this button to enumerate all the wireless devices available in the ZigBee
network. Make sure that the coordinator USB key is correctly installed. The button is disabled
if one or more devices are listed in the “Assigned Devices” list.

Get Device Status: click this button to retrieve the current status of the wireless devices. The
status shows if the GPS signal is detected and the level of the battery (0 to 5).

lllumination adjustment and gain: select this option on a sync device to activate the light
Sensor.

Camera: select a camera from a list of all the available cameras. Once a camera is selected,
you may connect one or more wireless devices to that camera.

Add/Remove: click Add to connect a device to a camera. Click Remove to disconnect it.
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Once a device is connected to a camera, the devices parameters can be configured from
wireless dialog box or from the camera control bar.

Sync/Trigger Device: each camera can have only one camera device connected. The
camera frame sync is automatically set to “Extemal” and the “Sync Cfg” is set to “GPS". The
user can set the rate and the exposure from the camera control bar and automatically the
Period and Pulse width of the wireless device will be set to the same values.

LED Light Device: each camera can have more than one light devices assigned. The period
is set to the inverse of the camera rate and the pulse width can be configured from the
wireless dialog box. The phase can also be configured.

6.36.12. Giga-Ethernet cameras Network Configuration

172

See the “Configuration of Giga-Ethernet cameras” topic.
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6.36.13. Image Tile Utility

The Image Tile Utility is an external application that may be invoked by Motion Studio. It
allows the user to horizontally or vertically tile image sequences.

™ Motion Studio Image Tile Utility

Motion Studio

Image A:
| C:\Program Files\IDT\MationProXiImages\hgl 00_000%Imagh, avi Browse...

| 1504x1128 - 24 bit - 500 Fps - 300 Frames

Image B:
] C:\Program Files\IDT\MotionProXiImagesihgl00_0013Imas, avi Browse...

|1504x1128 - 24 bit - 500 Fps - 300 Frames

Image A+B:
l C:\Program Files\IDT\MotionProxXiImagesihgl00_0063ImgC. avi Browse...

3008x1128 - 24 bit - 5 fps - 300 Frames

File Type: IUncumpressed AT (% avi) L] Rate: |5
( Tile made -

E * Tile horizontally, E " Tile vertically,

[ Status
Ready!

bl

Stark |

Image A and Image B

Click the Browse button to select the sequences that will be tiled.
Image A+B

Click the browse button to select the name of the output image sequence.
File Type

Select the output image sequence type.

Rate

Edit the output file rate

Tile mode

The images may be tile horizontally or vertically tiled.

Start

Click this button to start the tile process.
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The image tile utility can be used with command line parameters. The syntax is below.
To display the help message:
XimgTile /H
To tile images:
XimgTile /A ImgA /B ImgB /O ImgAB /T OutType /V TileV /R Rate

where:

+ ImgA: full path of Image A (ex: C:\Program Files\iDT\MotionProX\imgs\VmgA.tif).

+ ImgB: full path of Image B (ex: C:\Program Files\\DT\MotionProX\imgs\mgB.tif).

+ ImgAB: full path of output image (ex: C:\Program Files\iD T\MotionProX\imgs\mgAB.tif).

« OutType: output file type (1:TIF, 2:BMP, 3:JPG, 4:PNG, 11:MPT, 12:MRF, 13:AVI,
16:MPG).

+ TileV: 0 for horizontal tile, 1 for vertical tile.

« Rate: output file rate, only for file image formats that support the parameter (ex: AVI).
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6.36.14. Language Selection

1. From the Tools menu, select “Language...”

2. Select the language from the list and click OK.

Currently the supported languages are English, German, ltalian, Japanese and Chinese.

Users Manual

Language

@

Select the language from the list

below:
‘English v ‘
[ ok | [ Cancel
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6.36.15. Vidi Motion

For a detailed description of the Vidi Motion tool, please refer to the Vidi Motion topic.
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6.37. WINDOW menu

If more than a window is open in the Motion Studio program, use the window menu to
cascade, tile horizontally, tile vertically or select one of the windows.

6.38. HELP menu

This menu contains support options and information including: e-mail tech support and
software and manual updates.

Help

'.Q_)J gontents j |‘f_—m| s (el (;"
| Wweb Site #] Home page...

Cameras info. .. #] Technical Suppaort. ..

About...
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6.38.1. Camera Information

Cameras Info displays a dialog box with the information about the cameras, such as model,
type (color or black and white), ID and serial number. The information may be saved in a text
file by clicking the “Save...” button.

From the main toolbar, select Help > Cameras Info.

178

Cameras Information

" JCam_2304070244 - MotionPro X3 (USE 2.0)
BB Carn_2304070244 - MationPro X3 (GigaBit)
Current Device Info
Lirk:
Description Yalue
Link Type Usg 2.0
Yendor ID 0x04E4
Product ID 0x4346
Part Mumber 0
Device:
Description Yalue ~
Camera Mame Cam_2304070244
Serial Number 23-0407-0244
HW Revision E
Color Yes
Madel %3
Calibration File Yes
EEPR.COM Firmware Yersion 4
Controller Firmware Yersions 51 - 07 =
IRIG Yes
Intensified Mo v
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7. Vidi-Motion (Lens calculator)

7.1. Overview

Vidi-Motion contains the most important specifications of the Redlake Motion cameras, a lens
calculator and an overview of the current lenses available from Redlake. With Vid-Motion you
may:

Calculate resolutions, amount of motion blur, correct exposure time, depth of field, hyper
focal distance etc.

Find compatible lenses, based on the selected amount of pixels, pixel size, the field width
and focal length.

Review lens specifications such as: f-stop, size, weight, minimum object distance.

Calculate the speed at impact, of a free falling object. It is assumed that the object falls in
vacuum, thus no compensation for air resistance is included.

Calculate the circumference speed of a spinning object.
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7.2. Camera information

Select the camera Family first, then the camera model.

MotionPro HS: HS-1, HS-2, HS-3, HS-4, SI-3, Sl-4.

MotionPro X: X3, X4, X5

MotionPro Y: Y3, Y4L, Y5, Y6, Y7-HDiablo

MotionXtra N: N3, N4, N4L, N5

MotionScope M CameraLink: M3, M5

MotionPro: 500, 2000, 10000.

MotionScope M (old): M1, M2, M3.

MotionXtra: HG-2000, HG-TX, HG-SE, HG-LE, HG-TH, HG-100K, HG-XE, HG-XR, HG-N.
MotionScope: 1000, 2000, 8000.

MotionCorder: SR-500, SR-1000, SR-3000, SR-ultra.

MotionMeter: 250, 1000

Once you have selected the Camera Model, several textboxes will be updated with the
camera specifications. The default values are:

e Maximum Memory configuration.

¢ Maximum Recording Speed at maximum Horizontal and Vertical Resolution.

« Exposure Time of 1 divided by Recording Speed.

Select the Memory configuration: Maximum Session Length and Record Time will be
recalculated.

Select the Horizontal and Vertical Resolution: Maximum Session Length, Record Time
and Recording Speed will be recalculated.

Adjust the Recording Speed to the frame rate you want to capture images at. The Record
Time and the Exposure Time are recalculated.

Adjust the Exposure Time at the correct time, if it is known or leave it as it is and calculate it
later.

Camara Information

Famity Mode

[ eiariprn v Wotion®ro X3 v Pixe! Size 12 um Bidepth 5
Sensor Size, Horlzortal [15.36 mim Binning Yes
it Sensor Size, Verlcal iru-?ﬁa mm Double Exposure Yes ]

Wamory E;ﬂom;am serce Sansor Size, Diegonalilg-ﬁ? mm RIGASPS Time Ction/Ogtion
id v_;_Ob_ .1280 v _51024 :. Iinimum Exposure Time (1 (T Veri. Res. 4.3 950

Madmum Session Length | 3272 \art. Res. 16:9 720
Recording Speed Exposure Time M aximum Frame Rate 51040 frisac Fecord Time 3146 SEL
51040  risec .952 :Eusec Max. Frama Rate Flus Mudc! frissc

Available Inlnu:“! USB-2, GlgabitEthernet (Optionaly Live Out
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7.3. Basic Calculations

Basic Calculalions | Lens Datails & Dapth OF Field | Spesd Calculstions

Selact Subject Units
Fiald of Viaw v | mm v Resolution|0.1579 mm ¥ [ per pixel
Field Width Ficid Height Resclution|5 35238 plxeleger  |mm ]
21504 mm | |17203122 mm Diagonal Field Angle of Wiew| 1735 degrees

[

22.25
Obledt batunse Focal Length Horizontal Field Angle OF View degraes
700 ] | |50 mm Image Dlagonal|19.67 mm

Magnification| 0.07142
Compatible Lens 'I'ypa!f- and PL-mount
Object Velocity Units oy T
ji £ mm
2? [ miseo v Object Movement per Frame :
- T Object Motion Blur 240488 [mm Object Fixel Bluy 14431547

7.3.1. Lens calculations
Several calculations are combined here.

Select the calculation of Focal length, Field of View or Object Distance. Later you need to
input the remaining parameters.

Choose the measurement unit
Input the two remaining values

The result will be displayed including: Field Height, Resolution, Angle of View, Image
Diagonal, Magnification factor and the compatible lenses types.

If the lens specifications shown are not compatible with your lens, you need to lower the
Horizontal and Vertical Resolution to avoid “vignetting”.

The units of the results can be independently chosen, in the drop down box “Resolution”.

7.3.2. Fast moving objects
¢ Input the object velocity here and choose the correct unit (m/sec, km/h, feet/s, and
inches/s).

e The Object movement per frame, the object motion blur and the object pixel blur are
calculated.

e The units are equal to the choice made in the drop down box “Resolution”.
e Ifthe object movement is too big: increase the recording speed.

¢ |fthe motion blur is too high: lower the exposure time.
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7.4. Lens details and depth of field

Show Lenses filkared with:

I
Focal Langth + Opfical Diamster+ Minimum Object Dist, v Maximum Ralative Apartura 1.2 Format|F
Minimum Object Distancs 500 mm alght|300 a
Fooallegh Dimensions[88575 | mm Mount|F
2RTE Filter Size 92 mm Compatible mm.| all
28105 [
Fart # Ropar Seientifie By, SAME8165-001 | Comment|
T [
Ralative Lens Aperure Dapih of Field Infinity |mm Near Focus | 61.90351 !mm
1 b HyparFocal Distance 825 |mm Far Focus| Infinity |r'"n

Effective Aperure 1.07

According to the lens calculation results, compatible lenses are listed here. The list can be
filtered to include the following specifications:

e Focal length + optical diameter + minimum object distance
¢ Lens type + minimum object distance

e Lenstype

e No filter

Select a lens in the “focal length” box to display the product details and part number.

7.4.1. Depth of field and hyper-focal distance

Select the relative lens aperture. The following parameters will be calculated.

¢ Depth of Field.

¢ Near focus.

e Farfocus.

¢ Hyper focal distance.
o Effective aperture.
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7.5. Speed calculations

Speed calculations include circumference speed and falling objects speed.

Basic Calculstions | Lens Details & Depth Of Fisld | Speed Calculations

Select Caleulation Speed of spinning object
Circumference Speed W !1!]3 | rewtmin

Diamater of object

Aot blonliad iy ST

|20 i e Objest Velosity 1.04588 | misec

7.5.1. Circumference speed
The object circumference speed can be calculated if the following is known:
¢ The speed of the spinning object (rev/min).
¢ The diameter of the object (cm).

The result is shown in m/sec.

7.5.2. Falling objects

The theoretical speed at impact of a falling object can be calculated here. The speed at 0
meter is assumed to be equal to 0.

« Input the distance form object to the impact point with the correct unit (m or ft)

e The speed at impact units are in m/sec or km/hr.

Note: Decimal signs are shown according to the “decimal setting” of the Operating System.
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8. Frame Synchronization and Event Triggering

8.1. Overview

The camera and software enable external sync and triggering capabilities. The camera is
synchronized externally via a trigger source in the form of a TTL pulse. The synchronization
INPUT signals as well as a synchronization OUTPUT signal are handled through BNC
connectors. The synchronization signal is output for every frame that is acquired and can
supply the time reference for other pieces of hardware, for example a strobe for illumination.

Two options are available:

1. Cameras with 2 BNC connectors: 1 input connector is used for synchronization and
event triggering. The output connector is used for sync out.

2. Cameras with 3 BNC connectors: a “Trig In” connector is used for event triggering, a

“Sync in” connector is used for external synchronization. The output connector is used for
sync out.
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8.2. Record Modes and Trigger Configuration
On the Record tab, the default Frame Sync source of the camera is set to Internal. If in
External, the camera must have an external Sync signal.
TRIG IN: use the Trigger in connector at the back of the camera for event triggering.
SYNC IN: use the Sync In for external synchronization.

SYNC OUT: use the Sync Qut for sync out.

. Trigger In
Record Mode Sync In Configuration Configuration
: Ignored (the camera
Internal or external (the BNC is :
Normal : ] does not require event
used to provide a sync signal) trigger)
Circular/BROC Internal or exﬁernal (the BNC is All yalues (the camera
used to provide a sync signal) requires an event trigger)
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8.3. Change the Sync and the Trigger

1. Select the Record tab.

2. Use the Frame Sync drop-down list to select from the following options:

Select Internal to acquire frames continuously at a rate that is dependent on the frame
read-out time and the exposure.

Select Extemnal to wait for an external trigger input to acquire frames. An external signal
must be provided.

3. In external mode, the camera waits for an external sync input to acquire a frame. Use the
Sync Cfg drop-down list to select from the following options.

Select Edge-High to trigger on the positive going slope of the signal.
Select Edge-Low to trigger on the negative slope of the signal.

Select Pulse High mode to set the duration of the exposure to equal the trigger signal
duration (High state).

Select Pulse Low mode to set the duration of the exposure to equal the trigger signal
duration (Low state).

The time delay between the trigger signal and the acquisition of the image is less than 20 ns.

If the record mode is set to “Circular” or “BROC” each acquisition requires an event trigger.
To set a trigger, click on the Trigger button on the Camera Control tab for a software trigger,
or use an external trigger source.

1.

il
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Select the Record tab.
Use the Record Mode drop-down list to select BROC or Circular.

Use the Trig Cfg drop-down to select from the following options: Edge High, Edge Low,
and Switch Closure.
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8.4. Exposure Modes

To set the Exposure mode, Camera tab > Exposure Mode pull-down list indicate Single
frame, Double (two frames consecutively) or Extended Dynamic Range (XDR). In the timing
of these acquisitions, the first frame is acquired each time the internal clock of the camera or
an external trigger is present. The exposure for this first frame is equal to the exposure
setting parameter. The second frame with an exposure that is equal to the frame read-out
time (the value depends on camera model and Region of Interest) is acquired within 100 ns
from the first one. The exposure ratio control shows the ratio between the first exposure and
the second.

Extended Dynamic Range (XDR): in this mode the camera operates in double exposure and

the image pairs are combined to increase the camera dynamic range. If this mode is enabled
the exposure control contains the sum of first (configurable) and second (fixed) exposures.
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8.5. Triggering the camera and synchronizing with strobe
illumination

The camera cab is used together with a strobe for illumination. In this case it is necessary to
synchronize the illumination pulse event with the camera exposure. Examples of methods
that can be employed are presented in the following. The schematics of various timing
diagrams are included. This diagram assumes the use of an externally pulse(s) (TTL) to
synchronize both the camera and the strobe.
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8.5.1. Synchronizing via the leading edge of a pulse event (Single
exposure)

The figure shows the timing signals in a single exposure configuration. In the Record Tab the
frame sync is set to “External Edge-High” and the exposure mode is set to “single”. The
camera exposure is started by the leading edge of the pulse signal and the exposure duration
is set in the “Exposure” control of the camera software panel.

Definitions:

¢ Input sync pulse is TTL level.

e lllumination pulse duration: typical 7-10 ns for flash lamp and 100-150 ns for diode
pumped lasers respectively).

e Camera exposure > lllumination latency + lllumination pulse duration.

_"q— INPUT Sync Pulse (o camera and laser)

llumination Pulze

— |<— Strobe latency

_ I Exposure (st in camera configuration)

—= |&— Camera latency (~ 15 - 20 ngec)
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8.5.2. Synchronizing via the trailing edge of a pulse event (Single
exposure)

The figure shows the timing signals in a single exposure configuration. In the Record Tab the
frame sync is set to “External Edge-Low” and the exposure mode is set to “single”’. The
camera exposure is started by the trailing edge of the pulse signal and the exposure duration
is set in the “Exposure” control of the camera software panel.

Definitions:

¢ Input sync pulse is TTL level.

e lllumination pulse duration: typical 7-10 ns for flash lamp and 100-150 ns for diode
pumped lasers respectively).

e Camera exposure > lllumination latency + lllumination pulse duration.

—L INPUT Sync Pulse (o camera and laser)

lllumination Pulse

—= k— Strobe latency

Exposure (set in camera configuration)

—=} |=— Camera latency (~ 15 - 20 nsec)
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8.5.3. Synchronizing and controlling the exposure with an input pulse

The figure shows the timing signals in a single exposure configuration. In the camera panel
the frame sync is set to “External Pulse-High” and the exposure mode is set to “single”. The
camera exposure is integrated over the high part of the input pulse and the camera ignores
the exposure value set in the “Exposure” control of the camera software panel.

Definitions:

e Input sync pulse is TTL level.

¢ |llumination pulse duration: typical 7-10 ns for flash lamp and 100-150 ns for diode
pumped lasers respectively).

e Camera exposure > lllumination latency + lllumination pulse duration.

_ | INPUT Sync Pulse (to camera and laser)
_'I | llumination Pulse

—=4 &— Strobe latency

_I | Exposure (equalto trigger pulse duration)

—» |&<— Camera latency (~ 15 - 20 nsec)
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8.5.4. Synchronizing in dual exposure mode

The figure below shows the timing signal in a typical double exposure PIV configuration. In
the camera panel the sync mode is set to “External Edge-High” and the exposure mode is set
to “double”. The time between the two laser pulses must be larger than the sum of the first
laser pulse duration and the camera frame transfer time. The second exposure duration
cannot be set and depends from the camera frame readout, so the second laser pulse
duration must be configured to the desired exposure time.

_ 1stlaser pulse (~120 ns)

_’{q— Sync Pulse to camera and 1st laser
|

Sync Pulse to 2nd laser

-—I— 2nd laser pulse

&>
Laser pulse separation
Camera exposures:

| exp: laser pulse duration.
| ]
_J s e Il exp: frame read-out time.
— Camera frame transfer time (~100 ns)
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9. Motion Studio Remote Control

9.1. Overview

The camera may be remotely controlled by a Pocket PC. The requirements are:

1. A Windows 2000/XP personal computer (the “host”) with the following items: the camera
and software, a 10/100/1000 Ethernet network card or an 802.11b (wireless) network
card.

2. A pocket PC (the “client”) with the following items: Windows Mobile 2003 Second Edition,
the Motion Studio Remote Control software, and an 802.11b (wireless) network card.
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9.2. Software installation

To install Motion Studio on the host, follow the instructions on the Quick Start Guide.

To install the “Motion Studio Remote Control” on the Pocket PC, you need Microsoft
ActiveSync installed on your computer. There are two ways to install the Remote Control.

1. When installing Motion Studio, the setup asks for the Setup type among Typical, Full and
Custom. Select custom and check the Remote Control Option. Then follow the on-screen
instructions.

Motion Studio (Ver. 2.06.00)

Select Components

Choose the components Setup will install,

Select the components vau want ta install, clear the components you da not want ta install.

Mation Studio
LabVIEW Vs

MATLAE Interface
SDK files and examples
Twsain Diiver

Femaote Contral

Activer Control

Space Required on C:
Space Available on C:

-~ Description

< Back | Nest » I Cancel

This component includes the
Remaote Control Client
application.

2. Run the xstream_rem.exe self-extracting file from the Remote subdirectory of the Motion

Studio CD and follow the on-screen instructions.

Both the install options copy the remote Control Install files to the XRemote sub-directory of

the Microsoft ActiveSync application.
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To install the Remote Control to the Pocket PC:

1. Locate the XRemote subdirectory in the Microsoft ActiveSync folder.

2. Run the CElnstall.exe application and follow the on-screen instructions.

Users Manual

. Add/Remove Programs Ed

—

Select a program's check box if you want to install it on your
mobile device, or clear the check box if you want to remove the
program from your device.

MNote: If a program that you installed is not listed, the program was
not desighed ta be used on your mobile device.

SDT Motion Studia Remate Control 2026 K

i~ Program deszcription -

Mation Studio Remote Control

Space required for selected programs: 2026 K
Space available on device: 29,2452 K

v Install program into the default installation folder

 Remove from bath locations
To remove the zelected program from both A
vour device and this computer, click Remove,  DEMOVE.. |

| 0K I Cancel I Help |
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9.3. Configuring the wireless connection

In order to remotely control the camera from the client, the wireless connection requires to be
configured.

A wireless network may be of two types: “infrastructure” (usually used when a wireless
router is present on a LAN) and “ad-hoc” (computer to computer connection, usually used
when no wireless router is present on a LAN).

Both types of wireless connection may be used to remotely control the camera.

9.3.1. Configuring the host

The computer running Motion Studio can have more than one network card. In this section,
we show the configuration of the wireless card in a computer to computer (ad how)
connection. We suppose that the host computer is connected to the corporate LAN via the
Ethernet card and the wireless card will be used in a dedicated connection to the Pocket PC.

From the Start Menu, select All Programs, Accessories, Communications, and Network
Connections. The window below will appear.

S Network Connections EI@@
File Edit View Favorkes Tools Advenced Help >
_/ l" P ) Search i Folders 3-

t), Netwaork Connections bt | Go
A1 Name Type Status
LAN or High-Speed Internet

Create a new <L 1394 Connection LAN or High-Speed Inbernet Connected, Firewalled

connection

i[9 7 : i 2
SR Wireless Network Connection LAN or High-Spead Internet Mot connected, Firewalled
office network L Local Area Connection LAM or High-Speed Internet Connected, Firewalled

Change Windows
Firewall settings

[5p) View available wireless
nekwarks

&% Disable this netwark
device

&, Repar this connection

Q‘-D Fename this connection

Change settings of this
conneckion v

1EM High Fuabe Wireless LAN MiniPCI Combo Card

If the wireless card is not connected to any wireless connection, the wireless connection
status is shown as “disconnected”.

Right click on the “Wireless Network Connection” item and select Properties. Then select the
Wireless Networks Tab.
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- Wireless Network Connection Properties ‘E]@

General wireless Metworks ‘ Advanced|

[V]iU ze Windows ko configure my wireless network. setings

Available networks:

To connect ta, disconnect from, or find out more information
abaout wireless networks in range, click the button belaw.

[ View Wireless Networks ]

Preferred networks:

Automatically connect to available networks in the order listed
below:

Move up

Move down

[ Add... ][ Remove ][ Propeties ]

Learn about setting up wireless netwark
confiquration, =

I DK ][ Cancel ]

The dialog box shows the available wireless network. Click the Advanced button. The
following dialog box appears.

Advanced E[@

Metwarks to access

() Any available network [access point preferred)

() Access point [infrastructure] nebworks only

(®)iComputer-to-computer [ad hoc) netwarks only

[] Automatically connect ta non-preferred networks

Cloze

Select the “Compute-to-computer (ad hoc) networks only” option, to display only the
dedicated connections. The click Close and then click the Add button. The following dialog
box appears.
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Wireless network properties

Association |.Aulhenticalion | Connection |

Network name [SSID): ‘ mynetw ‘

Wireless network key

This network requires a key for the fallowing:

Network. Authentication: | Open v |
D ata encryption: | WEP 3 |
Metwork key: essne ‘
Confirn network ke ‘ senes ‘

Key index [advanced): 1 =

[ The key is provided for me automatically

Thizizac cecomputer [ad hoc] netwaork; wireless

ACCess

[ ok || conce |

Edit the network name (SSID), uncheck the “The key is provided for me automatically” option,
enter the Network Key and then confirm it. The network key is a password which is required
to authenticate the connection. You will be required to enter the same key when you will
configure the Pocket PC wireless connection.

Then click OK. The new network appears in the preferred networks list, but it’s still not active.
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L Wireless Network Connection Properties [Elz|

General  Wireless Networks ;Advanced

Usze Windows to configure my wirglsss network. sethings

Available networks:

To connect to, disconnect fram, of find out mars information
about wirelezs networks in range, click the button below,

[ Wiew Winsless Metworks I

Preferred networks:

Automatically connect to available networks in the onder isted
belowr

F=3 munebs [Automatic) Move up

Move dowr

[ Add... H Remove H Froperties l

Learn about setting up wireless network =
e

I 0K ][ Cancel ]

From the Wireless Network connection Properties dialog box, select the General Tab as
shown below.

- Wireless Network Connection Properties FEE|

General | Wireless Metworks | Advanced

Connect uging:

‘ EB IBM High Rate Wirsless LAN MiniPCl ‘ [ Comigwe. ]

This connection usas the following items:

¥ B Ciient for Microsolt Netwarks
vl Q File and Printer Sharing for Microsoft Networks
/=005 Packet Scheduler

v |nternet Protocol [TCPAIP)

Dezcniption

Transmizzion Control Protocol/|ntemet Pratocol. The default
wide area network protocol that provides communication
across diverse interconnected networks

Show icon in notification area when connected
Motify me when this connection has limited or no connectivity

[ ok [ cancel |

Select the Internet Protocol (TCP/IP) item, and click Properties. The following dialog box
appears:
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Internet Protocol (TCP/IP) Properties

General |

the appiopriate IP settings.

(O Obtain an IP address automatically

‘Y'ou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you neead to ask your network. administrator for

IP addiess:

[132.163. 10 . 11

Subnet mask:

Default gateway: |

|
| 265.255.255. 0 |
|

Obtain DMS erver address automatically

(&) Use the following DNS server addresses:

Preferred DNS server: |

Alternate DNS zerver |

Select the “Use the following IP Address” option and enter the IP address and the subnet
mask. Make sure that your IP address is not duplicated in the network. Otherwise the

connection would be refused.

Click OK, then OK again and wait a few seconds until the wireless connection shows its

status as “Connected” (see the picture below).

® Network Connections

Flle  Edit Favorites Touols Advapced Help

L) Eack J. |I’ jﬁ] Search |_ Folders v

Wiew

fiddress | @ Network Connections

| Hame
Network Tasks | LAN or High-Speed Internet
Create a new ~ | <1394 Connection

connection
9 Set up a home or small

office retwork

g Change Windows b
Firevsall settings

G0 View availsble wireless
networks

@E Diszble this network
device

Wireless Metwork, Connection
L Local Area Connection

% Repair this connection
®[| Rename this connection

& View status of this
connection o

Type

LAM or High-Speed Internet
L&M or High-Speed Internet
LAM or High-Speed Internet

Status

Connected, Firewalled
Connected, Firewalled
Connected, Firewalled

IBM High Rate Wireless LAN MinPCI Combo Card

The message below will appear from the status bar.
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7 Wireless Network Connection is now connected

Connected to: mynetw
Signal Skrength: No Signal

NOTE: if the wireless network connection is protected by a firewall, make sure that the
port 8164 is open to the TCP and UDP traffic.
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9.3.2. Configuring the client (Pocket PC)

From the Windows Mobile Start menu, select the Settings item. Then select the Connection
Tabs as shown below.

Fodl ERELE I )
Beam Bluetooth  Connections

(o] 2o e
A F &

Dell WLAN Network Odyssey
Utility Cards Client

Personal | Sysbeml Connedichnsl

=[8

Select the Connections item. The screen below appears:

&t a0 D
Configure Network Adapters £? )

My network card connects to:

Waork

Tap an adapter to medify settings:
NE2000 Compatible Ethernet Driver
L2TP NDISWAN Miniport

AsyncMac NDISWAN Miniport
PPTP NDISWAN Miniport

Dell Axim X50 WLAN Wireless Adapter
Bluetooth PAN User Driver

— -

Make sure that the “My network card connects to:” option is “Work”, Then from the list of
network adapters (you may have different models on your Pocket PC) select your wireless
Adapter.
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Dell Axim X50 WLAN Wireless Adapter

D Use server-assigned IP address

(@) Use specific IP address
IP address: (192 . 168 10 . 11 |

Subnet mask: [255.255.255. 0 |

Default gateway: | : : : |

IP Address | Mame Servers |
sl 1]z ]3lalslelzls]olal-|=]®
TathJv‘;IEJrJtJvJuJiJop ]

Select the “Use specific IP address” option and enter the address and the subnet mask. The
subnet mask must be the same as the one entered in the host TCP/IP configuration. The IP
address must be different from the host’s.

Then click OK and disable/enable the wireless card to let the configuration changes take
effect.

When the new changes take effect, the wireless connection starts and the message box

below shows up:

"mynetw" network connects me to:

() The Internet
(® work

If this network connects to work via a VPN,

select The Internet,

Settings | connect || Hide |
S ’

Select the “Work” option and click connect. You will be asked to enter the network key as

shown below

Metwork "mynenw” may require a key, If you
have = Metwork key, enter it and t=p
Connect, Otherwise, just tap Connect,

Key: |
Settings Connect | | Cancel |

%\, A
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Enter the network key you entered in the host connection configuration (see above) and click
connect. If the connection starts the dialog box below appears.

Tha Intarnat PC connection
Wi-Fi {(mynatw) Connected il

Settings
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9.4. Using the Motion Studio Remote Control

9.4.1. Starting the remote server on the Host

1. Run Motion Studio.
From the main menu select Options.

From the General Options dialog box, select the Camera Tab and check the “Enable
Remote Connection server” option. Then click OK.

Open a camera window.
From the Camera menu, select the “Start remote Connection Server” item.
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9.4.2. Running the Remote control on the Pocket PC

1. From the Pocket PC Start menu, select Programs.

2. From the Programs window, select the “Motion Studio Remote Control” application and

start it.

H 4 |Programs = 0P 41251 9

(sl ?‘]
s l

»® B
3 U

X W

Gamas Caleulator Data Backup

Pocket Excel Pocket MSN Pocket Word

&
>

Matian

Remote
Control

LG

Pictures

W

W

§|..

The program will set the Pocket PC landscape view and show the following screen.

Server IP Address:
l192.168.10.10 |

|Enter selver IP address and connect,

| Connect

Servers list:

192.165.10.10

Search

To start the connection to the host, a valid |IP address needs to be entered. If the host
connection is active and the server has been activated in Motion Studio, the IP address is
shown in the Servers list. Otherwise, click the Search button. If no IP address appears in the
servers list, enter the address manually. Then click connect and start the remote control.
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The application includes a configuration panel on the right, a control bar on the bottom and a
main toolbar.

Configuration panel

192.168.10.10 Br 45 1005 (D

Flames [100

> RecMode |Marmal

s

O (L) Do s

Grelaghachatn * ColorCheckes Color Rendition Chart

Control Bar Main toolbar

The Control Bar has camera control functions including the following:

Record.

Stop/Snap a single image.
Live play of images.
Trigger.

Camera selection: if more than one camera is active on the host, you may select which
camera to operate.

The Configuration Panel allows configuring the main camera parameters, such as:

Exposure.

Acquisition rate.

Automatic save on images after acquisition (auto-save flag).
Number of frames to record.

Record mode.

Sync mode.

The Playback controls work like other familiar media player controls. The controls
include the following:

Directional play

Forward or reverse

Step forward and reverse
Skip to first or last frame
Stop play
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The Main Toolbar has controls for zoom and pan the image, including the following:

e Zoom In.
e Zoom Qut.

e Toggle the pan window.

2 |192.168.10.10

B A< 10:00 (D

B [us] :_;JI

R 0 |~
|_| AutoSave

Flames |100

RecMode | Marmal

O (L) DO s

SNl IR R Y
W o b | ieody e s ) omyy
EREIE] |-

When the pan window is enabled, the user may drag the red rectangle and locate the area of

the image to display.
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10. Appendix A Product Specifications

10.1. Mechanical and hole mounts (MotionPro Y)

10.1.1. Front and back views

[102.67]
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l
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10.1.2. Side view

@l
I g

8

[228.28]
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10.1.3. Top View

(79.48]
3.14
[22.99]
0.91 5y
1/4"-20 UNC
¥ .375" (3/8")
~
N N
l."’)' (nt|
'C!_'J P
o <
o™
% >3(2 UNC
=~ b € o |¢ T 9/32"
O
sl L )
=< e
| Q el |
\lNSERT, EXT. 1/4-28
193.58] INT. 8-32 X 9/32 LENGTH
' W/ NYLON PATCH
| 093
[79.08]
311
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8-32 UNC
¥ 9/32"
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3X

g€
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20T
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Bottom view
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Mounting plate

Motion Studio
10.1.5.
Front View
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Side view

0.188
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10.1.6. Top mounting plate
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Side view

4%

0l&
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10.1.7. First revision camera front view
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10.1.8. First Revision camera top view

0
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10.1.9. First revision camera side view
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10.2. Mechanical and hole mounts (MotionXtra N)

10.2.1. Front View

T-MOUNT
M42 X .75

C-MOUNT
1.000-32 TPI
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10.2.2. Back Views
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10.2.3. Side View
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10.2.4. Top View
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10.2.5. Bottom View
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10.3. Mechanical and hole mounts (MotionScope M)

10.3.1. Front View

Rl
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10.3.2. Back View
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10.3.3. Side View
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10.3.4. Side View with mount
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10.3.5. Top View
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10.3.6.

Bottom View
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10.3.7. Bottom View with Mount
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10.4. Mechanical and hole mounts (MotionPro X)

10.4.1.
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10.4.2. Bottom view
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10.4.3.

Side view
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10.5. Camera specifications

10.5.1. Y-Series
MotionPro Y

Y3 Y4L Y5 Y6 Y7 HD
Sensor Array 1280 x 1024 1016 x 1016 2352 x 1728 1504 x 1128 1920 x 1080
Pixel Size 12 13.7 TH 16 125
Sensor Bit Depth 10 10 10 12 12
Image Bit Depth : s ; : ;
(mono) 8/10-bit 8-bit 8/10-bit 8/12-bit 8/12-bit
Image Bl Dapth 24/30-bit 24-bit 24/30-bit 24/36-bit 24/36-bit
(color)
sensorDynamic 59 dB 60 dB 60 dB 66 dB 66 dB
Range
Analog to Digital . . . . .
convateion 10-bit 10-bit 10-bit 12-bit 12-bit
Sensor aspect 3 2 : ; ;
ratlo 54 121 4:3 4:3 16:9
Pixel Fill factor 40 % 40 % 55 % 67% 67%
Center to center
spacing 12 hm 14 ym 7 Hm
Sensitivity (mono) 3,000 ASA 6,000 ASA 2,000 ASA 9,000 ASA 9,000 ASA
Sensitivity (color) 1,000 ASA 2,000 ASA 800 ASA 3,000 ASA 3,000 ASA
Internal clock 90 MHz 140 MHz 90 MHz 66 MHz 66 MHz

Memory

Configuration 4GB, 8GB, 16GB
Configurable

binning 1x1, 2x2, 3x3, 4x4
Shutter Global, 1 ps min exp, efficiency>98

Synchronization

BNC 3.3 V CMOS

Cable

Standard USB 2.0 to 5 m, 15 m with optical repeater

CAT. 5 or CAT. 6 Ethernet cable

Operating system

Windows 2000, XP, Vista, MAC OS X

Gain

Programmable gains and high/middle/low 8-bit selection

Size and weight

90.5 x 90.5 x 320 mm, 2.0 kg (2.45 kg with optional battery)

Lens Mount

C-mount, F-mount (Nikon and Canon)

Tripod Mount

Standard %-20 photo mounts
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10.5.2. N-Series

MotionXtra N

N3 /N3L N4/ N4L NS
Sensor Array 1280 x 1024 1016 x 1016 2352 x 1728
Pixel Size 12 pm 13.7 pm 7 um
Bit Depth 10 10 10

Image Bit Depth

8, 9, 10-bit mono
24, 27, 30-bit color

8, 9, 10-bit mono
24, 27, 30-bit color

8,9,10-bit mono
24 27, 30-bit color

Sensor Dynamic Range 59dB 60 dB 60 dB
conen 10-bit 10-bit 10-bit
Sensor aspect ratio 54 1:1 4:3

Pixel Fill factor 40 % 40 % 55 %
Center to center spacing 12 pm 14 um 7 Kim
Sensitivity (mono) 3,000 ASA 6,000 ASA 2,000 ASA
Sensitivity (color) 1,000 ASA 2,000 ASA 800 ASA
Internal clock 90 MHz 70 MHz 90 MHz
Compression Yes No Yes
Memory Configuration 1.25 GB, 2.5 GB 1.25 GB 125 GB, 2.5 GB

Configurable binning

1x1, 2x2, 3x3, 4x4

Shutter

Global, 1 pys min exp, efficiency>99

Synchronization

SMA 3.3 V CMOS

Cable

CAT. 5 or CAT. 6 Ethernet cable

Operating system

Windows 2000, XP, Vista, MAC OS X

Gain Programmable gains and high/middle/low 8-bit selection
Size and weight 75x55x 55 mm, 320 g

Lens Mount C-mount, F-mount (Nikon and Canon)

Tripod Mount Standard ¥2-20 photo mounts
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10.5.3. M-Series

MotionScope M

M3 M5
Sensor Array 1280 x 1024 2320x 1728
Pixel Size 12 TH
Bit Depth 10 10
Image Bit Depth St 24-bi color
Sensor Dynamic Range 59 dB 60 dB
Analcg fo Digital 10-bit 10-bit
conversion
Sensor aspect ratio 5:4 4:3
Pixel Fill factor 40 % 55 %
Center to center spacing 12 TH
Sensitivity (mono) 3,000 ASA 2,000 ASA
Sensitivity (color) 1,000 ASA 800 ASA
Internal clock 72 MHz 40 MHz
Memory configuration Computer memory
Video Output Type Full camera Link

Video Data Output Mode

10 taps 8 bit each

Configurable binning

1x1, 2x2, 3x3, 4x4

Shutter

Global, 1 us min exp, efficiency>99

Synchronization

SMA 3.3 V CMOS

Cables

2 MDR 26-pin Camera Link Cables

Operating system

Windows XP, Vista

Gain

Programmable gains

Size and weight

75 x 55 x 55 mm, 320 g

Lens Mount

"C-mount, F-mount (Nikon and Canon)
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10.5.4. X-Series
X-Stream XS - MotionPro HS/X
XS-3/ HS1 HS3 /X3 X4 X5

Sensor Array 1280 x 1024 1280 x 1024 512x 512 2352 x 1728
Pixel Size 12 12 16 p TH
Bit Depth 10 10 10 10

: 8/10-bit mono 8-bit mono 8-bit mono 8-bit mono
Image:BlkDepth 24/30-bit color 24-bit color 24-bit color | 24-bit color
Sensor Dynamic Range 59 dB 59 dB 57 dB 60 dB
Analog to Digital . . . .
conversion 10-bit 10-bit 10-bit 10-bit
Sensor aspect ratio 54 54 1:1 4:3
Pixel Fill factor 40 % 40 % 62 % 55 %
Center to center spacing 12 12 16y 7y
Internal clock 85/90 MHz 90 MHz 90 MHz 66 MHz
Memory Configuration 1GB,2GB,4GB
Configurable binning 1x1, 2x2, 3x3, 4x4
Shutter Global, 1 pys min exp, efficiency=99
Synchronization BNC 3.3 V CMOS
Cable Standard USB 2.0 to 5 m, 15 m with optical repeater

CAT. 5 or CAT. 6 Ethernet cable

Operating system Windows 2000, XP, MAC OS X
Gain Programmable gains and high/middle/low 8-bit selection
Size and weight 95 x 95 x 162 mm, 1.9 kg
Lens Mount C-mount, F-mount (Nikon and Canon)
Tripod Mount Standard ¥-20 photo mounts
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10.6. Frame Rates

In the tables below, the max frame rates for some camera resolutions.

Users Manual

MotionPro Y3 / MotionXtra N3

Resolution Rate [fps] Plus™ Rate [fps]
1280 x1024 1,040 2,080
1280 x 864 1,230 2,470
1280 x 768 1,380 2,770
1280 x 512 2,080 4,160
1280 x 384 2,770 5,540
1280 x 256 4,160 8,290
1280 x 128 8,290 16,400
1280 x 64 16,400 32,200
1280 x 32 32,200 62,300
1280 x 16 62,300 116,500
MotionPro Y4L
Resolution Rate [fps] Plus™ Rate [fps]
1016 x 1016 4,500 9,000
1016 x 768 6,000 11,800
1016 x 512 8,950 17,200
1016 x 256 17,200 32,200
1016 x 128 32,200 56,000
1016 x 64 56,000 92,000
1016 x 32 92,000 132,000
1016 x 16 132,000
MotionPro Y5 / MotionXtra N5
Resolution Rate [fps] Plus™ Rate [fps]
2352 x1728 500 999
2352 x 1128 765 1,530
2352 x 1024 840 1,685
2352 x 512 1,685 3,360
2352 x 256 3,360 6,700
2352 x128 6,700 13,280
2352 x 64 13,280 26,125
MotionPro Y6
Resolution Rate [fps] Plus™ Rate [fps]
1504 x 1128 1,200 N/A
1280 x 1024 1,500 N/A
1024 x 768 2,400 N/A
800 x 600 4,100 N/A
640 x 480 5,900 N/A
512 x512 6,750 N/A
480 x 320 11,200 N/A
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256 x 256 21,500 N/A
128 x 128 65,000 N/A
MotionPro Y7 HDiablo
Resolution Rate [fps] Plus™ Rate [fps]
1920 x 1080 1,500 N/A
1280 x 720 3,300 N/A
768 x 432 8,000 N/A
MotionXtra N3L
Resolution Rate [fps] Plus™ Rate [fps]
1280 x1024 500 N/A
1280 x 768 665 N/A
1280 x 512 1000 N/A
1280 x 256 2000 N/A
1280 x 128 4000 N/A
1280 x 64 8000 N/A
1280 x 32 16000 N/A
1280 x 16 32000 N/A
MotionXtra N4L
Resolution Rate [fps] Plus™ Rate [fps]
1016 x 1016 2,000 N/A
1016 x 768 2,660 N/A
1016 x 512 3,970 N/A
1016 x 256 7715 N/A
1016 x 128 14,900 N/A
1016 x 64 27,500 N/A
1016 x 32 48,000 N/A
1016 x 16 75,000 N/A
MotionXtra N4
Resolution Rate [fps] Plus™ Rate [fps]
1016 x 1016 3,000 6,000
1016 x 768 4,040 7,950
1016 x 512 6,000 11,800
1016 x 256 11,800 22,500
1016 x 128 22,500 42 000
1016 x 64 42,000 70,000
1016 x 32 70,000 100,000
1016 x 16 100,000 200,000
MotionScope M3
Resolution Rate [fps] Plus™ Rate [fps]
1280 x1024 520 1,040
1280 x 768 690 1,380
1280 x 512 1,040 2,080
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1280 x 256 2,080 4,140
1280 x 128 4,140 8,200
1280 x 64 8,200 16,100
1280 x 32 16,100 31,100
1280 x 16 31,100 58,200
MotionScope M5
Resolution Rate [fps] Plus™ Rate [fps]
2320 x1728 170 N/A
2320 x 1376 215 N/A
2320 x 1024 285 N/A
2320 x 768 380 N/A
2320 x 512 570 N/A
2320 x 256 1,135 N/A
2320 x 128 2,240 N/A
2320 x 64 4,370 N/A
2320 x 32 8,350 N/A
2320 x 16 15,350 N/A

X-Stream XS3 / MotionPro HS1

Resolution Max Rate [fps]
1280 x 1024 660
1280 x 768 880
1280 x 512 1,320
1280 x 256 2,640
1280 x 128 5,270
1280 x 64 10,400
1280 x 32 20,500
1280 x 16 39,800
MotionPro X3 / HS3
Resolution Rate [fps] Plus™ Rate [fps]
1280 x1024 1,040 2,080
1280 x 768 1,380 2,770
1280 x 512 2,080 4160
1280 x 256 4,160 8,290
1280 x 128 8,290 16,400
1280 x 64 16,400 32,200
1280 x 32 32,200 62,300
1280 x 16 62,300 116,500
MotionPro X4 / HS4
Resolution Rate [fps] Plus™ Rate [fps]
512 x 512 5,130 10,100
512 x 256 10,100 20,100
512 x 128 20,100 38,500
512 x 64 38,500 73,500
512 x 32 73,500 132,000
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512x16 | 132,000 | 200,000 |
MotionPro X5

Resolution Rate [fps] Plus™ Rate [fps]

2352 x 1728 250 500

2352 x 1376 314 628

2352 x 1024 422 842

2352 x 768 563 1120

2352 x 512 842 1,675

2352 x 256 1,675 3,310

2352 x128 3,310 6,470
2352 x 64 6,470 12,360
2352 x 32 12,360 22,720
2352 x 16 22,720 39,100
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10.7. Intensified X cameras

In the table below, you may find the optical specifications at 20 C and nominal operating

conditions.
Parameter Value

Input diameter 17.5 mm min
Input window Glass (AVG)
Cathode sensitivity for white light 500 yA/iIm min
at 800 nm 43 mA/Im min
at 850 nm 33 mA/im min
Phosphor P46
Output window Fiber-optic
Luminance gain 1590 cd/m?/Ix min
E.B.I 0.25 plx max
Shading 45 % max
Resolution 36 Ip/mm min
Gate-able Yes (down to 50 ns)
Iris delay 16.6 ns max
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11. Appendix B - Image Formats

Motion Studio supports the image formats listed in the table below:

Format Ext Pixel Depth Notes

Tagged Image File Format - TIFF™ TIF 8/16/24/48 Gray/Color

Windows ™ Bitmap BMP 8/24 Gray/Color

JPEG File JPG 8/24 Gray/Color

Portable network Graphics — PNG PNG 8/16/24/48 Gray/Color

Type 2 Bayer TP2 8 Gray/Bayer

Falcon eXtra RAW FBA 8/24 Gray/Color

Multi-Page TIFF MPT 8/16/24/48 Gray/Color

Multi-page Raw MPR 8/16/24/48 Gray/Color (IDT proprietary)
Multi-page Compressed MCF 8/16/24/48 Gray/Color (IDT proprietary)
Audio Video Interleaved (AVI) AVI 8/24 Gray/Color

Apple Quick Time (MOV) MoV 8/24 Gray/Color

Weinberger Sequence (BLD) BLD 8/24 Gray/Color

Moving Picture Experts Group (MPEG) | MPG 8/24 Gray/Color (MPEG-1)
MPEG H.264 (Advanced Video Coding) | MP4 8/24 Gray/Color (MPEG-4)

11.1. Formats Overview

11.1.1. TIFF Format
TIFF pictures store a single raster image at any color depth. TIFF is arguably the most widely
supported graphic file format in the printing industry. It supports optional compression, and is
not suitable for viewing in Web browsers.

The TIFF format is an extensible format, which means that a programmer can modify the
original specification to add functionality or meet specific needs. This can lead to
incompatibilities between different types of TIFF pictures.

11.1.2. Bitmap Format

Windows bitmap files are stored in a device-independent bitmap (DIB) format that allows
Windows to display the bitmap on any type of display device. The term "device independent”
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means that the bitmap specifies pixel color in a form independent of the method used by a
display to represent color. The default flename extension of a Windows DIB file is .BMP.

For further information, refer to the Microsoft™ documentation.

1.3. JPEG Format

The name "JPEG" stands for Joint Photographic Experts Group, the name of the committee
that created the standard. The JPEG standard specifies both the codec, which defines how
an image is compressed into a stream of bytes and decompressed back into an image, and
the file format used to contain that stream. The compression method is usually lossy,
meaning that some visual quality is lost in the process and cannot be restored. However
there are variations on the standard baseline JPEG that are lossless.

1.4. PNG Format

PNG is an extensible file format for the lossless, portable, well-compressed storage of raster
images. PNG provides a patent-free replacement for GIF and can also replace many
common uses of TIFF. Indexed-color, grayscale, and true-color images are supported, plus
an optional alpha channel. Sample depths range from 1 to 16 bits.

PNG is designed to work well in online viewing applications, such as the World Wide Web, so
it is fully stream-able with a progressive display option. PNG is robust, providing both full file
integrity checking and simple detection of common transmission errors. Also, PNG can store
gamma and chromaticity data for improved color matching on heterogeneous platforms.

PNG is a platform-independent format that supports a high level of lossless compression,

alpha channel transparency, gamma correction, and interlacing. It is supported by more
recent WWeb browsers.

1.5. TP2 format

Type-2 format is the Redlake raw data format. It’s the format used to save raw image data.

1.6. FBA format

The FBA format is the Falcon eXtra raw data format. It's the format used by Falcon eXtra
software to save raw image data. For further information, please refer to falcon
documentation.

.1.7. AVI Format

The Microsoft AVI file format is a Resource Interchange File Format (RIFF) file specification
used with applications that capture, edit, and play back audio-video sequences. In general,
AVI files contain multiple streams of different types of data. Most AVI sequences use both
audio and video streams. A simple variation for an AVI sequence uses video data and does
not require an audio stream. The program supports uncompressed (raw) and compressed
AVI. The INDEO 5.11 codec is installed on 32-bit Windows. The format is not supported in
MAC OS.
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1.8. MOV Format

The Apple Quick Time MOV file format is used with applications that capture, edit, and play
back audio-video sequences. In general, MOV files contain multiple streams of different types
of data. Most MOV sequences use both audio and video streams. A simple variation for an
MOV sequence uses video data and does not require an audio stream. The format is not
supported on Windows OS.

1.9. BLD Format

The BLD format corresponds to the file format RAW, which is known from several
applications. Each BLD file needs a corresponding descriptor file in the DSC format. In a BLD
file all single frames of an image sequence are stored successively uncompressed in the
block format. The data is in binary raw data format (e.g. for grayscale pictures 1 Byte per
Pixel). The descriptor file (DSC) belonging to the BLD file is a line-orientated ASCII file, in
which values like e.g. resolution, frames or date are stored. The DSC file can be created with
any text editor.

1.10. MPEG Format

MPEG, which stands for “Moving Picture Experts Group”, is a name of family standards used
for coding audio-visual in a digital compressed format. MPEG is a generic means of
compactly representing digital video and audio signals for consumer distribution. The basic
idea is to transform a stream of discrete samples into a bit-stream of tokens which takes less
space, but is just as filling to the eye. The graphic library implements the MPEG-1 format, the
standard on which such products as video CD and MP3 are based. The
compression/decompression technique implemented in MPEG is “lossy”, e.g. some amount
of data information is lost.

1.11. MPEG H.264 (Advanced Video Coding)

It is also known as MPEG-4 Part 10 or MPEG-4 AVC (Advanced Video Coding). The intent of
the H.264 project was to create a standard capable of providing good video quality at
substantially lower bit rates than previous standards without increasing the complexity of
design so much that it would be impractical or excessively expensive to implement. An
additional goal was to provide enough flexibility to allow the standard to be applied to a wide
variety of applications on a wide variety of networks and systems, including low and high bit
rates, low and high resolution video and broadcast. The MPEG H.264 format is supported
only on a 32 bit Windows OS with installed QuickTime™.

1.12. Multi-page Raw Format (MRF)

Multi-page Raw Format (MRF) is an uncompressed IDT proprietary file format. Multiple raster
images are stored in a single file. The format is described below.

Each MREF file contains a file header, an image header and an array of bytes that defines the
image data bits. The image raster data is not compressed and stored in the file “as it is”. Both
8 bit and 16 bit data are supported. The file structures are the following:

11.1.12.1. File header

A MREF file begins with a file header structure containing the IDT raw file signature.
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typedef struct _RCFILE HEADER

{
char szSign[8]; // IDT raw file signature
ungigned long nReserved; // reserved

} RCFILE HEADER, *PRCFILE HEADER;

Members

szSign[8]: a 8 char buffer which contains the signature “IDT-MRF". It indicates that the
remainder of the file contains a Multiple Raw File.

nReserved.: this field is reserved for future use.

11.1.12.2. Image header

The file header is followed by the image header which contains general information about the
data stream.

typedef struct RCIMG HEADER
{

unsigned long nSize; / size of this header
unsigned long nPages; / number of pages/frames
unsigned long nWidth; // image width

unsigned long nHeight; / image height

unsigned long nBPP; // bits per pizxel
unsigned long userDatal[64]; // user data array

} RCIMG HEADER, *PRCIMG HEADER;

Members

nSize: size of the structure in bytes. It should be 84.
nPages: number of images contained in the file
nWidth: width of each image in pixels.

nHeight: height of each image in pixels.

nBPP: number of bits per pixels (8, 10 or12)

userData: an array of 64 unsigned long that may be user by the user to store other
information.

11.1.12.3. Data arrays

The image header is followed by the images data. Images are stored contiguously in
uncompressed format.
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11.1.13. Multi-page Compressed Format (MCF)

Multi-page Compressed Format (MCF) is a compressed IDT proprietary file format. Multiple
raster images are stored in a single file. The format is described below.

Each MCF file contains a file header, an image header and an array of bytes that defines the

image data bits. The image raster data is compressed and stored in the file. Both 8 bit and 16
bit data are supported. The file structures are the following:

11.1.13.1. File header

A MREF file begins with a file header structure containing the IDT raw file signature.

typedef struct RCFILE HEADER
{

raw file signature

char szSign[8]; s
Vs erved

unsigned long nReserved;
} RCFILE_HEADER, *PRCFILE HEADER;

™
M |
I

1
res

Members

szSign[8]: a 8 char buffer which contains the signature “IDT-MCF". It indicates that the
remainder of the file contains a Multiple Compressed File.

nReserved.: this field is reserved for future use.

11.1.13.2. Image header

The file header is followed by the image header which contains general information about the
data stream.

typedef struct _RCIMG HEADER
{

unsigned long nSize; // size of this header
ungigned long nPages; // number of pages/frames
unsigned long nWidth; // image width

unsigned long nHeight; // image height

unsigned long nBPP; // bits per pixel
unsigned long userDatal[64]; // user data array

} RCIMG HEADER, *PRCIMG HEADER;
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Members

nSize: size of the structure in bytes. It should be 84.
nPages: number of images contained in the file
nWidth: width of each image in pixels.

nHeight: height of each image in pixels.

nBPP: number of bits per pixels (8, 10 or12)

userData: an array of 64 unsigned long that may be user by the user to store other
information.

11.1.13.3. Data arrays

The image header is followed by the images data. Images are stored contiguously in
compressed format. The first four bytes contains the size of the compressed buffer, followed
by image data.

Data compression is done using ZLIB library version 1.1.4, which is free and available for
download at the URL hitp://www.zlib.org.

The compression algorithm used by ZLIB is a variation of LZ77 (Lempel-Ziv 1977). It finds
duplicated strings in the input data. The second occurrence of a string is replaced by a
pointer to the previous string, in the form of a pair (distance, length). Distances are limited to
32K bytes, and lengths are limited to 258 bytes. When a string does not occur anywhere in
the previous 32K bytes, it is emitted as a sequence of literal bytes.

11.1.14. Note on 16 bit grayscale formats

10-bit images acquired from the camera may be saved in different 16 bit formats. These
formats include TIF, PNG, MPT, MRF and MCF. Since 16 bit grayscale format is not a
standard, not all the applications for image processing may correctly display the saved
images.
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12. Appendix C - Error codes

Below a list of the Motion Studio error codes with a brief description.

ERRO001: Internal error. The program has generated a severe internal error and must be
restarted.

ERRO05: Invalid database path. The program is trying to open a database from a wrong
directory.

ERRO11: Error opening file. The program failed opening an image file because it is damaged
or the format is not supported.

ERRO012: Error opening image sequence. The program failed opening an image sequence
because it is damaged or the format is not supported.

ERR023: Camera generic error. Unspecified camera error.

ERRO027: Camera play time out. The camera cannot snap images and a time out occurred.
Check if the camera sync configuration is set to external and the external sync signal is
available.

ERRO028: Camera acquisition time out. The camera cannot acquire images and a time out
occeurs.

ERRO033: Unable to open camera. The program cannot start the communication with the
camera. Check the hardware and the cables.

ERRO034: Unable to create a folder. The program cannot create a new folder in the database
for the storage of the acquired images. Check your administrator privileges.

ERRO035: not enough camera memory to add a new acquisition. All the camera memory is
filled with acquisitions. A new acquisition cannot be added.

ERRO036: Unable to delete the current acquisition. The program cannot delete the current
acquisition from the camera memory configuration.

ERRO037: Camera hardware generic error. An error occurred in the communication through
the USB or the Ethernet cable.

ERRO038: The buffer is too small. The buffer allocated for the image snap is too small.

ERRO039: Camera device I/O error. An error occurred in the communication through the USB
cable. Check the cables and the USB board.

ERR040: Camera I/O read error. An error occurred while the program was reading an image
from the camera. Check the cables and the USB board.
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ERRO041: Cannot complete the operation because the camera is busy. The camera is busy
and cannot perform the requested operation. Wait and try again.

ERR042: An eror occurred during the calibration procedure. The error can occur during the
camera background calibration or during the tracking calibration. Restart the program and try
again.

ERRO045: Invalid range value. The error occurs when the user tries to configure a parameter
which is out of the allowed range. Correct the value and try again.

ERR048: An error occurred during the color balance and/or white balance procedure because
one of the circular targets is outside the image. Move the targets and try again.

ERR049: An error occurred during the color balance andfor white balance procedure. Move
the targets and try again.

ERRO055: Unable to create a new database. The error occurs when the program tries to
create a new database. Check your administrator privileges and try again on a different
folder.

ERRO056: Unable to delete folder. The error occurs when the program tries to delete a folder
(acquisition, calibration or tracking) from the current database. Check your administrator
privileges.

ERRO059: Unable to create calibration folder. The error occurs when the program tries to
create a new calibration folder and save the calibration image.

ERRO81: Unable to copy file. The error occurs when the program tries to copy the camera
calibration file from the distribution CD. Check your administrator privileges and the CD
integrity.

ERRO65: Invalid camera calibration file. The error occurs when the program tries to copy a
camera calibration file that is not valid. Check if the file is damaged.

ERRO067: Camera |/O write emor. An error occured while the program was trying to write a
parameter to the camera. Check the cables and the USB board.

ERRO068: Unable to open camera driver. The program cannot start the communication with
the camera. Check the hardware and the cables.

ERRO70: Invalid iTunes version. The error occurs because the program is trying to
communicate with the iPod through iTunes and the version is not valid. Install a newer
version of iTunes.

ERRO71: iTunes Type library is not compatible. The error occurs because the program is
trying to communicate with the iPod through iTunes and the version is not valid. Install a
newer version of iTunes.

ERRO072: Unable to connect to iPod through iTunes. There is a communication error between
the program and the iPod. Try again.

ERRO73: More than one iPod found. The computer is connected to more than one iPod.
Disconnect one of them and try again.
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ERRO74: Unable to connect to iTunes. There is a communication error between the program
and iTunes.

ERRO75: Not enough space on the destination database. The error occurs because the
program tries to synchronize with the iPod, but the iPod disk has not enough space to store
the database.

ERRO76: Unable to delete the iPod acquisition list. The error occurs because the program is
trying to synchronize with the iPod but it's not able to delete the previous acquisition list.

ERRO77: Unable to delete the acquisition folder. The error occurs because the program is
trying to synchronize with the iPod but it's not able to delete one of the acquisition folders.

ERRO078: Unable to create the acquisition folder. The error occurs because the program is
trying to synchronize with the iPod but it's not able to create a new acquisition folder.

ERRO79: Unable to copy the database system files. The error occurs because the program is
trying to synchronize with the iPod but it's not able to copy the database system files.

ERRO80: Unable to find images. The error occurs bhecause the program is trying to
synchronize with the iPod but it cannot find images in the source database.

ERRO081: Unable to add files to the iPod acquisition list. The error occurs because the
program is trying to synchronize with the iPod but it cannot add a sequence to the iPod list.

ERRO082: Unable to add files to the iPod acquisition list. The error occurs because the
program is trying to synchronize with the iPod but it cannot add a sequence to the iPod
folders.

ERRO083: Unable to convert the acquisition to the iPod format. The error occurs because the
program is trying to add a sequence to the iPod list but it cannot convert it to the proper iPod
format.

ERRO084: Multiple camera snap time out. The error occurs because the program is trying to
snap an image from a multiple camera setup. One or more cameras failed, check the cables.
If the system is in Master/Slave configuration check that the sync in connector of the slave
camera is connected to the sync out connector of the master.

ERRO086: Unable to save calibration image. The error occurs because the program tries to
save a tracking calibration image. Check your administrator privileges and try again.

ERRO087: Unable to download the camera calibration file from flash memory. Check the
cables and try again.

ERR088: The command line passed to the raw converter to convert a file is not correct.

ERR089: Unable to find acquisition directory. This emror occurs when the Raw Converter tries
to open an INI files but is not able to find it. Check the command line path and try again.

ERRO090: Invalid configuration file. This error occurs when the Raw Converter tries to convert
a sequence but the configuration file is not valid.

ERR091: Unable to read the RAW file. This error occurs when the Raw Converter tries to
convert a sequence but the raw file is not valid or damaged.
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ERR092: the raw file and the converter have different versions. This error occurs when the
Raw Converter tries to convert a sequence generated by an older version of the software.

ERR093: Unable to set the IP address. This error occurs when the program tries to change
the camera IP address and it fails. Check that the selected IP address is compatible with the
network adapter subnet mask and disconnect the USB cable if it's connected.

ERR094: Unable to assign a specific IP address to the camera. The automatic assignment of
the IP addresses has failed. Try with the manual configuration.

ERRO095: Data acquisition module over-run. A data acquisition module intemal error has
occurred.

ERR096: Data acquisition module under-run. A data acquisition module internal error has
occurred.

ERRO097: Unable to download the camera calibration file from flash memory because the
camera calibration file is not stored in the flash. Contact the technical support.

ERR098: The calibration file download has been aborted. The user has clicked the Abort
button during the download.

ERR099: Unable to set the IP address. An error occurred in the procedure of setting the IP
address starting from the camera MAC address. Make sure that the MAC address is correct
and the camera is connected to the network.

ERR100: Unable to save tracking data. The error occurs because the program tries to save
the tracking results to a file and it fails.

ERR101: Invalid file format. The error occurs when a waveform file is not valid. The file may
be damaged or have invalid data.

ERR102: Unable to save to a file. The error occurs when the program cannot save an image
to the specified file format.

ERR103: Unable to save to a file. The error occurs because the file is too large and the file
format does not support that size.

ERR104: Unable to allocate enough computer memory for the acquisition. This error occurs
when M cameras try to acquire a large number of images in computer memory.

ERR105: The camera cable has been disconnected.

ERR106: The program is unable to attach to the camera. The program instance has been
detached from the camera because the control has been taken by someone else.

ERR107: Unable to configure the camera for first use. The procedure of setting up the
camera for the first time failed.

ERR108: Aborted operation. The error message occurs when the user aborts the raw
conversion procedure,

ERR109: The selected region of interest is not supported by this file format.
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ERR110: the application is not able to open a device in the Galileo network.

ERR111: the HG100K camera memory cannot be erased.

ERR112: a Galileo wireless device cannot be configured.

ERR113: a frame cannot be read from the camera during a procedure of sequence save.
ERR114: the compressed AVI codec is not valid and the sequence cannot be saved.

ERR115: memory allocation error. The program cannot allocate enough memory to open and
display a sequence of images.

ERR116: write to disk overrun. When the program acquires in direct write to disk mode with
M camera, the memory allocated for buffering is not enough and it is overwritten.

ERR117: SD card download error. The camera cannot download the images to the SD card.
ERR118: the time limited license has expired. Contact IDT for a new activation code.

ERR119: The activation key cannot be sent to the camera. Reboot the camera, restart Motion
Studio and try again.

ERR120: Read EEPROM error. The camera cannot be initialized because the EEPROM data
cannot be read.

ERR121: The HDMI output cannot be initialized.

ERR122: 3D card download error. Some cameras were not able to save the images to their
8D card devices.
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13. Appendix D - Spatial filtering

Spatial filters alter pixel values with respect to variations in light intensity in their
neighborhood. The neighborhood of a pixel is defined by the size of a matrix, or mask,
centered in the pixel itself. These filters can be sensitive to the presence or the absence of
light intensity variations. Spatial filters can serve a variety of purposes, such as detecting
edges along a specific direction, contouring patterns, reducing noise and detail outlining and
smoothing.

Spatial filters fall in two categories:

High-pass filters emphasize significant variations of the light intensity usually found at the
boundary of object. They are also called sharpening filters.

Low-pass filters attenuate variations of the light intensity. They have the tendency to smooth
images by eliminating details and blurring edges. They are also called smoothing filters.

In the case of a 3x3 matrix, the value of the central pixel derives from the values of its eight
surrounding neighbors. A 5x5 matrix specifies 24 neighbors; a 7x7 matrix specifies 48
neighbors and so forth.

If Pg,; specifies the intensity of the pixel P with the coordinates (i,j), the pixels surrounding Py
can be indexed as follows (in the case of a 3x3 matrix):

P14 P Pis11)
Pt _ P _ Peirti)
Pe1je) P+ Ps1e1)

A linear filter assigns to Py a value which is a linear combination of its surrounding values.
For example:

Py = Py + Pgjoy + Piirt, oy = Piajen) = Piijsr) - Piisajnn)

A nonlinear filter assigns to P a value that is not a linear combination of the surrounding
values. For example:

P(i,j) = max( P(I-1,j-1); P(|+1, 1) P(i-1,]+1); P(I+1,j+1))

13.1. Linear filters (Convolution filters)

A convolution is a mathematical function that replaces each pixel by a weighted sum of its
neighbors. The matrix defining the neighborhood of the pixel also specifies the weight
assigned to each neighbor. This matrix is called the convolution kernel.
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For each pixel Pg; in an image, the convolution kernel is centered on Pgj;. Each pixel
masked by the kernel is multiplied by the coefficient placed on top of it. Py; becomes the
sum of these products.

In the case of 3x3 neighborhood, the coefficients of the kernel matrix can be indexed as

follows.
Kii1.-1) Keign K
Kt K K+
Kii-t+1) Kjs K1+

The grater the absolute value of a coefficient K, the more the pixel Py, contributes to the
new value of Pg. If a coefficient Kq ) is 0, the neighbor P, p) does not contribute to the new
value of P

0 1 0
1 0 1
0 1 0

then

Py = Piijny + Piajy + Ppaaj + Pjar)
If the kernel contains both negative and positive coefficients, the transfer function is
equivalent to a weighted differentiation and produces a sharpening or high-pass filter (like
Laplacian, Prewitt and Sobel filters).

If all coefficients in the kernel are positive, the transfer function is equivalent to a weighted
summation and produces a smoothing o low-pass filer (like Average and Gaussian filters).

13.2. Linear sharpening filters

Typical smoothing filters are:
Gradient filters

A gradient filter highlights the variation of light intensity along a specific direction, which has
the effect of outlining edges and revealing texture.

A gradient convolution filter is a first-order derivative. Its kernel uses the following matrix:

a -b c

b X -d
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Where a, b, ¢ and d are integer coefficients and x=0 or x=1.

This kernel has an axis of symmetry that runs between the positive and negative coefficients
of the kemel and through the central element. This axis of symmetry gives the orientation of
the edges to outline.

There are two sets of pre-defined gradient filters used in Motion Studio. They are listed
below.

The Prewitt filters have the following kernels. The notations N (north) NE(north-east) E
(east) SE (south-east) S (south) SW (south-west) W (west) NW (north-west) indicate which
edges of bright regions they outline.

The Sobel filters are very similar to the Prewitt filters except that they highlight light intensity
variations along a particular axis that is assigned a stronger weight. They have the following
kernels.

Laplacian filters

A Laplacian filter highlights the variation of the light intensity surrounding a pixel. The filter
extracts the contour of objects and outline details. Unlike the gradient filter, it is omni
directional.

The Laplacian filter is a second-order derivative. Its kernel uses the following matrix:

‘ a d c
‘ b X b
‘ c d A

where a, b, ¢ and d are integers.

The Laplacian filter has two different effects, depending on whether the central coefficient x is
equal or greater than the sum of the absolute values of the outer coefficients.

If x is equal to that sum, the filter extracts the pixels where significant variations of light
intensity are found. The presence of sharp edges, boundaries between objects, modification
in the texture of a background, noise, and other effects can cause these variations. The
transformed image contains white contours on a black background.

If x is greater than that sum, the filter detects the same variations as mentioned above, but

superimposes them over the source image. The transformed image looks like the source
image, with all significant variations of the light intensity highlighted.
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13.3. Linear Smoothing filters

A smoothing filter attenuates the variations of light intensity in the neighborhood of a pixel. It
smoothes the overall shape of objects, blurs edges, and removes details.

It is an averaging filters and its kernel uses the following matrix:

a d c
b X b
[¢ d a

where a, b, ¢ and d are positive integers, and x=0 or x=1.

Because all the coefficients are positive, each central pixel becomes a weighted average of
its neighbors. The stronger the weight of a neighbor is. The more influence it has on the new
value of the central pixel.

A list of average smoothing kernels is shown below

A Gaussian filter attenuates the variations of light intensity in the neighborhood of a pixel. It
smoothes the overall shape of objects and attenuates details. It is similar to a smoothing filter,
but its blurring effect is more subdued.

Its kernel uses the following matrix.

a d c
b X b
[¢ d a

where a, b, ¢ and d are positive integers, and x=0 or x=1.

Because all the coefficients are positive, each central pixel becomes a weighted average of
its neighbors. The stronger the weight of a neighbor is. The more influence it has on the new
value of the central pixel.

Unlike a smoothing kernel, the central coefficient of a Gaussian filter is greater than 1.
Therefore the original value of a pixel is multiplied by a value greater than the weight of any of
its neighbors. As a result, a greater central coefficient corresponds to a more subtle
smoothing effect. A larger kernel size corresponds to a stronger smoothing effect.
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13.4. Nonlinear filters

A nonlinear filter replaces each pixel with a nonlinear function of its surrounding pixels. Like
the convolution filters the nonlinear filters operate on a neighborhood.

A Median filter is a nonlinear low pass filter that assigns to each pixel the median value of its
neighborhood, effectively reducing isolated pixels and reducing details. However, the median
filter does not blur the contour of objects.

A Maximum Filter is a nonlinear filter that assigns to each pixel the maximum value of pixels
in its neighborhood. This has the effect to increase the contrast of the image.

A Dilation of an image is a particular case of max filter. The output pixel is set to the
maximum of the corresponding input pixel and its 8 neighbors. The effect of dilation is to fill
up holes and to thicken boundaries of objects on a dark background (that is, objects whose
pixel values are greater than those of the background).

A Minimum Filter is a nonlinear filter that assigns to each pixel the minimum value of pixels
in its neighborhood. This has the effect to decrease the contrast of the image.

An Erosion of an image is a particular case of min filter. The output pixel is set to the
minimum of the corresponding input pixel and its 8 neighbors. The effect of erosion is to
remove spurious pixels (such as noise) and to thin boundaries of objects on a dark
background (that is, objects whose pixel values are greater than those of the background).

Opening an image is a sequence of erosions followed by dilations. The process of opening
has the effect of eliminating small and thin objects, breaking objects at thin points, and
generally smoothing the boundaries of larger objects without significantly changing their area.

Closing an image is a sequence of dilations followed by erosions. The process of closing has
the effect of filling small and thin holes in objects, connecting nearby objects, and generally
smoothing the boundaries of objects without significantly changing their area.

13.5. Adding noise to images

"8

A random noise signal may be generated and added to an image. Two different noise signals
may be generated.

Uniform noise: a noise signal with uniform distribution over a range [low, high].

Gaussian noise: a noise signal with Gaussian distribution that has a specified mean value
and a specified standard deviation.

NOTE: Uniform noise and Gaussian noise are not available in the MAC version of the
software.
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14. Appendix E - Look-up Table Transformations

The Jook-up table (LUT) transformations are basic image-processing functions that you can
use to improve the contrast and the brightness of an image by modifying the dynamic
intensity of region with poor contrast. LUT transformations can highlight details in areas
containing significant information, at the expense of other areas.

A LUT transformation convert input gray-level values (8 or 16 bit) into other gray-level values.
The transfer function has an intended effect on the brightness and contrast of the image.
Each input value is transformed into a new value by a transfer function

Output value = F (input value)
Where F is a linear or nonlinear, continuous or discontinuous transfer function defined over
the interval [0, max]. In case of an 8-bit image, a LUT is a table of 256 elements. Each
element of the array represents an input value. Its content indicates the output value.

Five different LUT types are available in Motion Studio: linear, equalize, logarithmic,
exponential and gate. The table below shows the transfer function for each LUT type.

Resolution Transfer Function Description

A linear transfer function ( y = ax + b) affects both
the brightness and contrast of the image. The
parameter b (offset) increase or decrease the
Linear image brightness, while the parameter s (gain)
influences the image contrast.

The equalize function alters the gray-level value
of pixels so they become distributed evenly in the
defined grayscale range (0 to 155 for an 8 bit
Equalize image) The function associates an equal amount
of pixels per constant gray-level interval and takes
full advantage of the available shades of gray.

The logarithmic function expands low gray-level
ranges while compressing high level ranges.
These transformations increase the overall
Logarithmic brightness of an image and increase the contrast
in dark areas at the expense of the contrast in
bright areas.
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Exponential

‘ The exponential function expands high gray-level
ranges while compressing low level ranges.
These fransformations decrease the overall
brightness of an image and increase the contrast
in bright areas at the expense of the contrast in
dark areas.

Gate

The gate function sets to zero all the gray-level
values that are below a certain value and above
another one. The other gray-level values remain
unaltered.
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15. Appendix F - Color Filter Arrays (CFA)

The Color camera uses a single image sensor. Color imaging with a single sensor requires
the use of a Color Filter Array (CFA) which covers the sensor array. In this fashion each
pixel in the detector samples the intensity of just one of the three color components, i.e. red,
green or blue. The recovery of full-color images from a CFA-based sensor requires a method
of calculating values of the other color separations at each pixel. These methods are
commonly referred as color interpolation or color “demosaicing” algorithms.

In a single-sensor camera, varying intensities of light are measured at a rectangular grid of
image sensors. To construct a color image, a CFA must be placed between the lens and the
sensors. A CFA typically has one color filter element for each sensor. Obviously, the color
interpolation algorithms depend on the CFA configuration. Many different CFA configurations
have been proposed. The one used in IDT cameras is the Bayer pattern.

A Bayer pattern consists of pixels on your sensor tinted green, red or blue and set in a
mosaic pattern. Consider the figure below: moving from left to right and then down, you see
that you have a GR-BG pattern. This is your Bayer pattern, and is then placed all over the
sensor to form the Bayer Mosaic Pattern. This means that you have half of your pixels tinted
with a Green sensitive element, a quarter tinted with a Red sensitive element, and a quarter
tinted with a Blue sensitive element.

The MotionPro/MotionScope camera models have different Bayer patterns:
e X3,Y3, N3 and M3 have BG-GR pattern.

e X4, X5,Y5, M6 and N5 have GR-BG pattem.

e Y4,N4, Y6 and Y7 HDiablo have GB-RG pattern.

The camera driver may perform six different interpolation algorithms (demosaicing):
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=  Advanced: a new advanced method for high quality reconstruction.
= Nearest: the algorithm is based on nearest neighbor reconstruction.

» Bilinear: for each missing pixel, a weighted value of the surrounding four pixels is
computed. It's the simplest method and is non-adaptive. The indiscriminate averaging of
neighboring pixel causes a blur effect (“Zipper”).

= Gradient A: the interpolation is done using chrominance gradients in two steps. First the
luminance channel is interpolated (green). Then the color differences (red minus green
and blue minus green) are interpolated.

* Gradient B: the interpolation is done using luminance gradients in a more adaptive way
than algorithm B.

* Gradient C: the interpolation is done using a threshold based variable number of
gradients.

= Hue Transition A: the algorithm is based on the assumption that the hue of the image
cannot change abruptly and in an unnatural manner. The term hue refers to the relation
between luminance (green) and chrominance (red, blue).

* Hue Transition B: based on the same principles of “A” method, but more precise

= Pixel Grouping: the algorithm is based on the observation that natural scene images are
usually composed of numerous groups of pixels, and have approximately the same
brightness and color.
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16. Appendix G - XDR

The eXtended Dynamic Range (XDR) is an IDT-proprietary implementation that uses a of
the MotionPro Y4 camera. In XDR mode the camera dynamic range may be enhanced to 9,
10 or 11 bit depth.

Imagine that we are taking a picture of a high contrast scene. In the picture we may have a
very bright portion (almost saturated) and a very dark portion that is almost black.

How can we change our exposure to have a good image? If we try to increase the exposure
to improve the dark part, we saturate the bright one. On the other side, if we decrease to
improve the bright part, we reduce the light to the dark portion and we loose information.

The solution is XDR.

With XDR the Y4 camera uses a capability of the sensor that can acquire at two different
exposures at the same time: one of the pictures at lower exposure and one at higher
exposure.

Then the pictures are linearly combined to obtain a third picture with increased sensitivity.
The ratio between higher exposure and lower exposure gives the new pixel depth, which can
be 8, 10 or 11 bits for 8 bit images or 10, 11 and 12 bits for 10 bit images.

Last but not least, the resulting image may be converted back to 8 bits (or 10 bits) with a look
up table.

See the example below.

The image below shows a dark area at the top left side.

el

T

If we increase the exposure, the top left side becomes visible but the image saturates at the
right side. See below.
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With XDR the two images are combined and the result is a uniform image without dark or

saturated zones.
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17. Appendix H - Glossary

A

Ambient Light

It's the available natural light completely surrounding a subject. It’s tight already existing in an
indoor or outdoor setting that is not caused by any illumination supplied by artificial light
source.

Aperture

It's the lens opening. The hole or opening formed by the metal leaf diaphragm inside the lens
or the opening in a camera lens through which light passes to expose the sensor. The size of
aperture is either fixed or adjustable. Aperture size is usually calibrated in - numbers-the
larger the number, the smaller the lens opening. Aperture affects depth of field, the smaller
the aperture, the greater is the zone of sharpness, the bigger the aperture, the zone of
sharpness is reduced. The size of the aperture is indicated by its f-number.

ASCII

American Standard Code for Information Interchange, an encoding system for converting
keyboard characters and instructions into the binary number code that the computer
understands.

Aspect ratio
It's the ratio between the width and height of an image or image sensor.

Auto focus
It's a system that automatically focuses the camera lens.

AVI (Audio Video Interleaved)

It's a file format used to store video and audio. For further information, refer to the Microsoft™
documentation.
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B

Bandwidth

It's the capacity of a networked connection and determines how much data can be sent along
the networked wires. The bandwidth is particularly important for Internet connections, since
greater bandwidth also means faster downloads.

Bayer pattern

A Bayer pattern consists of pixels on the sensor tinted green, red or blue and set in a mosaic
pattern. Moving from left to right and then down, the pattern may be GR-BG. This is the
sensor's Bayer pattern, and is then placed all over the sensor to form the Bayer Mosaic
Pattern. This means that half of the pixels are tinted with a Green sensitive element, a quarter
tinted with a Red sensitive element, and a quarter tinted with a Blue sensitive element.

Binning

Binning is a method of increasing camera speed and sensitivity to boost low signals. Binning
causes the acquired image to be brighter and smaller, but the resolution will be lower as a
result. Because the image is smaller, the image transfer time is reduced significantly. When
you select a binning setting in your imaging software, the camera combines data from several
pixels in the camera’s CCD into a single super pixel. For example, a 2x2 bin means that 2
pixels in the horizontal direction and 2 pixels in the vertical direction are combined to form
one super pixel.

Bit Depth
It's the color or gray scale of an individual pixel. A pixel with 8 bits per color gives a 24 bit
image. (8 Bits x 3 colors are 24 bits.) 24 bit color resolution is 16.7 million colors.

BMP {Bitmap)
It's a file format used to store images. For further information, refer to the Microsoft™
documentation.

BNC

BNC is the acronym for Bayonet Neill-Concelman (for the inventors Paul Neill and Carl
Concelmany). It's a twist-and-lock connector for coaxial cables, used for electronic equipment
and for wiring LANs.

Brightness
It's the value of a pixel in an electronic image, representing its lightness value from black to
white. It's usually defined as brightness levels ranging in value from 0 (black) to 255 (white).

BROC {Burst Record on Command)

It's one of the operating modes of a camera with on board memory. The memory is divided
into segments; the camera acquires in circular mode in a segment. When the event trigger is
issued, the camera completes the acquisition and start acquiring in the following segment
until the memory is filled.
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C-Mount
A standard threaded lens mount used to attach a camera to a microscope, or a separate lens
to a camera.

CCD (Charge Coupled Device)

It's the light sensitive silicon chip near the optical interface of the camera that converts light
intensities into electrical signals. Every pixel's charge is transferred through a very limited
number of output nodes (often just one) to be converted to voltage, buffered, and sent off-
chip as an analog signal. All of the pixel can be devoted to light capture, and the output's
uniformity (a key factor in image quality) is high.

Circular Mode

It's one of the operating modes of a camera with on board memory. The camera acquires and
restarts when the memory is filled. The camera waits for an event trigger to complete the
acquisition.

CFA (Color Filter Array)
The filter dyes placed directly over each pixel on the chip surface.

CMOS (Complementary Metal-Oxide Semiconductor)

It's the light sensitive silicon chip near the optical interface of the camera that converts light
intensities into electrical signals. Each pixel has its own charge-to-voltage conversion, and
the sensor often also includes amplifiers, noise-correction, and digitization circuits, so that the
chip outputs digital bits. These other functions increase the design complexity and reduce the
area available for light capture. With each pixel doing its own conversion, uniformity is lower.
But the chip can be huilt to require less off-chip circuitry for basic operation.

Contrast
It's a measure of rate of change of brightness in an image.

268 Users Manual



Motion Studio

D

Dark Current
The charge accumulated by pixels while not exposed to light. Normally, this charge is
reduced or eliminated prior to capturing a picture.

Depth of Field

The distance between the nearest and farthest points that appears in acceptably sharp focus
in a photograph. Depth of field varies with lens aperture, focal length, and camera-to-subject
distance.

Diaphragm

An adjustable device inside the lens which is similar to the iris in the human eye, it's
comprised of six or seven overlapping metal blades; continuously adjustable from "wide
open” to "stopped down"; controls the amount of light allowed to pass through the lens and
expose the sensor when a picture is taken. It also controls the amount of depth of field the
photograph will have. Openings are usually calibrated in f-numbers. The more blades used
will have a more natural and rounded spots.

Digitization
It's the process of converting analog information into digital format.

Digital Camera

It's an electronic device used to capture and store photographs electronically instead of using
photographic film like conventional cameras. Modern compact digital cameras are typically
multifunctional, with some devices capable of recording sound and/or video as well as
photographs.

Double Exposure
It's a capability of CCD and CMOS cameras to acquire two images within a 100 ns interval.
The first camera exposure may be controlled while the second exposure doesn't.

DLL (Dynamic Linking Library)

A dynamic link library (DLL) is a collection of small programs, any of which can be called
when needed by a larger program that is running in the computer. The small program that lets
the larger program communicate with a specific device such as a printer or scanner is often
packaged as a DLL program (usually referred to as a DLL file). The advantage of DLL files is
that, because they don't get loaded into RAM together with the main program, space is saved
in RAM.

Dynamic Range

It's the ratio of the saturation level of the CCD to the readout noise of the CCD camera
system. Dynamic range is a measure of the ability of the camera to capture both bright and
dark features in a single image. In general, the higher the camera’s dynamic range, the more
information per pixel it can capture. It's usually expressed in dB.
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Ethernet (10Base-T)

It's a local area network (LAN) architecture developed by Xerox Corporation in cooperation
with DEC and Intel in 1976, Ethernet uses a bus or star topology and supports data transfer
rates of 10 Mbps.

Exposure
The amount of time that light reaches the image sensor.
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F-Number

The ratio of the diameter of the opening to the focal length of the lens; a large aperture is
indicated by a small numerical f-number. The f-number series is a geometric progression
based on changes in the size of the lens aperture, as it is opened and closed. As the scale
rises, each number is multiplied by a factor of 1.4. The standard numbers for Calibration are
1.0,1.4,2,28, 4,586, 8, 11, 16, 22, 32, etc., and each change results in a doubling or halving
of the amount of light transmitted by the lens to the film plane.

Fast Ethernet (100Base-T)
A newer version of Ethernet, called also 100Base-T, which supports data transfer rates of
100 Mbps.

Field of View
It's the area visible through the camera’s optics.

Fill Factor

The fill factor indicates the size of the light sensitive photodiode relative to the surface of the
pixel. Because of the extra electronics required around each pixel the "fill factor" tends to be
quite small, especially for Active Pixel Sensors which have more per pixel circuitry. To
overcome this limitation, often an array of micro-lenses is placed on top of the sensor.

FireWire (IEEE 1394)
High bandwidth (40 megabytes/second - 1394a; 80 megabytes/second - 1324b) interface for
connecting digital imaging, storage, and other devices to host computers.

Focal Length
The distance from the optical center of the lens to the image sensor when the lens is focused
on infinity, usually expressed in millimeters.

Focus
It's the process of bringing one plane of the scene into sharp focus on the image sensor.

Fps (Frames per second)
It's used to describe how many frames a camera can acquire per second.

Frame
One of the still pictures that make up a video.

Frame Grabber
It's a device that lets you capture individual frames out of a video camera or off a video tape.

Frame Rate

It's the number of frames that are shown or sent each second. Live action relates to a frame
rate of 30 frames per second.
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Gigabit Ethernet

A version of Ethernet, which supports data transfer rates of 1 Gigabit (1,000 megabits) per
second. The first Gigabit Ethernet standard (802.3z) was ratified by the |EEE 802.3
Committee in 1998.

Gray Level
It's the brightness of a pixel.

Gray Scale
It's an image containing shades of gray as well as black and white.

GUI (Graphical User Interface)
A system that simplifies selecting computer commands by enabling the user to point to
symbols or illustrations (called icons) on the computer screen with a mouse.

| H

High-G

It refers to the Vehicle Impact Test or similar environment that includes up to 100-G shock
and 3-G vibration stress. Generally indicates ability to withstand extreme shock and vibration
forces.

Image Intensifier
It's an electro-optical vacuum tube which intensifies or amplifies on low light level images.

Integration
It's the active collection of photons as done by an image sensor.

Interpolation
Method used to increase the resolution of an image map by adding pixels to an image based
on the value of surrounding pixels. This method can cause artifacts.

IP Address

The Intemet Protocol Address is a unique set of numbers used to locate another computer on
a network. The format of an IP address is a 32-bit string of four numbers separated by
periods. Each number can be from 0 to 255 (i.e., 1.154.10.266). Within a closed network IP
addresses may be assigned at random, however, |P addresses of web servers must be
registered to avoid duplicates.

IRIG (Inter-Range Instrumentation Group)
Time code signals of various formats defined by the IRIG 200-98 standard/itime derived from
GPS satellites. Both require an optional receiver/decoder/generator module.

Iris

It's a diaphragm in the lens that opens or closes to set the aperture (the amount of light that
passes through the lens to the CCD).
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L

Laser

Laser is an acronym for Light Amplification by Stimulated Emission of Radiation. A laser is a
cavity, with mirrors at the ends, filled with material such as crystal, glass, liquid, gas or dye.
It's a device which produces an intense beam of light with the unique properties of
coherence, collimation and mono-chromaticity.

LED (Light Emitting Diode)
Light producing transistor used to display dots, numeric and text, slowly replacing by LCD
display.

Lens
One or more pieces of optical glass or similar material designed to collect and focus rays of
light to form a sharp image on the sensor.

Lossless
It's an image format which stores the image in a non-compressed format, or in a compressed
format that don’t loose information.

Lossy
It's an image format that sacrifices a certain amount of image information in order to create a
smaller compressed file.

Low-G

It refers to a general industrial environment with less than 10-G shock and 2.5-G vibration
stresses.
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MAC Address

The Media Access Control address is a hardware address that uniquely identifies each node
of a network. A MAC address is 48 bits long and is commonly written as a sequence of 12
hexadecimal digits (for instance, 48-3F-0A-91-00-BC). MAC addresses are uniquely set by
the network adapter manufacturer and are sometimes called "physical addresses™ for this
reason.

MCF {Multi-page Compressed Format)
Multi-page Compressed Format (MRF) is a compressed IDT proprietary file format. Multiple
raster images are stored in a single file.

Micro-lens

To overcome the limitations of a low fill factor, on certain sensors an array of micro-lenses is
placed on top of the pixel aray in order to funnel the photons of a larger area into the smaller
area of the light sensitive photodiode.

Megapixel
It means having a resolution of one million pixels.

MOV
It's a file format used to store images. The Apple Quick Time MOV file format is used with
applications that capture, edit, and play back audio-video sequences.

MPEG (Moving Picture Experts Group)

It's a file format used to store videos. MPEG is a name of family standards used for coding
audio-visual in a digital compressed format. MPEG is a generic means of compactly
representing digital video and audio signals for consumer distribution.

MRF (Multi-page Raw Format)

Multi-page Raw Format (MRF) is an uncompressed IDT proprietary file format. Multiple raster
images are stored in a single file.
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NTSC (National Television Standards Committee)
It's a standard for video broadcasting and recording in the US and Japan.

|0

Offset

It's the offset value adjusts the CCD black level relative to the analog-to-digital converter
zero. It is factory-optimized for the camera’s maximum dynamic range.

Optical Zoom

It indicates that the camera has a real multi-focal length lens, as opposed to a digital zoom,
which magnifies the center portion of the picture.
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PAL (Phase Alternation Line)
It's a standard for video broadcasting and recording in Europe.

Palette
It's a thumbnail of all available colors to a computer or devices. The palette allows the user to
choose which colors are available for the computer to display. The greater the number of
colors, the larger the data file becomes and more processing time is required to display your
images. If the system uses 24-bit color, then over 16.7 million colors are included in the
palette.

Peltier Cooler

Thermoelectric cooling uses the Peltier effect to create a heat flux between the junctions of
two different types of materials. This effect is commonly used in electronic components and
small instruments. There are no moving parts and such a device is maintenance free.

Pixel
It's an individual element of either a sensor or a digital image.

PIV (Particle Image Velocimetry)

Particle lmage Velocimetry is an optical method used to measure velocities and related
properties in fluids. The fluid is seeded with particles, which, for the purposes of PIV, are
generally assumed to faithfully follow the flow dynamics. It is the motion of these seeding
particles that is used to calculate velocity information.

Plug-in

A file containing data used to alter, enhance, or extend the operation of a parent application
program. Plug-ins, both commercially and independently authored, can usually he
downloaded for free and are stored locally. Plug-ins come in different versions specific to
particular operating systems.

PNG (Portable Network Graphics)

It's a file format used to store images. PNG is an extensible file format for the lossless,
portable, well-compressed storage of raster images. PNG provides a patent-free replacement
for GIF and can also replace many common uses of TIFF. Indexed-color, grayscale, and true-
color images are supported, plus an optional alpha channel. Sample depths range from 1 to
16 bits.

Pulse

It's a signal whose amplitude deviates from zero for a short period of time. A pulse may be
periodic (pulse train) and not periodic (single pulse). The Pulse Width is the time between
the rising edge and the falling edge of a pulse. If the pulse is periodic it has a period and a
duty cycle.
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Quantum Efficiency

It's a quantity defined for a photosensitive device such as photographic film or a sensor (CCD
or CMOS) as the percentage of photons hitting the photo reactive surface that will produce an
electron-hole pair. It is an accurate measurement of the device's sensitivity. It is often
measured over a range of different wavelengths to characterize a device's efficiency at
different energies.

'R

Resolution

Resolution is expressed as either the number of pixels counted horizontally by the number of
pixels counted vertically or by the number of mega pixels. It can be expressed as one of the
following formats: QVGA (320 x 240), VGA (640 x 480), SVGA (800 x 600), XGA (1024 x
768) UXGA (1600 x 1200).

RGB (Red, Green and Blue)
The color system used in most digital cameras in which the image is separated by capturing
the red, green, and blue light separately and then are re-combined to create a full color
image.
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Sensor
It's an electronic device that converts the light allowed in by the shutter to an electrical signal.

Sensor Gain
It's the amount of analog signal amplification. The gain is factory-optimized for the camera’s
maximum dynamic range.

Sharpness
The clarity of detail in a photo

Shutter

It's the device in the camera that opens and closes to let light from the scene stiike the image
sensor and expose the image. The three primary types used in digital photography are digital
shutters, iris shutters and focal plane shutter.

SDK (Software Development Kit)
It's a programming package that enables a programmer to develop applications for a specific
platform. An SDK typically includes one or more APIs programming tools and documentation.

Spike
It's a short pulse of voltage or current, usually undesirable.

Square wave
It's a periodic signal which changes instantaneously between two fixed levels. The values are
usually 0 and 5 V (TTL) or 0 to 3.3 V (CMOS).

Switch Closure
It's a type of external event trigger. The trigger is detected when the poles of the trigger
connector are shorted by a switch.

Synchronous

Synchronous events occur at the same time or at the same rate or with a regular or
predictable time relationship or sequence.
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TIFF (Tagged Image File Format)

It's a file format used to store images. TIFF pictures store a single raster image at any color
depth. TIFF is arguably the most widely supported graphic file format in the printing industry.
It supports optional compression, and is not suitable for viewing in Web browsers.

Thumbnail
It's a small, low-resolution version of a larger image file that is used for quick identification.

Trigger

A trigger is something that causes a data acquisition system to start collecting data or a
camera to start acquiring images. It may be as simple as pressing a software button or a set
of conditions which when met trigger data capture (intemal triggers), or an extemally
generated, hardware signal (an external trigger).

Tripod
A tripod is a three-legged supporting stand used to hold the camera steady, especially useful
when using slow shutter speeds. Another is the monopod, single leg tripod.

TTL (Transistor-Transistor Logic)
A common semiconductor technology for building discrete digital logic integrated circuits. For
digital circuits, logic 1 is obtained for inputs of 2.0 to 5.5 V and logic 0 forinputs of 0 to 0.8 V.,

TWAIN

It's a protocol for exchanging information between applications and devices such as scanners
and digital cameras. TWAIN makes it possible for digital cameras and software to "talk” with
one another on PCs.
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Underexposure
A picture that appears too dark because not enough light got to the imaging system.

USB (Universal Serial Bus)

It's a serial bus standard for connecting devices. It was designed for computers such as PCs
and the Apple Macintosh, but its popularity has prompted it to also become commonplace on
video game consoles, PDA, cell phones. It has a slow version (USB 1.1 - 12 Mbps) and a
high speed version (USB 2.0 — 430 Mbps).

USB 2.0

Finalized in 2001, Universal Serial Bus (USB) 2.0 is a complete overhaul of the Universal
Serial Bus input/output bus protocol which allows much higher speeds than the older USB 1.1
standard did. The goal of the new serial bus is to broaden the range of external peripherals
that can be used on a computer. A hard drive can easily hit the USB 1.1 bottleneck whereas it
now becomes more 'usable' under USB 2.0 conditions. USB 2.0 maximum speed is 480
Mbps.

|V

W

White balance
Its a function to compensate for different colors of light being emitted by different light
SOUrces.

| X

XDR (Extended Dynamic Range)
Its an IDT-proprietary implementation that uses the double exposure capability of the
MotionPro series cameras.
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